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1. OpenRoads Designer Basics

OpenRoads technologies are integrated with ProjectWise. As such, the ProjectWise Managed
Workspace delivers OpenRoads configurations and template files within the managed ProjectWise
environment. Throughout this document, specific functionality of OpenRoads with ProjectWise will be
called out and expanded on in a workflow specific manner.

1.1 OpenRoads Designer vs. InRoads: What is the Difference?

It is important to distinguish the differences between the current OpenRoads Designer environment and
the InRoads environment that has existed up to this point. This document will try to highlight some of
these differences, but the following items will shed some light on the specifics.

InRoads and Native Tools — These are the tools and file formats that would be recognizable from the
SS2, SS4, and SS10 versions of InRoads. Native tools are those that are located on the InRoads Explorer,
so items like Annotations, Plan and Profile Generator, and the like. These references may also include
the old file formats such as ALGs, DTMs, etc.

OpenRoads and OpenRoads Technologies — While working with the OpenRoads Designer application,
there is no need for a separate application such as InRoads to create alignments (ALG’s), terrains
(DTM’s), sheets, etc. OpenRoads Designer is designed to handle all aspects of roadway modeling and
plan sheet creation in one application. For INDOT purposes, the major areas where this functionality
will be used are items such as OpenRoads Survey, Terrains, Civil Geometry, Corridor Modeling, and Cross
Sections—features that are not found in the old InRoads toolset.

1.2 The OpenRoads Designer Ul

The following sections will review the specific interface Workflows and Project Explorer items that you
can expect to see when working with OpenRoads Designer. Note that most of these are OpenRoads
specific and will not be available in other MicroStation Platform products.

1.2-1 OpenRoads Designer Workflows
For a more in-depth discussion of the MicroStation Platform interface, and additional information on
interacting with workflows, please refer to the DOTWise 5.0 MicroStation module.

This subsection will cover each of the workflows in OpenRoads Designer, along with a brief description
of their purpose. Before doing so, it should be noted that each workflow—with the exception of the
SignCAD workflow—has a Home tab that has commonly used tools/functionality such as the assignment
of attributes, reference attachment, model display, element selection, etc.
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1.2-1a OpenRoads Modeling Workflow
The OpenRoads Modeling workflow is designed to guide the user in modeling various design elements
such as terrain, geometry, parcels, corridors, etc. Each of these design elements has its own specific tab
in the workflow.
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The Drawing Production, Drawing, and View tabs are more specific towards the production of
drawings—which will be covered next in the discussion of the OpenRoads Drawing Production workflow.

1.2-1b OpenRoads Drawing Production Workflow
The OpenRoads Drawing Production workflow contains three workflow-specific tabs:

e Drawing Production: Used to place text, annotations, create named boundaries that are used to
cut sheets, set the drawing scale, etc.

e Drawing: Used for general drafting work on a drawing.

e View: Used to manipulate the display of the current view.
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OpenRoads Drawing Production Workflow

1.2-1c Survey Workflow
The Survey workflow contains tools that are specifically geared towards generating survey data such as
field books, terrain, survey annotations, etc.
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1.2-1d Geotechnical Workflow
The Geotechnical workflow is designed to assist with adding geotechnical information to a design
model.
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1.2-1e Reality Modeling Workflow
The Reality Modeling Workflow provides tools to enhance the design model with various effects such as
reality meshes and models, raster images, and point clouds.
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Reality Modeling Workflow

1.2-1f Drawing Workflow
The Drawing workflow provides tools to draw elements in a model, annotate a model, measure specific
elements, among many other tools.
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1.2-1g Modeling Workflow
Only visible in 3D models/files, the Modeling workflow provides tools to create and/or modify various

3D elements.
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1.2-1h Visualization Workflow
Only visible in 3D models/files, the Visualization workflow allows you to create animations for your

design content.
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1.2-1i SignCAD Workflow
The SignCAD workflow—if enabled for an individual user—provides tools to open and place SignCAD
sign files directly from the OpenRoads SignCAD sign libraries.
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SignCAD Workflow




1.2-1j Drainage and Utilities Workflow
The Drainage and Utilities workflow contains tools to create and place various drainage and utility-
related elements to a design model.
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1.2-1k INDOT Tools Workflow
The INDOT Tools workflow contains INDOT-specific tools that are specific to the workspace. From this
workflow, users can launch the AutoTurn application, add title block integration, connect to INDOT cell
libraries, among many other tasks.
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There are a few dropdown menus in this workflow to pay attention to. The first is the Signs Cells
dropdown on the Cells tab—which provides a connection to each of the traffic sign cell libraries.
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The other two are the Letter Size and Full Size dropdown menus on the Annotation Tools tab—which
provide specific annotation styles for Letter Size and Full Size Sheets respectively.
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1.2-2 Project Explorer
The Project Explorer interface allows you to browse and manage content within an OpenRoads Designer
file.
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Project Explorer (docked on left side of user interface)

Note: If the Project Explorer interface does not display automatically upon opening OpenRoads Designer,
you can open it manually by navigating to the Primary button group in most workflows, which should
contain an Explorer button to launch Project Explorer. Once opened, you can then dock it on the
interface as desired.

The remainder of this section will give a brief overview of the different tabs in Project Explorer.




1.2-2a OpenRoads Model Tab
The OpenRoads Model tab displays information on any modeling components (alignments, terrains,
corridors, templates, etc.) that are contained within the file.
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1.2-2b OpenRoads Standards Tab
The OpenRoads Standards tab shows the various CAD standards that have been applied within your
active design file. It also allows you to see the components of the various standards libraries that have
been implemented into the workspace.
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OpenRoads Standards Tab

1.2-2c Drainage and Utilities Model Tab
The Drainage and Utilities model tab lists all the drainage and utility-related elements that have been
added to the file via the Drainage and Utilities workflow.
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1.2-2d Survey Tab
The Survey tab shows all the survey data that has been imported into the file. It lists the name of the
fieldbook that was created, the data file it was created from, and all the features, control points, setups,
and observations that are associated with the survey data. More information on how to import survey
data into an OpenRoads Designer file is covered in Chapter 6.
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1.2-3 The View Control Right Click Menu
The View Control Menu in OpenRoads Designer allows the user to view a design from many different
perspectives. From this menu, users can open a new view to view designs in 3D, in cross section view, in
profile view, along with various other view commands such as quickly toggling the view presentation,
toggling construction elements, and various zoom and rotation commands. To access this menu, simply
click and hold the right mouse button in the active view. Then hover over the arrow in the View Control
field in the menu that appears to access the view options.

View Control FE 1 View

5 Copy (g 2 Views Plan/3D

-3 Move (@ 2 Views Plan/X5

7 Scale (@ 2 Views Plan/Profile

& Rotate [@ 2 Views Plan/Superelevation

7\ Mirror (3 3 Views Plan/Profile/2D
(@ 3 Views Plan/X5/3D

i k|
¥ Selectlinks (3 4Views Plan/Profile/X5/3D

Level Off (1 Ref Adjust Colors
a2 Open View Attributes dialog “er  Dynamic X5 View
Maodel Properties Profile View
Clip Velume 4 Toggle Construction Class

S Calect All = Levels Off Except Element

)
% Delete Element Hustration View

Smooth View

@5 Properties

WireFrame View

Select Mone i@ Displayset Set
v Select Previous >, Displayset Clear
», Cutto Clipboard E Arrange Windows

Copy to Clipboard +) FRotate View

Paste from Clipboard |:| Fit View

1
L)
L
L
L
L

View Control Menu

As you can see, there are several options to choose from. To illustrate an example, here is what
happens to the display when the 2 Views Plan/3D option is selected when you only have a plan view
currently displayed:



= View 1, Default [ =] | = = [=3][=
-4 PRPLHYD|EE| SR S- AN A PPROADHOREE ETRE

2 Views Plan/3D

As you can see, ORD splits the display into the standard 2D plan view and a 3D view. For future
reference, this is the view display that is necessary to create cut cross sections from, as you need to
have a 3D view open and active to perform the operation.

To illustrate another example, here is what happens with the 2 Views Plan/XS option. Note that upon
selecting this option, you will first be prompted to create a dynamic cross section view. Click OK at the
prompt to proceed. A new view will be opened.

Select DK to Create a Dynamic X5 View

oK Cancel

Create a Dynamic Cross Section View

You will then be prompted to locate your corridor or alignment to view cross sections along. Select your
corridor or alignment.



Selecting Corridor or Alignment

Finally, you will be prompted to select/open a view to place the dynamic cross section view in. In this

example, select the view that was automatically opened.

Then click in the open view to place the dynamic cross section viewer. Your views will then be tiled to

show both views and their respective content.

=2 (e =)

orridor
-1 P PRM9 D EE &N

I
\M

‘ |
|

]

I

[

I

/

2 Views Plan/XS



Note that the cross-section view being displayed is dynamic, where you can adjust the stationing as
necessary to display the cross sections along a corridor or alignment.

The final example is the 2 Views Plan/Profile option. As its name implies, it will place a profile view in
conjunction with the plan view. Note that you upon selecting this option, you will first be prompted to
create a dynamic profile view. Click OK to proceed. A new view will be opened.

Select OK to Create a Dynamic Profile View

0K Cancel

Create Dynamic Profile View

You will then be prompted to select your horizontal alignment (or “Plan Element” as it is referred to in

the prompt).
© -"':: :
Locate F'Iar Element A

Selecting Horizontal Alignment

Once the horizontal alignment is selected, you will be prompted to select an open view to place the
profile viewer into. In this example, the newly opened view will be selected. Then click inside the new

view to place the profile display.

2 Views Plan/Profile
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The remainder of the options pertaining to the number of views to display are variations of these
examples that have been shown. The rest of the options in the menu after that are self-explanatory and
perform the function listed.

1.3 OpenRoads Designer Standards and Seed Files

This section will discuss the location of INDOT-specific OpenRoads Designer standards and seed files for
use with the application. All OpenRoads Designer files except DGN seed files will be found under folders
within the following ProjectWise path: Documents\Template Documents\ORD-Connect Seed. It is highly
advised that users do not interact directly with files under this location as the underlying OpenRoads
technology requires that the workspace maintains a high degree of integration.

1.3-1 ITL File
As of the release of the InRoads/OpenRoads SS4 workspace, a customized agency template library has
been created and is now available. It contains several default templates configured with agency specific
feature, component, and point naming. It also contains the relevant templates used by the agency civil
cells.

These templates can be found under the template library folder, in the INDOT.itl file. Like the XIN file
that was used with InRoads, this library is automatically attached at startup.

1.3-2 Civil Cells
With the migration to InRoads SS4 and OpenRoads technology, the workspace now contains several Civil
Cells. These can be found under the civil cells folder and are attached automatically at startup. Note
that these are DGNLib files, and direct customization will not be available.

1.3-3 Cell Libraries
All INDOT cells for use with OpenRoads Designer can be found under the cell folder. There are several
cell libraries in use under this folder:

e |N_InRoads.cel

e |IN_MOTCells.cel

e IN_PE-LS-Stamps.cel

e IN_Signs_Construction.cel

e IN_Signs_Guide.cel

e IN_Signs_Recreational.cel

e IN_Signs_Regulatory.cel

e IN_Signs_School-ObjectMarkers.cel
e IN_Signs_Warning.cel

The first library is used by the Aerial Survey group for topographical collection. The second library is
used for the display of point features in the topographical surface and other items such as cells placed
for title sheet integration and north arrows. The third library contains cells that are specific to denoting
Maintenance of Traffic (MOT) operations on plan sheets. The fourth library contains cells with digital
versions of Professional Engineer and Land Surveyor stamps. The remaining libraries contain traffic sign
cells, categorized by sign type.


pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CINDOT%20Workspace%5CORDWorkspace%5CINDOT%5CTemplate%20Library%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CINDOT%20Workspace%5CORDWorkspace%5CINDOT%5CTemplate%20Library%5CINDOT.ITL
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CINDOT%20Workspace%5CORDWorkspace%5CINDOT%5CDgnlib%5CCivil%20Cells%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CINDOT%20Workspace%5CORDWorkspace%5CINDOT%5CCell%5C
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1.3-4 Plans Production — Sheet Borders
The files located under Sheet Borders are used in the creation of all plan sheets. Discussion of these files
will be expanded with their usage in the Plans Production workflow.

1.3-5 OpenRoads Designer DGN Seed Files and the Importance of File Associations
OpenRoads Designer allows for any DGN or model in a DGN to be a container for OpenRoads elements
at any time. As such, the first item required when starting an OpenRoads Designer project is the
appropriate unit DGN seed file. For all new projects that are created after the Fall 2013 release of the
Indiana Design Manual Part 1 (Ch. 106, Section 26-1.01 memo requiring Geo-Coordinated seed files),
you will be provided a Survey seed file in the pw:\\indot-pw.bentley.com:indot-pw-01
\Documents\District\Des No.\ Survey\Project Files folder of your project with the following naming
convention: Des #_SRxx Seed 2D.dgn and Des #_SRxx Seed 3D.dgn. These seed files are used to set the
coordinate system for every OpenRoads Designer-based file in your project. Each will already have the
properly selected working units for your project. If you are a consultant working on an INDOT project
and do not have access to the Survey\Project Files folder, please contact your surveyor to request the
newly required geo-coordinated seed files.

Your project might fall outside the requirement window of the new design memo, so you may continue
to use the previous method of creating your own seed file (or possibly ask the Surveyor if they can
create one for you). The files you will need are located with the rest of the INDOT-specific ProjectWise
seed files. They can be found at pw:\\indot-pw.bentley.com:indot-pw-01\Documents\Template
Documents\ORD-Connect Seed\.

At the root of this location, 2 seed files have been provided, corresponding to the units of measurement
used in current INDOT projects. These are:

e |INDOT US SVFT 3Dseed.dgn
e |INDOT US SVFT 2Dseed.dgn

Please note that both 2D and 3D versions of each file have been made available. OpenRoads technology
allows for the full use of civil data regardless of the availability of the Z axis. For instance, when showing
3D OpenRoads elements in a 2D seed file, a 3D model will automatically be created as needed.
Throughout the remaining chapters, care should be given to what seed file a particular function would
best function in. For example, if working with survey and terrains, users need to utilize 3D seed files.
Also, if working with corridor modeling, users should be utilizing 2D seed files.

These files are configured with Design History disabled to remove compatibility errors caused by the
rapid display and deletion of elements during the design process.

Finally, as OpenRoads Designer is integrated with ProjectWise, these seeds are configured with their
application association set to OpenRoads Designer, causing OpenRoads Designer to launch when the
files are checked out and opened.

1.3-6 ProjectWise
1.3-6a Project Creation
The first step in working with OpenRoads Designer and ProjectWise is the creation of your project. At
this time, the Design project template has been setup to have distinct OpenRoads Designer folders


pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CINDOT%20Workspace%5CORDWorkspace%5CINDOT%5CSheet%20Borders%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5CINDOT_US_SVFT_3Dseed.dgn
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5CINDOT_US_SVFT_2Dseed.dgn

separate your data. As always, if your project does not yet have a Design folder please create the
project/folder using the DOTWise Project Creator.

1.3-6b Survey Provided Files
When starting an OpenRoads Designer project, you can expect having access to the following files:

FOR ORD PROJECTS

1. Des#_SRxx Survey Fieldbook.dgn - Contains Fieldbook information for TOPO and Control Points
in the OpenRoads Format (survey fieldbook) along with the existing terrain model. This will be
done in a 3D model.

2. Des#_SRxx Survey Alignment.dgn - Contains Survey alignment(s) in the OpenRoads Format (civil
data — linear elements). This will be done in a 2D model.

3. Des #_SRxx LCRS Plat.dgn - MicroStation plat DGN

To begin a project, it is recommended to copy the Alignment and Terrain DGNs that Survey provides into
your Design\OpenRoads Designer folder in ProjectWise. These are the base files you will start your
project from and should be available in a read-write location as you will be directly interacting with
them.

With these files copied into your project, it is suggested to rename the DGN containing the survey
alignment to Des #_SRxx Design Alignment.dgn. This will alleviate confusion and specifically denote that
this file is for the proposed alignments while maintaining the collected information from the Survey
alignment.

1.3-6¢c Base Drawing Creation
To start creating a project, the only item required is a base DGN to start the product with. Using the
advanced document creation wizard, you can create your base drawings using the unit appropriate seed
file as noted in Section 1.3-5. The INDOT base drawing naming convention will still be used.

Project information will be organized into several base drawings. The information is separated based on
categories of information included. These base drawings are the locations for all line work. Most base
drawings will be created while in OpenRoads Designer. By using OpenRoads-based referencing tools, a
base drawing can be enhanced to view other base drawing information as a backdrop. Please refer to
the INDOT Wise MicroStation module for a summary of base drawings and recommended naming.
Below is a list of Standard Base Drawings to be used at INDOT and descriptions of their contents. Other
names are possible based on project needs.
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Standard Base Drawings

Drawing Names / Descriptions / Examples

Logical Names Reference Descriptions

Survey Alignment Survey Centerline Des # SRxx Survey Alignment.dgn

Survey Section US Government Section Corners Des #_SRxx Survey Section

Corner Corner.dgn

Survey Fieldbook Survey Existing Topography and Des # SRxx Survey Fieldbook.dgn
Contours

Prplan Proposed Design Strings Prplan.dgn

RW Existing scale Existing Right of Way RW Existing.dgn

Design Alignments Design Alignments Design Alignments.dgn

If your project is anticipated to require multiple scales, it may be desirable to create multiple base
drawings at those scales. Creating the multiple scaled drawings is easily done by creating a new plan
display titled appropriately for the scale to be created, and then displaying the appropriate models at
the desired scale. Some examples of scales and various usages are presented below.

Using this procedure makes it extremely easy to vary the scale of a sheet by simply picking the base
drawings that have the desired scaling when referencing into the OpenRoads Designer drawings. From
this point forward, the 1” = 30’ scale will primarily be used in this documentation. Note that the scale
will vary with projects, and other scales can be developed using the same procedures as described.

US Scales

Scale Typical Uses

17 =20 Construction details and other detail drawings.

1”7 =30’ Bridge Layouts and Constuction Details and Plan profiles

1”7 =50 Most common scale used in plan and profile sheets and
plan drawings.

1”7 =100’ Pavement marking plans, and other miscellaneous
sheets. Pavement markings are unreadable at this scale.

Note: OpenRoads technologies make substantive use of the Annotation Scaling tools for element and
feature display. When discussing multiple scaled base drawings, it may be beneficial to create a single
base drawing and then scale the content through using the scaling settings available on reference files.

1.4 Opening, Closing and Saving OpenRoads Files from ProjectWise

With the integration of OpenRoads Designer and ProjectWise, procedures for opening, closing, and
saving files in OpenRoads Designer differs from these functions as shown in training. As with
MicroStation and other integrated applications, standard Open and Save dialogs are replaced with
ProjectWise integrated dialogs with extended functionality. Please keep in mind that these options will
be used when working with the legacy file formats of the InRoads software.



1.4-1 Opening Existing Files
Note: In most cases, OpenRoads files will be opened directly from the ProjectWise Explorer. The
following method can be used when switching between files, but it should be noted that doing so could
result in being prompted to reload the workspace/application.

To open a file from within OpenRoads Designer, first click on the File tab.

E OpenRoads M

File tab

Then on the File menu, the Open command should be automatically selected, and a list of recently
opened files for the current WorkSet will then appear. If the desired file to open is in the list, clicking on
it will open it. If the desired file is not in the list, click the Browse button to open the Open dialog:

Open
-
: ) o %
Recent Files for No WorkSet &l open
Select
,,,,, . ORD PrPlan.dgn Fold
E pwA\dotwise.indotin.gov:DOTWise\Documents\ Testing\0001350\DesigniinRoadsy
Modified: 2/14/2020 11:00:02 AM Size: 2097 KB |f_ test
Survey Testing.dgn Y@
pwi\dotwiseindotin.gov:DOTWise\Documents\ Testing\0001350\Designiinoadsy
Modified: 2/7/2020 9:01:26 AM Size: 749 KB
Tables.d Hame
o s gd"r -DOTWise\D: ts\La Porte\1801219\Design\MS\MS #/BAINDOT.US SVFT.2Dsecd dgn
P indotin.gov: ise\Documents\La Porte\ \Design\MS\| 72 INDQT U SVFT aDseed.dgn
Modified: 2/5/2020 10:03:05 AM Size: 2241 KB
“iz ORD PrPlan.dgn
INDOT_US_SVFT_3Dseed.dgn /& ORD Survey Fieldbook.dgn
P ise.indotin.gov:DOTWise\Doct te CAD Support\Working /WA proposed corridors.dgn
Modified: 2/3/2020 1:33:23 PM Size: 494 KB /P proposed terrain.dgn
¥5 Sht 30_1.d
INDOT_US_SVFT_3Dseed.dgn j s an
D p ise.indotin.gov:DOTWise\Documents CAD Supportyworking /Sm 3073.d;n
Remote document |8 sht PlanProfileLrgPlan_20_1.dgn
INDOT_US_SVFT_3Dseed_PIPELINERS.dgn /4 Survey Fieldbook.dgn
p ise.indotin.gov:DOTWise\Doxr ts CAD Suppert\Working h
Modified: 2/3/2020 12:47:35 PM Size: 596 KB 3 £2
INDOT_US_SVFT_3Dseed.dgn address: ‘ - — y—— P ——— P ———— ‘
p ise.indotin.gov:DOTWise\Documents CAD Support\Working ressi Ll estng estng Dataltest|ORD Prelan.dgn
Modified: 2/3/2020 11:53:27 AM Size: 596 KB Description: [ ORD PrPlan.dgn |
IN_PrintStyles.dgnlib Fie Name: [ cRD PPtan.don |
p ise.indotin.gov:DOTWise\Doc ts\INDOT
Modified: 2/3/2020 §:45:31 AM Size: 57 KB Application: All Applications 52
transeed.dgn Extension: *.dgn; *.dwg; *.chef v
C:\ProgramData\Bentley\MicroStation V&i (SELECTseries)\WorkSpace\systemyseedy
Modified: 8/13/2010 1:11:02 PM Size: 46 KB [Jopen document s read-only
o Traffic Mod - Tyler.dgn
i{_m pwA\dotwise indot in.gav:DOTWise\Documents\La Porte\1801219\Design\MS\MS Cpen Cancel
i E Modified: 1/31/2020 3:20:04 PM Size: 403 KB
‘

Opening ProjectWise-Based Files from OpenRoads Designer

If you wish to narrow down the list of files by application, that application can be selected from the
Application field—which contains a list of applications that have been defined in the ProjectWise
environment.

22 |
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Additionally, you may selectively open a file in a read only mode by selecting it in the Open dialog and
enabling the check box for open it as read only:

Address: | pw: Ydotwise.indot.in.gov: DOTWis:
Description: | INDOT_UUS_SVFT_2Dseed

File Mame: | INDOT_US_SWFT_2Dseed.dgn
Application: all Applications

Extension: = dgn; *.dwg;*.dxf

[Jopen document as read-only h

Adding Files to an Open list/Read Only

1.4-1a Workspace/Workset Association Warning
In OpenRoads Designer, users will find that all files have the workspace/workset definition for their
project burned into the DGN as it is used. With the myriad of external firms that INDOT works with, it
will be very common to find files that are associated with different workspaces/worksets than what is
made available in the ProjectWise Managed Workspace.

The following warning will be common if you’re starting with files that were created using a version of
our external workspace, or another firm’s modification of the workspace made available publicly. Most
often, this will be seen when starting with survey data provided by an external firm.

9|

The file you have chosen to open is associated with #
WorkSpace "INDOT_Standards”, WorkSet "INDOT", which was not
found.

Dpen Cancel

This is simply a message indicating that the file is associated with a different workspace and workset
than what we have configured in ProjectWise and will not prevent you from opening or working with
the files as you typically would. If you want to unassociate and reassociate the files from/to the
ProjectWise workspace, a pair of key-ins are available to perform this action and can be found in the
linked technote: How to remove the workset association in a dgn file - OpenRoads | OpenSite Wiki -
OpenRoads | OpenSite - Bentley Communities

1.4-2 Saving New Files
When performing a Save for the first time, or a Save As on an existing file, you will be presented with an
OpenRoads Designer/ProjectWise specific Select a Wizard dialog, as shown below:


https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/40405/how-to-remove-the-workset-association-in-a-dgn-file
https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/40405/how-to-remove-the-workset-association-in-a-dgn-file

# Select a Wizard >

Document Creation Wizards

oK

I~
B A
Mo Wizard Advanced
Wizard

[[] Make this wizard the defautt.

Select a Wizard Dialog

It is suggested to select the No Wizard option and click OK to bring up the Save Document As dialog:

Save Document As >
General
Falder Sawve
test | Select Cancel
Document
Mame: | ORD PrPlan.dgn | ﬁ

Description: | ORD PrPlan |

File Mame: | ORD PrPlan.dgn |
Format: | MicroStation V8 DGN Files (*.dgn) | Faormat...
Application: Department:

MicroStation ~ || <none = ~

Save Document As Dialog

All ProjectWise Save dialogs require you to define your project folder, document name, file name, and
description. It is still recommended that you maintain the same naming convention—at least for the
document and file names. Also, it is very important to make sure the application is appropriately set to
the file type you’re attempting to save to, as the dialog does not assume the file type you’re saving.

1.4-3 Closing Files

When closing files from within OpenRoads Designer, the user will be presented with the ProjectWise
Check In dialog:
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General  Comment

Documents

Marme Description File Mame Falder Sterag

+ EIJ ORD PrPI... ORD PrPlan.dgn ORD PrPlan.dgn CODesign

< >
Folder: _Testing0001350\Design {InRoads'0ld Testing Datatest

[ create new version during Check In

Version: |

Check In Update Server Copy Free Close

ProjectWise Check In Dialog

It is recommended that each check in be accompanied by good comments to allow quick review of
anything that may have been done.

1.5 OpenRoads Technologies

1.5-1 Using 2D Seed Files/Models for Design
In a departure from previous versions and guidance, OpenRoads technologies highly emphasize the use
of 2D models for the design process. Throughout this document, many instances that previously
referred to the use of a 3D seed file/model configuration have been amended to reflect this change in
software philosophy.

As part of using a 2D seed file, the OpenRoads product will automatically create a 3D model on the fly.
Bentley advises that when performing operations, all work be done in the 2D model with a view of the
3D model open so that modifications can be seen as they occur. This 3D model will only be created once
a terrain model has been generated or attached and activated.

A proposed workflow would be to process all survey in a 3D seed file, and then attach this 3D content to
a 2D seed file for alignment and design purposes.

1.5-2 Alignment Naming in OpenRoads
Within the following chapters, in many cases you will see references to how alignments are or should be
named. Convention up to this point has been to name these Line ”A”, Line “B”, etc. However, as of the
transition to ORD, please be advised that CAD Support strongly recommends that users no longer use
quotation marks in alignment names. Continuing to do so can cause instability/crashing behavior in
plans production processes that cannot process alignments that contain them. Should you import any
source data into your design file that contains an alignment name with quotation marks, the first step
should be to rename the alignment to eliminate the quotation marks.
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1.5-3 OpenRoads and MicroStation Multi-View Configurations
As discussed in the previous section, OpenRoads Designer will automatically create 3D models when
started from a 2D seed. In these instances, and others such as profile creation and dynamic cross
section review, it may be advantageous or required to open multiple views. The following steps will

cover how to open additional views, and then, if necessary, how to display content from a different
model.

1. When in OpenRoads Designer, locate the View tab in the current workflow. Then locate the View
Groups Group.

T Drawing =) ! L E=T ] pwa\dotwise.ndot.in.gov:DOTWise\Dacuments\_Testing\0001350\Design\InRoads\0ld Testing Data\test\ORD PrPlan.dgn [2D - V8 DGN] - OpenRoads Designer CONNECT Edition
“ Home B Attach  Analyze  Curves  Constraints  Utilties  DrawingAids  Content
—_—T L0 - _ 2 @& i |
_ a = e © T
E & B LPCILE. # G % O O SEHMAFC 12345678
Window Zoom Fit v ew  View Named Pre =

iew Vi
Out  View @ @ Orientation ™ Previous Next

Presentation ] Tools

View Appl Create  Update Saved  Appl Copy Cascade Tile Arrange View
Attributes D.splay{ty\e Area Boundary ~ P FView | Ve e

Clip
Volume G | Saved View View Settings Saved Vi

Mamed Boundaries Clip Saved Views T ‘Window View Groups ]

View Groups Group

2. By default, most files will open with view 1 active as your active display. To open an additional
display, select one of the other views so the button is depressed.

123456738

-

View Groups I

Second View Opened

3. At this point, depending on the tool in use or if you are modifying the display, the steps will branch
off. If the tool prompts to select an active display to show content (profile creation, dynamic cross
sections), place a data point in the display as requested. If wanting to display content from a
different model, continue on.

4. With the view open, select the View Attributes button.

B View 2, Default

El-|@ 5~ L P L0OO

View Attributes
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5. Onthe View Attributes, expand the View Setup leaf. Under the Models dropdown, select the
appropriate -3D model. These models will name themselves after the base DGN model that the
terrain is created in.

[ view Setup -~

Saved Views: |Select... e l[__II':I -

Default

Models:

Model Mame

R —

E (¢ Default-2D
By Plan 3
Plan 4
Profile &

i Profile &

[3 I Plan 3 [Sheet]
[2 I Plan 4 [Sheet]

-
st

-
)

O
O
O
O

Selecting 3D Model

6. At this time, two models would be displayed. View 1 would presumably have the 2D Default model
displayed, and the Default-3D model will display in View 2.

1.5-4 Project Explorer
In OpenRoads Designer, file types such as DTM, ALG, and FWD are no longer required for many of the
tools. Bentley has now made the DGN file the container for much of this data. To access this data,
OpenRoads Designer uses the Project Explorer.

When starting OpenRoads Designer you may need to enable the Project Explorer. To do so, go to the
Home tab for the current workflow, and select Explorer from the Primary Group.

E’J Drrawing T L—_I I'._[:; o * = l;?,:, = pw:\hdotwiseindot.in.gowv: Dt

lil Home ‘u‘ii Annotate Attach Analyze Curves Constraints Litilities Drawing A
& |Mone T Default '- I_quplurer F Reference = (@7 Properties
— A || Attach Tools ~ s Level Manager = EF More -
=0 @0 = 0 E Models = = Level Display ~

Attributes Primary

v

N L =
4 U -

i

Starting the Project Explorer

An Explorer tab should then appear on the far left side of the interface.
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Explorer Tab

Hover over the Explorer tab to display the Project Explorer’s contents, and then click on the pin icon to
pin it to the display.

@ Items n
| OpenRoads Model
: L Sheet Index
| OpenRoads Standards

| Drainage and Utilities Model

)((((E

| Survey
"'_-\ q J | |
| Search o0

4

> & [ Survey Data

The Project Explorer in OpenRoads Designer

1.5-5 Drawing Scale
OpenRoads Designer leverages the MicroStation-based Drawing Scale Tools. These tools are in the
Drawing Scales Group at several locations throughout all of the workflows:
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1"=50' o
¥ ACS Plane Lock

|....£...| Annotation Scale Lock

Drawing Scales

The Drawing Scale and Annotation Scale Lock

As shown, this tool controls the scaling of all Annotation enabled elements including linestyles, text,
dimensions, and cells. This tool should be used to control the scaling of any OpenRoads data. Care
should be given to using this in addition to other manual scaling factors as the results could be incorrect.

With the Annotation Scale Lock enabled (highlighted in light blue as shown above), changing the scaling
value above it will dynamically rescale all elements by the defined value.

With the frequency that these controls in particular will be used, it’s advised that this particular set of
tools be pinned to all workflows using the process discussed in the DOTWise 5.0 MicroStation Platform
document.

Note: Initially all items should be drawn up at a Full Scale 1:1 setting. Drawing items up at higher scales
may cause them to improperly display in your drawing. This can be resolved by setting the scale back to
Full Scale 1:1 and then selecting the desired scale from the listing.

The following table shows the various drawing scales configured in our workspace, along with their
equivalent direct scale factors.

Scale Name Scale Factor
Full Size 1=1 1:1
6"=1'-0" 2:1
3"=1'-0" 4:1
11/2"=1'-0" 8:1
1"=1'-0" 12:1
3/4"=1'-0" 16:1
1/2"=1'-0" 21:1
3/8"=1'-0" 32:1
1/4"=1'-0" 48:1
3/16"=1'-0" 64:1
1/8"=1'-0" 96:1
1/16"=1'-0" 192:1
1/32"=1'-0" 384:1
1"=10' 120:1
1"=20' 240:1
1"=30' 360:1
1"=40' 480:1
1"=50' 600:1




1"=60' 720:1
1"=100' 1200:1
1"=200' 2400:1
1"=300' 3600:1
1"=400' 4800:1
1"=500' 6000:1
1"=600' 7200:1
1"=1000"' 12000:1
1”=2000’ 24000:1
1”=3000’ 36000:1

Drawing Scale Chart

1.5-6 File Referencing
As discussed previously, OpenRoads data is now all stored directly in DGN files. One major advantage of
this functionality is that standard MicroStation referencing allows for OpenRoads data to be visible
through the reference documents. Examples of this functionality will be discussed further in the coming
chapters, particularly in areas such as the creation of a terrain model from a referenced survey field
book, and in the modeling of a corridor from referenced terrain and geometry files.

1.5-7 ORD Heads-Up Display (HUD)
New to OpenRoads Designer is the heads-up display (HUD). The HUD provides a menu of options for
various elements when they are selected. To activate the HUD for a particular element, left click on it
and then hover the mouse pointer over it. In the below example, the boundary of a terrain is selected—
which activates the HUD where you can activate the terrain in the model.

Set As Active Terrain Model

Using the HUD to Activate Terrain

1.6 Built-in Imagery in OpenRoads Designer

As of the release of OpenRoads Designer, Bentley has provided functionality to allow a user to apply
background map imagery to a geocoordinated design file via Bing Maps. This section will outline the
process to apply this imagery:

1. With a geocoordinated design file open, click on the View Attributes button in the top left
corner of the view window.

View Attributes Button



2. Onthe View Attributes window that appears, locate the Background Map dropdown menu at

the bottom of the window.

I3
View Number; 1 - F'.._h q
) Presentation HHEES
Display Style: |7 Wireframe o
Ts ACSTriad 4 Fast Cells
E Background FlH
11 Boundary Display ] Grid
Camera & Level Overrides
Clip Back Line Styles
Clip Front & tineveiatis
G Clip Volume B Marters -
Constructions @ Patterns
Default Lighting @Tags
Dimensions Texl
Dala Fields 14 Text Nodes
(3 Displayset @&
=@ Displays ransparency
Height Field
Global Brightress: @ Q
@ View Setup
W Background Map v

Background Map

3. Click on the menu, which will open to show two settings: Background Map Type, and

Transparency.
W Background Map ~
Background Map Type: | Mone e
Transparency: @ o w

Background Map Settings

4. The Background Map Type setting provides four options, which are explained below. Select

from one of the options as needed:

e None: No background map imagery is displayed.
e Street Map: Displays a street map in the background.



[55 View Attributes - View 1 -

View Number 1 - |Ey O

@ Presentation

E View Setup

Background Map

Background Map Type:

Transparency:

Street Map Background

Aerial: Displays aerial imagery in the background.

a3 View Attributes - View 1
View Mumber: 1 - |24 [F]]
) Presentation

4] view Setup

[0 Background Map
Background Map Type:

B ’5—0:‘

Aerial Background

Hybrid: Displays a combination of aerial and map imagery in the background.




| [ag View Attributes - View 1 —
| View Number: 1 ‘:.I‘—_II q

i @ Presentation

| E View Setup

W Background Map

Background Map Type:

Transparency:

Hybrid Background

5. With the desired background map type selected, the transparency of the imagery can be
adjusted via the Transparency setting:

‘ fog View Attributes - Vie — X
‘\"\ew Number: 1 - | & O

@ Presentation

@ View Setup

W Background Map
Background Map Type: | Aenal

Transparency: L) 5{?

Transparency
Q0

10

20

30

40

70
80
@

B >

Aerial Background with 50% Transparency

Note: The provided Bing maps imagery should only be used as a reference guide. The imagery is not
survey grade and you may notice inconsistency and inaccuracy when comparing to the Best Available
WMS imagery, or when looking at survey provided data.

2. Using OpenRoads Designer for Survey/Routeplat Production

The following sections discuss the usage of OpenRoads Designer for Routeplat development. These
procedures should be used for the development of survey deliverables as noted in Chapter 106
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(formerly chapter 26) of the INDOT Design Manual. More in-depth discussion of these procedures can
be found in the 2020 - INDOT ORD for Survey learning path published on the Bentley Learning Network.

In addition to the OpenRoads Designer-specific tools noted throughout this section, also keep in mind
the Survey tools provided in the Survey tab of the INDOT Tools workflow.

INDOTT::-:::Is = H ks = s

Applications Cells Annotation Tools Survey Traffic
o/ A I Gb @ _é

1 =100
Place Place Place Graphic Survey Survey LS  Survey
Line Text Mote Scale  Topo Symbols Monuments Stamps  Cells
Cuick Tools Cell Tools
—

Survey Tools in INDOT Tools Workflow

2.1 What’s Changed with Survey in OpenRoads
With the release of OpenRoads Survey, the following coding changes have been necessitated:

New Control Codes have been incorporated to replace the +0O, +D, +H InRoads offset note commands.
Note that the (-) indicates which direction would be a negative value:

e AD¥* is for vertical offsets, Up/Down(-)
o Example: AD*-2 UEO2 B would result in UEO2 2 feet below the observation at the start
of the string.
e NF* is for distance offset, Front(-)/Back
o Example: NF*4.5 PTCS would result in PTCS 4.5 feet back from the observation.
e LR* are for left/right offsets, Up/Down(-)
o Example: LR*-7 TB04 would result in TB04 7 feet to the left of the observation.

The EXTARC code can no longer be used to create a closed 3 point circle. Advisement from Bentley is
that circles should have 4 shots, with the fourth shot being near the first shot so only a small linear
element closes out the circle.

OpenRoads will automatically draw up and place text consistent with the old planimetric graphics.
However, these do not dynamically scale and now rely on MicroStation Drawing Scale tools.

NOTE: There is a known defect with ORD where survey graphics sometimes do no respond to changes in
annotation scale. Bentley and CAD Support are aware of this. If this issue occurs, instead of being able
to create the survey fieldbook first and then adjust the annotation scale on the fly as needed, you will
need to set the annotation scale first and then redraw the survey data.

2.2 Creating OpenRoads Survey Deliverable Files

With the move to OpenRoads technology for Survey, there are some slight changes to the project
deliverables when compared to SS4 and SS10. The following workflow will step through the process of


https://www.in.gov/indot/design_manual/
https://learn.bentley.com/app/Public/ViewLearningPathDetails?lpId=114008&callFrom=MyLp&aftkn=2bc7180b-0e8d-4133-9c27-fb11ce9c8bb8
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creating each file for a survey project. It is assumed that the user will be working from the Survey
workflow in OpenRoads Designer.

As the intent is that every project should now be geocoordinated, the first document in the workflow
will be the geocoordinated seed files. These will allow for all project files to be created and based off
the same coordinate system, allowing the file content to be shown spatially without the need to
configure each individual file.

2.2-1 Creating the Geocoordinated Seed Files (2D and 3D)
The following procedure steps through the process for creating the geocoordinated seed file for use
through the project lifecycle. The creation of these files allows for any CAD files based on the created
seed file to be instantly consumed by the ESRI ArcGIS Products and made available for a variety of other
uses. With OpenRoads changes to document handling and civil information, these steps should be
performed for both a 2D and 3D file (shown).

1. After creating your Survey Work Area in your DES No. specific project via the DOTWise project
creator, navigate to the Project Files folder:

=0 ProjectWise Explorer Datasources
+[_J DamageWise
5 v DOTWise (DOT\DFuller)
—1..- Documents
5. Crawfordsville
5.[/"% 0001250
+-L*% Design
+1..-— Envircnmental
1____ Motice of Entry

Consultant Files
Documents
ERMS Submittals
GPS

Images

Project Files




2. With the Project Files folder selected and its contents displayed in the Document pane, right
click in the document pane and select New -> Document.

10v:DOTWise\Documents'\Resources\CAD Support INDOTWise - InRoads'\Survey\Proje l; Go

Ust |_Spatial|

Name Description
Select View 3
New 3 Document...
Open Dependency Map...

Open as Read-Orly Multiple Documents

Version...

Open With...
Markup Advanced Wizard...
View Mo Wizard...

Check Out Plot Set...

Starting the New Document Wizard

3. You will then be presented with a series of options; select the Advanced Wizard option.

# Select a Wizard x

Document Creation Wizards

QK
N
L

No Wizard Advanced Project Wise
Wizard InterPlot
[] Make this wizard the defautt.

Using OpenRoads Designer for Design/Plans Production

4. This will start the Advanced Documentation Creation Wizard. The first panel is informational
and can be bypassed. The second panel confirms your location. If for some reason you did not
have the correct folder active in your document panel, you can select it now or confirm the path
shown.

5. The next panel allows selection of the template document. On the first line “Use a ProjectWise
document as a template” option and then press the select button.

Advanced Docurment Creation Wizard | = |

Select a Template [
*fou should select a template for created document. -{i. A
Only ProjectWise documert or extemal file can act as a template [ A

@ Use ProjectVWise documert as a template
|»——rmt selected - -- Select..

() Use extemal file as a template

Browse.

Select from recent used templates

u" o= o

Select a Template dialog



6. Inthe “Select Template Document” panel, navigate to the ORD-Connect Seed files in the
ProjectWise System and select the appropriate unit files for your project and that the file you
select is the 3D version:
pw:\\indot-pw.bentley.com:indot-pw-01\Documents\Template Documents\ORD-Connect Seed\

a Select Template Document *

Select

Folder

. ORD-Connect Seed V| u‘l | =

Document

Mame

./L- Real Estate Seed Files (2D only)
| Sheets

Pa's Survey Seed Files

/ﬂ Design_Manual Seed2D.dgn
/& INDOT_US_SVFT_2Dseed.dgn

J INDOT_US_SVFT_3Dseed.dgn

7 j seed.dwg

/ﬂ Standards_Seed2D.dgn

fﬂtranseed.dgn

< >
Address: | pw:\idotwise.indot.in.gov:DOTWise\Documents {Template Documents\ORD-Connect Seed\INDOT_US_SVFT_3Dseed.dgn w |
Description: | INDOT_US_SVFT_3Dseed.dgn |
File Mame: | INDOT_US_SVFT_3Dseed.dan |
Application: All Applications v

Selecting a US Survey Foot OpenRoads Designer Seed File

7. With your file selected, you can then proceed to the next screen. If you are prompted for
Document Attributes, you may proceed beyond this screen as well.


pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5C

8. The final step in creating the document is to provide a name. Seed drawings should be titled
with the following format: Des # SRxx Seed 3D.dgn. To ease document searches and for
consistency purposes, all three names should be the same as shown. Also worth noting is the
Application dropdown, as it illustrates the OpenRoads Designer association as shown in the
following screen capture.

Advanced Document Creation Wizard X

Document Properties
Define required document properties - the name and the file name:
Optionally, you can also define document description and version string.

New document name

[Des #_SRuox Ssed 3D dan &0

Description for the new document
[ Des #_SRax Seed 3D.dgn |

New document file name
[Des #_SRax Seed 3D.dnl |

Version

Application:

OpenRoads Designer ~

< Back Next > Cancel

Document Properties and Naming

9. Select Next to complete the document naming process. On the final two pages of the wizard,
confirm the document properties and create the document. Proceed through these and then
continue in the same Project Files folder.

10. From your Project Files folder, right-click and Check Out your IN_GeoCS.dty file locally.

Mame

# B routeplat_US_SVFT.dgn

# 8 routeplat_US.dgn J

IN GeoC

jﬂ es,cad.' W= ’

/' M4Des £ SR Open

/W4 Des # SR Open as Read-Only
Open With...
Markup

View

Check Out
Check In




11. Navigate to your newly created seed file in the Survey\Project Files folder & double click on the
file to open it in OpenRoads Designer. (Allow for Managed Workspace to download).

ProjectWise Explorer

Datasource  Folder Document View Tools Window Help
; B A | & bp By e r 2 - ~
(&2 0t ] @ o A sl |5

i B iiAddressm‘q pusiidotwise.indot.in.gov:DOTWise\Documents_Testing\0001350\Survey\Project Files\Des #_SRox Seed 3D.d ~ | B> Go

=] U:.I ProjectWise Explorer Datasources ~ | Name

&) i
- l.ig EOBW'SE (DOT\PSmock] # &) CroidNDOT_US_SVFT_3Dseed.dgn
=, Documents /M4 Des # SR LCRS Plat.dgn

L:: _?rcl’Tlve P4¥ Des # SR Seed 3D.dgn
BL; {:_’_:E%SO /M4 Des # SR Survey ent.dgn
£ {2 0001350 /4 Des # SR Survey Fi
i =-{%F Design # | esri_cadwid

| Design Review /M lan_test.dgn

# 7 IN_GeoCS.dty
# " IndianaGCS.dty
# W4 INDOT_US SVFT 3Dseed.dgn
= Finished Example # ] routeplat_US.dgn

{2 Martin /@routeplatﬁUS,SVFl'.dgn

|’ Documents

12. Open the Geographic Coordinate System dialog by clicking on the Coordinate System tool on the
Geographic tab (assumed the user is in the Survey workflow).

E‘ Survey =] H l'g:! [fs\:: 4 » * % = pw:\\dotwise.indot.in.gov:DOTWise\Documents'_Testing 0001330\ Design\InRoads\Ol
File Home d Book Analyze Geographic Edit Terrain Geometry Drawing Production Drawing View

il A A & £ = @ » o

Coordinate Global ort ure Define Synchronize Follow Google Play Camera Open Location
Systern  |Positioning Syst... GoogIeEar‘th File Google Ea fr‘th Image Placemark Monument Google Eart... Google Earth View Earth Settings Animationi..  in Google..

Geographic

Coordinate System Tool

13. In the Geographic Coordinate System dialog, click on the From Library button.

ﬂ Geographic Coordinate System - X
1: i --- o[
o LB X

Current Geographic Coordinate System

Mame: <MNone>

Description:

Source:

From Library Button in Geographic Coordinate System Dialog




At this point, the Select Geographic Coordinate System dialog is displayed. The Library tab in this dialog
contains folders with all the available coordinate systems. The Favorites, ProjectGCS, AgencyGCS, and
Library are the folders you will see. In the ProjectGCS as well as the AgencyGCS folders, there will be a
list of coordinate Systems for Indiana State Plane East and West and the Local Ground Coordinate
System (LGCS) templates..

14. At this point in the process, you may have data that can use one of the county coordinate
systems located under the AgencyGCS library. If your data conforms to this configuration,
please select and apply the correct coordinate system at this time.

Central Meridian
Origin Latitude
Scale Reduction
False Easting
False Morthing
Quadrant

Minimum Longitude
Maximum Longitude
Minimum Latitude
Maximum Latitude

E’J Select Geographic Coordinate System — O .
Library  Search
. Favorites Coordinate System L
B~ 1 ProjectGCS
G-l AgencyGCS Name_ . InGCS5-Adams
---I Library Description Indiana GCS Adams County code 01
Projection Transverse Mercator
EPSG Code 1]
Source Indiana DOT Land and Aerial Survey
Units Meter

84°5700.0000"W
40°33'00.0000"N
1.00003400
240000.0000
36000.0000
Positive X and Y
88°30'00.0000"W
84°00'00.0000"W
37°00'00.0000"N
42°15°00.0000"N

Select Geographic Coordinate System Dialog
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15. A pop-up dialog may appear asking you to choose whether you want to reproject the data based
on this newly applied coordinate system. Be sure to select the option to keep the storage units

as they are (should not be changed) as shown below.

Geograpl

b

(®) Correcting the Geographic Coordinate System - do not reproject the data

hic Coordinate System Changed

You have selected a different Geographic Coordinate System,
InGCS-Adams, for Explan 50.dgn.Untitled Design-2-30. Are you comecting
the Geographic Coordinate System, or reprojecting the data to a new
Geographic Coordinate System?

The units of Geographic Coordinate System InGCS-Adams are
Meter, but the Storage Units in the model are Survey Foot. Please
review the units used in the source data for this design.

(® The graphic elements are comectly drawn in Survey Foot. The
storage units should not be changed

(C) Change the storage units in the model from Survey Foot to Meter to
match the Geographic Coordinate System. The physical size of
graphic elements will be changed

() Reproject the data to the new Geographic Coordinate System

Cancel

Keeping Storage Units

16. The newly selected Coordinate System will now appear in the Geographic Coordinate System

dialog window as shown:

' D

Al

8P o

(i

Current Geographic G

Mame:
Description:

Source:

Des Mo_SRxx - LGCS
LGCS
ESRI PRJ [ArcGIS]

Y

Applied Coordinate System

17. Upon completion of these steps, you will need to exit OpenRoads Designer and check in your

CAD file. Please add comments upon check-in.

General  Comment

Documents

File Name

Mame
Des # SRxx Seed.dgn

P4 Des # SRiox Seed.dgn

<

Folder: _Testing\0001350\Survey Project Files

[ create new version during Check In

versors |

Updats Server Copy Free Cancel

Checking In CAD File
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With the LGCS defined within the dgn file the survey can be processed through InRoads in the typical
manner. The only difference is that MicroStation knows the parameters to convert data in any other
standard coordinate system to the LGCS. This means that ortho-imagery, GIS files, etc. can be
referenced to the dgn file and MicroStation will re-project them to the LGCS on-the-fly so that the data
is all spatially referenced.

2.2-2 Creating the Survey Fieldbook DGN file
Creating the fieldbook DGN file is the first instance where you will find the need to choose a particular
seed file. In this instance, you will need to start with the 3D geocoordinated seed file you created in the
previous section.

Note: Provided the supplied data correctly adheres to the county coordinate systems that are provided
in the geocoordination library, you may also apply the appropriate GCS to the file directly as shown in the
previous section.

1. Using the Des #_ SRxx Seed 3D.dgn you created in the previous section, create a new document
under your Survey\Project Files folder. Use the Advanced Document Wizard and instead of
pointing to a pre-existing seed file, point back to the Des # SRxx Seed 3D.dgn. Name this file

Des # SRxx Survey Fieldbook.dgn.

Note: By using the seed file created in the previous steps you will ensure starting off with a
correctly geocoordinated file. All subsequent DGNs should be created using this seed as your
starting file.

Advanced Decument Creation Wizard X

Document Properties -
Define required document properties -the name and the file name. :'l__ A
Optionally, you can also define document description and version string. Al

New document name
|Des #_SRux Survey Fieldbook dgn | a O

Description for the new document
|Des #_SRxx Survey Fieldbook.dgn |

New document file name
|Des #_SRxx Survey Fieldbook|dgn |

Version

Application:

OpenRoads Designer w

Creating the Survey Fieldbook DGN

2. Launch the DGN file from the ProjectWise Explorer by double clicking on it.



3. With OpenRoads Designer loaded, locate the Project Explorer and navigate to the Survey
section. Expand the Default tab so that Field Books are visible.

Explorer > I X

¥ Items

| OpenRoads Model
& SheetIndex

| OpenRoads Standards

| Drainage and Utilities Madel

> (¢t ¢ ¢

Survey
Q@pl.
|5€d-’t‘.‘-”‘.l P|,§ ¥

4 v Survey Data
4 v [E] Default
¥ Ty Filters

+ ) Multimedia Files

Survey Project Explorer

4. With the Field Books shown, right click on their entry. Select New...

Survey FY
Q@P.
|5‘eafn‘:l P|,§ ¥

4 v 0 Survey Data
4 v [E Default List bad
- | Ciount -I'I - |

Create Terrain Model From Field Book Selection Set

v "% Filters

L4 o Multime

@
Zoom

H lzolate

Properties

Clear lsolate
- 17—

Creating a New Field Book




5. Afield book will then be created. Note that you are not initially given the option to give it a
name, as it will be automatically created as Field Book 1. To change this, right click on the field
book and select Properties. The field book information will then show up in the OpenRoads
Designer Element Information panel, like any other OpenRoads element. You can rename it in
the Name field—and it is recommended to maintain the Des # SRxx convention.

Properties (Survey)

v o x

4 () Selection (1) File
v [ Field Book 1 @ Items
&) Resources
| OpenRoads Model
Selection -~ & sheetIndex
Name Field Book 1 e Links
Field Book -~ | OpenRoads Standards
Eie“’ Book 1 | Drainage and Utilities Model
1 | Survey
9%
2215 QP
15 Search
2200
4 v [ Survey Data
4 v [ Default
4 v [l Field Books
D_ q Create Terrain Model... I
¥ ¥y Filters Export To »
Models R 1x ¥ @ Multimedia | Delete
1hedoY :
Type 20/3D Name Description @]l Properties
W P Default Master Moc B Zoom
4 lsolate
Clear Isalate
ES  Details
@ Properties

Renaming a Field Book

6. With the field book renamed, you can now import your data. Right click on the field book and
select Import > File... OpenRoads field books allow for the import of a wide variety of data types
and formats. Additionally, existing FWD surveys from SS2 can be directly imported into the
OpenRoads environment using this tool.

| Survey ~
Q@ Pl
|.Sfa'mﬁ p| ox
4 v [ Survey Data
4 v [E Default Field Book A~
4 v [l Field Books Name Field Book 1

Control Points 0

Create Terrain Model...

v %, Dat: 0
+» Dati
Export To r =0
v AL 0
Delete En
v LA
Import G File...
v %A

@1 Properties File Using Text Import Wizard...
TrimbleLink...

Leica DBX...

v Tr Al
, Zoom
v %R ALL
Isolate
v Ty Fi
¥ Filters Clear lsolate Bentley Survey Format...

v @) Multimedia riies | I| Features From Current Graphics

Importing Survey Data



7. Onthe presented ProjectWise Open dialog, navigate to your Survey\_Raw Data folder and

locate your data collector file(s) to attach them.

8. With your data files attached, you will see output similar to the following.

Raw Survey Data in OpenRoads Designer

9. Asyou can see, there appear to be numerous issues with the TOPO display.

a.

First are the points denoted with the exclamation point (!) icon. These are points that
the OpenRoads environment does not have codes for. These should be adjusted to
known codes within the environment.

Point symbols and linestyles are not displaying properly. Using the Drawing Scale tools
mentioned in Chapter 5, first enable Annotation Scale Lock, and then pick your required
scale. This example will proceed with using 1”=50". To reiterate the note from the
beginning of the chapter, as of this writing, in the current ORD version (ORD 2021 R2)
your survey data may not respond to changing the annotation scale. If this happens, you
will need to set the annotation scale FIRST, and then redraw the survey data.

Linework denoting both the observations themselves, along with the instrument setups
will be displayed. In the Survey section of Project Explorer, disable these two options
prior to handing your data to design.

. Survey -~
Q QP

|5r'5m‘= LlLex
4 «~ 1 Survey Data

4 ¥ [ Default
4 v [l Field Books
4 ~ [ Field Book 1

b & % DataFiles

b & ¥ ALL Point Features

b % 0 ALL Linear Features
% ALL Control Points
71 ALL Setups

q %% ALL Observations

3 E Adjustment

~ Ty Filters

~ ) Multimedia Files

Disabling Setups and Observations
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d.

Finally, survey notation information will appear around each point, like the old

planimetric graphics in SS2. To disable these, open the Level Display and disable the

levels shown. Alternatively, you can right click on the ALL Point Features in the Survey

Fieldbook and select Annotations -> Turn Off All Annotations. You can also turn them

off from the Decorations section of the Analyze tab in the ribbon.

Level Display - View 1

Gy [ViewDisplay -

[ tone) ~ [Levels 7] [aA ~

=

> iX

V8 Des #_SRux Survey Fieldbook dgn

Name

Survey Names
Survey Codes
Survey Notes

Survey Hevations

. mE
H
a
>

Disable Survey Notation Graphics

ﬂ Survey

F |

e

Explorer Details

~ [ Survey Data
4 « [ Default
4 | []l Field Books
4 W [ Field Book 1
b« % Data Files
b S
. . —— e
> ¥ L AlUlinear  Detail A N\—
— L,
% ALL Contry Annotations... * Turn Off Annotations I
f1 ALL Setup: Mew... Turn Off VBA Annotations I
%, ALL Obser @] Properties |
I & Adjustmer B 7oom Turn Off All Annotations
| Ty Filters s Isolate _ 4
Turn Off All Annotations
M= lﬂ "._:; o & -~ ; =& fs = pw:\\indot-pw.bentley.com:indot-pw-01\Documents'_Testing',0001350\ DesigntInk
Field Book r.i'-.nal‘,-'ze Geographic Edit Terrain Geometry Drawing Production Drawing Utilities Collaborate View Help
q r/ Ay Reset Details k (z';: _C‘_h rj 9 E E 8 Names [l Descriptions [ lcons | o—o :ﬁ\ A :%,'
- i 8 Field Codes 8 Setups el
Element ..., Report Redraw Media All VBA i i Measure Measure Measure —,
Selection L. v Annotations Annotations || [ Elevations [ Observations Distance Radius  Angle &
Selection View Annotations Decorations Measure

Primary

Decorations Section of Analyze Tab



10. With these previous items resolved, your TOPO display will now look like the following and in
line with expectations.

Cleaned up TOPO Display

NOTE: From time to time, the line styles that contain embedded text may not appear correctly, with the
text symbol being disproportionately large. If this happens, please refer to the DOTWise 5.0 Technotes
document, in the CAD Workspace/MicroStation Platform section..

11. With the fieldbook now created, you can proceed to saving your file back to ProjectWise.
Before closing the document, first save the settings. This can be done by clicking on the Save
Settings button on the Quick Access toolbar, or via selecting Save Settings from the File
menu/Backstage View. Then close the application and check in your file.

2.2-2a Editing Fieldbook Features
Unlike the previous version where all features were edited in the fieldbook in line with how they were
shot, OpenRoads Survey prioritizes the individual features from an editing standpoint. To interrogate
individual features, you have multiple options on how to interact with them. This section will take a
brief look at two of the more immediate methods.

First up is the table-based editor. With your fieldbook open and selected, drill down to either the ALL
Point or ALL Linear Features and select one of the codes. Keep in mind that all breaklines will also have
point definitions as that’s how OpenRoads defines them. With a point or linear feature selected, go to
the Details tool in the Primary Group of the Field Book tab.
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Survey Details Tool

This will open a tabular view of the selected feature. Depending on the feature selected, you can
change the name of the feature or shot, if it is included in the triangulation, or
northing/easting/elevations, and other items. To modify any field, place your cursor within it. Ifitis a
dropdown, you will be presented with the applicable options. If it is a text entry field, enter the
appropriate information. In both instances, once complete, hit the Tab key to confirm the change.
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The other method of editing surveyed features is graphically. In the main display that shows your TOPO
elements, you can select on any feature and review its properties in the Element Information panel. In
this view you can edit the same data as you can in the details. Additionally, in the graphical side, all
elements will be given heads up element handles that you can grab and manipulate.

'

Create Import

Properties
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General
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Color 14

Line Style £ ugas

eight Ho
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Export
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2.2-3 Creating the Terrain Model
With the Survey Fieldbook now created, you will need to create the OpenRoads Terrain model. Note
that it is no longer necessary to create a boundary surface as it is automatically created when the terrain
model is generated. This boundary is automatically defined by the extents of the triangulation and will
automatically update as you are editing features or the triangulation itself.

1. To proceed with terrain generation, re-open your survey field book DGN from the previous
steps.

2. Navigate to the Survey section on the Project Explorer. Right click on your Des #_SRxx field book
and select the Create Terrain Model... option.
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3. When processing is completed, the terrain model will be created and displayed. The default
display style is to show Existing Contours at a 5:1 scale. The display will look like the following.

Survey with Created Terrain Model

4. At this time, you can investigate the terrain model. To select it, go to the OpenRoads Model
section on the Project Explorer. Expand out the Terrain Models listing on the tree and select
Des #_SRxx Survey Fieldbook.

OpenRoads Model S
*- Q f ]

| Seanch 2lex

4 £ ORD Survey Fieldbook_NEW.dgn (Default)
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4 % Terrain Models

4 < ¢ Existing_Contours_5: 1.0

o) |+ Des# SRux Survey Fieldbook

23| Survey Generated |_

The Terrain Model



5. By selecting the Terrain Model, you can then interrogate its properties in the Properties panel.
Reviewing the terrain in the panel allows you to control display items such as the maximum
length of triangles, whether contours should be displayed, displaying the triangulation, etc. The
following shows all the relevant settings for controlling the terrain display.

Properties (OpenRoads Model) v 1x
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Edge Method ~
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Minor Contours On
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Source Features Display ~
Breaklines Off

Boundary On

Imported Contours Off

Islands Off

Holes Off

Voids Off

Feature Spots Off

Feature ~
Feature Definition Existing_Contours_5: 1.0
Feature Name Des # SRxx Survey Fieldbook

Terrain Model Element Information




6. With the terrain model now having display settings for items such as the perimeter, contours
and triangulation, it is no longer necessary to use the Level Display to disable these items.
Simply use the Element information panel to shut these items off in preparation for the final
deliverables.
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Extended v
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Triangles Off
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Islands Off
Holes Off
Voids Off
Feature Spots Off

TOPO Display with Terrain Display Off

7. At any time, these features can be redisplayed simply by toggling the relevant feature on.



54

8. For the terrain to correctly display in referenced documents, make sure it has been activated.
Again, on the OpenRoads Model section in Project Explorer, right click on your terrain and select
the Set As Active Terrain Model option. Alternatively, you can activate it via the heads-up
display (HUD).

~. OpenRoads Model -~ lﬂ Des # SRux
Q@ L.

|5r'§.’f\‘." P |/ ¥

4 £ ORD Survey Fieldbook_NEW.dgn (Default)
~ Alignments

% Terrain Models

4 < Existing_Contours_5: 1.0

55| Survey Ge:*neratel,,2
Tﬂ Corridors
€\ Linear Template

S

Set As Active Terrain Model I

Export Terrain Model L

Update from Source »
& surface Templates

ke Civil Cells

& Superelevation

Templates

Delete

D X F O

Zoom

» Cant Isolate

/" Linear Geometry Clear Isckate

Set Active Terrain Model in ProjectWise Explorer

Set Active Terrain in Heads-Up Display

Note: This workflow no longer allows for the editing of features once they have been sent to the terrain
model as it becomes a “ruled” feature. If any changes are needed to surveyed features, the terrain
should be deleted and recreated from the field book once the changes have been made.



2.2-3a Triangulation Clean Up and Terrain Editing
OpenRoads terrains have similar commands to the previous version of InRoads allowing for the
modification of a triangulated terrain. The first option to clean up the triangulation extents is to adjust
the max length of the triangles it creates.

In the software, select your terrain either from the Project Explorer, or graphically select the terrain
perimeter on the screen. In either instance, select the Properties button.

Properties :
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On the Properties panel for your terrain, locate the Edge Method heading and from there you can adjust
the max length as you did when triangulating a DTM in the old version. From here, you can tighten up
the triangle lengths to get a more defined perimeter for your project without editing the terrain content.

Properties (OpenRoads Model) yhax
4 [ Selection (1)
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MNumber of Triangles 8.084
Edge Method ~
Edge Method Max Edge Length
Length 2000000

Max Edge Length Setting



Note: Changing the triangles max length will force the full triangulation to re-process. Please make sure
to have this value finalized prior to performing any further terrain edits.

Additionally, you can directly edit the terrain by disconnecting the survey processing rules to allow for
such functions as cleaning up any unnecessary triangles. These steps will look at how to disconnect the
terrain from the survey for editing.

1. Locate the Survey section on the Project Explorer. Right click on the model name (in this
example, Default)
2. Select the Deactivate Survey Processing Rules option.
Explorer Wi S Proper

i Items

| DpenRoads Model
iL? sheet Index

| OpenRoads Standards

| Drainage and Utilities Maodel

| Survey
|5‘e.-;m‘:| P| L
4 v [ Survey Data
4 M ) y
Deactivate Survey Processing Rules
[P
Show Message lcons
o |
Hide Marmes
v A

Show Features
Show Elevations
Show Descriptions
Hide Setups
Hide Observations
]  Properties
,9 Zoom
i |zolate

Clear Isolate

Deactivate Survey Processing Rules

This process disconnects your field book and terrain completely. Changes made to the field book will no
longer automatically be reflected to the terrain. This is like how the DTM and FWD were disconnected
outside the Survey Data to Surface process. Although they are in the same file, they co-exist as two
separate entities.

56 |
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With this disconnection completed, you can then use the terrain editing tools to interact with the terrain

for functions such as cleaning up triangles. Please keep in mind that all terrain edits must occur in a 3D
model. For instance, to delete triangles:

1. Continuing from the previous steps where the survey and terrain model were disconnected,
click on the Edit Model tool from the Edit Group in the Terrain tab.

ﬂ Survey = H "._:5 B::z *- - * |_Q.] l;?,_, s pw\\dotwise.indot.in.gov:DOTWise\Docurnents,_Testing'0C
Home Field Book Analyze Geographic Edit Terrain Geometry Drawing Production Drawing Viev

r @j * ? # From Fil Edit Complex Model Etb

G}\ | From Graphical Filter Feature Management ~ R

Explorer Attach Properties | Element ..., d't":'”al ACt'V _ Transform
Selection L. * 4% From Elements Methods = v dary Options

Primary Selection Create Edit
Edit Model Tool

2. At this point you can modify the triangulation in a number of ways. One of the most useful is
the ability to remove triangles with a crossing line. The 6% tool on this panel (highlighted) is the
Delete Triangle by Line command. Select it and then click on your terrain model.

&8 Edit Terrain Mode _
K B C<0 BR X% [

Delete Triangle by Line



3. With the terrain selected, draw a line as prompted across all the triangles that you wish to
remove. The bold lines indicate the crossing line as well as the outline of the triangles to be
removed. Confirm what’s to be cut with a single data point click.

Top — Before Trimming Bottom — Trimmed Result

This same methodology can be applied to most of the terrain editing tools. It is imperative however,
that as we did earlier in this chapter that the survey and terrain be disconnected through the survey rule
deactivation.

Throughout this section you have looked at how terrain editing works with the survey disconnected. As
an extension of this, one may ask what happens if you turn the survey rules back on. To do so, reverse
the process in the first part of this section and you will receive the following prompt:

Confirm

o Activating rules will revisit all elements, Continue ?

Yes Mo

Reactivation of Survey Rules

Selecting Yes will cause the terrain and survey to relink. It will also re-establish the terrain back to how it
was created from the survey, removing any changes or cleanup performed.



2.2-4 Verifying Topo using 3D Rotation and Shading the Triangulation
The View toolbar (located in the upper left of the view window) gives access to rotate 3D drawings to
any one of 9 predefined Views. Isometric View and Right Isometric View are the most useful to rotate
quickly to a 3D orientation. Option number 1 — Rotate View allows dynamic view rotation.

w Viewl - Top, Default
B-r-adx-AQ_RBEHNI WEEIAFAITES

4y 1 Rotate View |
2 TopView
3 Front View
4 Rinht View

Results will be similar to below.

Note: Alternate access to 3D rotation can be obtained from mouse functions. This involves the Alt-
Middle dynamic rotation. This is also the same as Option 1 Rotate View - dynamically

Alt & Middle click



Wheel Button
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The Drawing View will have a crosshair placed in the drawing. This is automatically placed at the center
of the graphical elements in the drawings.

Any subsequent rotation will be about this point unless you dictate otherwise. (This is rarely the desired
location.)



The rotation origin can be modified by tentatively snapping to the desired location (left right chord) or
by graphically dragging the cursor to a new location. When the cursor is moved over the crosshairs they

become highlighted as shown.

Press and hold the left mouse to graphically drag to a new rotation origin. AccuSnap is particularly
useful in this operation. When the left button is released, so is the cursor at the new location.

Subsequent left mouse dragging will dynamically rotate the drawing. (Make sure you are no longer over

the origin.)




Note: Subsequent panning and additional Dynamic rotation will change the perspective, allowing you
to see any portion of the project from any angle

Returning to Plan View
In CAD, the normal Plan View is referred to as Top View.

Simply select the icon to the right of Fit view.

w Viewl - Top, Default
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Isometric View

¥
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Resulting view:

You also may wish to verify the triangulation by applying shading to see if any holes exist. With your
triangulation displayed, click on the View Attributes button on the upper left hand corner of your active
MicroStation view. The very top option for presentation will be listed as wireframe by default. Change
this setting to smooth as shown, and your triangulation will look as shown.



W Viewl, Default
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View Number: 1 - | &y G
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Display Style: &% Smooth Il] =]
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Smooth Shading on View Attributes

Topo with Smooth Shading

You can switch back to the wireframe display by performing the same steps, changing from Smooth and
back to Wireframe. Note that there are additional display styles available that can also be used.
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2.2-5 Creating the Survey Alignment File
To create a survey alignment file, the first step is to create a new 2D geocoordinated seed file per the
instructions in section 2.2-1. Then proceed with the following instructions:

1. Using the Des # SRxx Seed 2D.dgn that you should have already created, create a new
document under your Survey\Project Files folder. Use the Advanced Document Wizard and
instead of pointing to a pre-existing seed file, point back to the Des # SRxx Seed 2D.dgn. Name

this file Des #_SRxx Survey Alignment.dgn.

e L I e T e e e L L e e O I e W e e e

Advanced Document Creation Wizard >
Document Properties
Define required document properties - the name and the file name. B A
Optionally, you can also define document description and version string. &y

Mew document name
|Des # SRwx Survey Alignment.dgn | a ]

Description for the new document
|Des H SR Survey Alignment.dgn |

Mew document file name
|Des H SR Survey Alignment.dgn |

Version

Application:

OpenRoads Designer

Creating Survey Alignment File

2. Launch this newly created file from ProjectWise Explorer.

3. Once in the survey alignment file, proceed to attach the survey fieldbook file to access the
terrain model and topo features. In the Primary tool group on the Home tab, click on the Attach
Tools button and proceed to attach the survey fieldbook file.
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Attach Tools Button
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File Mame: PW_WORKDIR:d0TTeE45\ORD_Survey Fieldbook_July 22.dgn
Full Path:  ..\pw_workhd07766458ORD_Survey Fieldbook_July 22.dgn

Model: | Default

| Logical Mame:

Description: | Master Model

Orientation:
View Description
Coincident Aligned with Master File

Coincident - World

Standard Views
Saved Views (nong)

Gecgraphic - AEC Transform
Gecgraphic - Reprojected

Global Origin aligned with Master File

Mamed Boundaries (none)

Calculated Transform, max error 000036131
Reproject reference data to Master GCS

Detail Scale:

Scale (Master:Ref):
Marmed Group:
Revision:

Level:

Mested Attachments:
Display Overrides:
Mew Level Display:
Global Line5tyle Scale:

Synchronize View:

Toggles

Full Size 1= 1 v h

1000000000 | 1.000000000
Live Mesting ¥ | Mesting Depth:
Allow 7

Use M5_REF_MEWLEVELDISPLAY Cor

Master - d—

Yolume Only 7

EIE=N @ - < e

oK

Cancel

0

Survey Fieldbook Attachment Settings

As shown above, the Detail Scale and Global LineStyle Scale settings are specifically called out.
These two settings should always be set as shown for Drawing Scale to scale them correctly.
Proceed to attach the survey fieldbook with these settings. Then, set the Annotation Scale in
the alignment file to be consistent with the fieldbook (1” = 50’) in this case.



5. With the fieldbook attached, activate the terrain associated with it. This will create and
reference attach an additional model with a -3D added to its name.

Activating the Attached Terrain from Fieldbook

6. With the fieldbook attached and terrain activated, you will now see the terrain model on the
OpenRoads Model tab in Project Explorer under Referenced Models.
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# Alignments
el % Terrain Models
4 < Existing_Contours_5: 1.0

53| Survey Generated

H Corridors

N Lingar Template

& Surface Templates
<l Civil Cells

7 Superelevation
<~ Cant

/" Linear Geometry

[& 3D Linear Elements

& Drimtc

Activated Terrain Model in Project Explorer



the appropriate element template for the alignment.

in the Attributes tool group select the Element Template dropdown. Then on the Element
Template dropdown, navigate to Survey > Geometry >S _ALG_Alignment. This will
automatically set the correct properties (level, color, line style, etc.) for the alignment you will

be creating.

xd Survey A= - | AP N o= N F
File Field Book
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Analyze Geographic Edit Terrain Geometry Drawit

S_ALG_Alignment

Recent Templates
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Geometry
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] Property
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Setting Element Template for Survey Alignment

Horizontal Geometry tools to create your alignment.

8. After setting the element template, you can navigate to the Geometry tab and use the

7. At this point, you can start creating your survey alignment. The first step in the process is to set
To do this, navigate to the Home tab, and

EJ Survey ~ @ S H ts:g Es\:: - v A * % |_—s\3 f's:‘; = pw:i\indot-pw.bentley.com:indot-pw-01'Documents
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9. Upon the completion of creating the alighment, you will need to create a complex element out
of it. In this example, the Complex By Element tool will be used. Ensure the S_ALG_Alignment
feature definition is selected. If it is not, click on the Feature Definition dropdown and navigate
to Alignment >S_ALG_Alignment to select it. Then enter the name of your alignment. Line Ais
used in this example. Once the name is entered, proceed to select the individual elements of
your alignment to create the single complex element.

Parameters ~

Method

Maximum Gap 0.0328

[=n

Feature
Feature Definition |S_ALG_Alignment |~
Mame ine A

Create Complex Element with Alignment Name

2.2-6 Updating Older Survey Data to OpenRoads Designer
Importing a field book from older survey data can be a very straightforward process. This section will
cover two methods to accomplish this. The first method to be discussed is to import an FWD file
directly. The second method is to take an existing survey in SS10, convert its data to LandXML and then
import it into ORD.

2.2-6a Importing Survey Data from FWD Files
This section will cover how to import survey data into ORD directly from FWD files. Please keep in mind
that while reviewing these instructions, the extent of additional cleanup that will need to occur will
depend heavily on if 3-point circles were created using the EXTARC command or if offsets were coded as
part of the notes (+O, +D, +H). The following steps will cover how to import FWD files, and in the case of
the offsets, how to find and modify the shot so the output is correct.

1. Toimport an FWD field book file, navigate to the Survey section on the Project Explorer.
2. Onthe Field Books heading, right click and create your Field Book. Please use the standard Des
# SRXX naming conventions.

Survey ~
Q@P.
Search plew

4 ¥ (3 SurveyData
List ~
Count n

Create Terrain Model From Field Book Selection Set

4 v/ [ Default
L]
v Ty Filters

v € Muttime

New.

/

@] Properties
D Zoom
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New Field Book



69

3. Right click on the newly created field book entry and select the Import -> File... option

to your FWD file and open it.

| Survey s
‘-: q : -
|5r'5.fw'3 blex
4 &[] Survey Data
4 v [E Default Field Book ~
4 v [l Field Books Neme  Field Book 1
Control Points 0
. Il Goorue;
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- % Dati - - ¢ D
Export To v =0
o Yy ALL 0
Delete n
v Al
Import ’ File...
v % ALL ) ) . :
@ Properties File Using Text Import Wizard..,
+  Jr AL
D Zaom TrimbleLink...
s -
A AL lsolate Leica DBEX...
S o
Y ¥ Fikers Clear Isolate Bentley Survey Format..,
¥ @ Multimedia ries | -| Features From Current Graphics

Import Field Book from File

consistent across versions. Continue for how to resolve these changes.

. Navigate

4. OpenRoads Survey will now import this data and create the field book and graphics.

5. If your survey did not use any offsets in the Note field (Descriptions in OpenRoads), you can
proceed to work with the survey using the OpenRoads tools as you have throughout this
chapter.

6.

If your survey contains offset notes, at this time these will need cleaned up so your data is



7. Select the All Point Features from the field book on the Project Explorer.
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8. Onthe Field Book tab in the Ribbon, select the Details tool from the Primary Group. This will
open the table view with all your points.
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9. On the table view, right click on the Description field and use one of the sorting methods. Be
advised that this is just a single method, and you can also use the find commands, or even drill
down to specific features and perform similar steps. For this example, you will be using the Sort
Ascending command.

£ Survey Details — %
(=] Blement List 5, Message Center
MName Display Field Code Link Code Zone Descripy == Model At..  *
» 552 True PSSA None 1 opus 2.2t SotAscending ByFe..

55 True PSsA None 1 orugg| Av  ortDescending o By Fe..

551 True PSSA None 1 PRE5 W| Custom Sorting... e By Fe

200 True PSSA MNone 1 CAMPBH Rename & By Fe

204 True PSSA MNone 1 MW COR Show Columns ¥ leByfe

208 True PSSA None 1 CAMPBE Freeze This Column e By Fe

n True PSSA None 1 IRONPI Alignment Y lemyre

212 True PSSA MNone 1 SMITH A Edit... e By Fe

213 True PSSA None 1 nw cor B Find... e By Fe

214 True PSSA None 1 wesT1| A Replace.. e By Fe

215 True PSSA None 1 PRE4 UP 1.6 AG NO CAP RECEI. | Detemine By Fe

216 True PSSA None 1 SMITH REBAR FD 0.3 AG THIS | . | Detemnine By Fe

412 True PSSA None 1 DELETED 3:05:27 PM 3/16/2009 . . | Detemine By Fe

413 True PSSA None 1 DELETED 3:05:31 PM 3/16/2009 | Detemine By Fe

414 True PSSA None 1 DELETED 306401 PM 3162009 | Detomine ByFo. |

. o - e - b R T SR
of 2219 | b B

Sorting Point Features

10. With the list sorted, all common offset notes in the Description field will be grouped together.
You may either scroll down to where these are or use the Find... command to quickly jump to
these in the list.

£ survey Details - s
[ Blement List % Message Center

Name Display Field Code Link Code Zone Description Temain Model At... ™

1501 True DP21 None 1 202 DPL1 THIS IS AN EDITED R... | Determine By Fe.

1500 True DP21 None 1 202 DPL1 THIS IS AN EDITED R... | Determine By Fe.

1459 True DP21 ArcPC 1 202 DPL1 THIS IS AN EDITED R... | Determine By Fe.

1296 True DP31 ArcPC 1 202 DPR1 THIS IS AN EDITED R... | Determine By Fe.

2044 True EP21 ArcPT 1 202 EPL1 THIS IS AN EDITED R... | Determine By Fe.

1483 Tue EP21 ArcPC 1 202 EPL1 THIS IS AN EDITED R Determine By Fe

1480 True EP31 AcPC 1 202 EPR1THIS IS AN EDITED R... | Determine By Fe.

1300 True EP31 ArcPT 1 202 EPR1THIS IS AN EDITED R... | Determine By Fe

1503 True ES21 None 1 202 ESL1 THIS IS AN EDITED R... | Determine By Fe.

2089 True ES21 None 1 202 ESL1 THIS IS AN EDITED R... | Determine By Fe.

1758 True ES21 None 1 202ESL1 THIS IS AN EDITED R... | Detemmine By Fe.

1659 True ES21 ArcPC 1 202 ESL1 THIS IS AN EDITED R... | Determine By Fe.

1709 True ES21 None 1 202 ESL1 THIS IS AN EDITED R... | Determine By Fe.

2137 True ES21 None 1 202 ESL1 THIS IS AN EDITED R... | Determine By Fe.

2184 True ES21 ArcPT 1 202 ESL1 THIS IS AN EDITED R Determine By Fe y
. oo = P _ - e e e o o - ———

Row: |4 4 |1 of2219 | b Ml

Sorted by Description




11. Click on the Control Codes field for one of the entries. Unfortunately, this tool does not support
bulk edits. In the case of the following example, you have a left offset of 1 foot, so the Control

Code will be set to LeftRight and a value of -

1 entered. Please keep in mind that you must use

the Tab Key in the Value field for the record to be confirmed. Repeat this step for any point

necessary.

ﬂ Survey Details
[=! Element List Iy Message Center

| Accept | Add Delete
| Control Codes | Value
LefRight -1

s

<

Description = Temain Model At...  Attibutes Pair Control Codes Easting Morthing Elevation [l
3 Determine By Fe... 417182164 39828.3582 508.4584°
Determine By Fe... 41706.2066" 398011577 507.8755'
Determine By Fe 41700.5480° 39789.7703° 507.0073
Edit Property Value # tm 33868.2928' 5076465
Control Codes X
9 | >

Row: 4 4 |1 of2219 | b M |

Modifying/Adding a Control Code for Left/Right Offsets

12. Locating your point in the display, it will appear that it has not moved to the offset entered.

Much like InRoads before, the display will n

eed redrawn. To do so, go to the Analyze Tab, and in

the View Group, select the Redraw tool. Your observation will then be reflected in the TOPO.

Tl survey M=l IRl AT pwi\dotwise.indot.in.gov:DOTWise\Documents)_Testing)0001350\Design\InRoads\0ld Testing Data\te.
Home Field Book | Geographic Edit Terrain Geometry Drawing Production Drawing View
lFH @ Ay Reset DS e %ﬁ : 7 8 Mames [l Descriptions Ml lcons  o—o ;9\ A
Q &7 L ] =] ) (o=
[l Field Codes [ Setups
Explorer Details Reporl] Redraw [ Al VBA Measure Measure Measure
- - Annotations Annotations [ Elevations [l Observations Distance Radius  Angle

Primary

Annotations

Decorations Measure

Redraw the Survey

At this point you will have the survey migrated over to OpenRoads Designer. Note that there will still be
clean up needed, such as resolving any 3-point circles or other coding issues that the above did not fix.
In many instances, bringing the survey forward should be a quick and painless process.
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2.2-6b Importing Survey Data in LandXML Format
This section will cover how to take an existing survey in S510 and convert it to LandXML format to
import into ORD.

Note: When exporting survey data from $510, make sure to disable the Setups and Observations entries
under the fieldbook. A defect has been found and logged, and having these enabled will prevent survey
notes (descriptions) from properly coming across.

1. With your survey fieldbook file open in InRoads SS10, navigate to the Survey tab in Project
Explorer and expand the Field Books folder to show the created fieldbook.

®W Project Explorer — X

e Links Fle 9§ Utiity Model < Civi Model ¥ Civil Standards ) Survey

= [ Survey Data

(R Defaut
-1 Field Books
¥l af 1/01044_TOPO

Survey Field Book

2. Right-click on the field book listing and select Export To > LandXML Format.

4 Project Explorer - *

B Links Fle § Utiity Model < Civil Model *} Civil Standards [ Survey
=-fA [ Survey Data
2[R Defautt

{7 Field Books

R wIlEY 1701044 TOPO

vy Fitters Load r

F" Properties

Create Terrain Model...

Muttimedia Delete
| Export To » | InReads Format

MX Format

Land¥ML Format

Trimble Link Format....
Leica DBX Format....
DGM Graphics...

Export to LandXML Format




3. You will then be prompted to provide a name for the exported file and its saved location in
either ProjectWise or locally on your computer. Specify these settings as desired.
4. In a brand-new survey fieldbook file in ORD, create a new field book as specified is section 2.2-2.

5. Right-click on the new fieldbook listing in Project Explorer and select Import > File from the
menu.

~
l
p

4 2 Survey Data
4 v [E Default
4 v [l Field Books
4 | v | Field Bock 1
v % Data Files

Create Adjustment

Create Terrain Model.,
¥ 7% ALL Point

Export To L
v 25 ALL Linea Delet.
elete
v % ALL Contr \mport » Fib
ile...
7 | .
ALL Setup ) Properties File Using Text Import Wizard...
-
v RALLOEs: g L TrimbleLink...
- "
~ "y Filters B8 olate Leica DBX...
¥ ) Multimedia Files Clear lsolate Bentley Survey Format..
:E Details Features From Current Graphics
| Properties

Importing LandXML File

6. Select the LandXML file you exported out from SS10 and proceed with the import. The survey
data will now be imported into the file.

o View 1 - Top, Default = =N 55
Brai-ld LoRanlbomED Ry

Imported Survey in LandXML Format



2.3 Routeplat, Reference Box and Section Corner Card Creation

The following sections will walk through the process to create a complete route plat sheet. This will
include creating the file in ProjectWise, examining its contents, and working with/referencing section
corners.

2.3-1 Creating the Route Plat .dgn File
Prior to placing any content into the route plat, you need to create a drawing to work in. This process
will be same to the steps performed in section 6.2-1.

Using these steps, you will need to make two adjustments.

1. When selecting your seed file, select the appropriate unit file from:
pw:\\indot-pw.bentley.com:indot-pw-01\Documents\Template Documents\ORD-Connect
Seed\Survey Seed Files\

Select Template Document X

Select

Folder

||:_ Survey Seed Files v‘ Lo | | EE |8

a

Document

Name

/J esri_cad.wld
/1 IN_GeoCS.dty
/EJ routeplat_US_SVFT.dgn

< >

Address:

Description:

File Name:

Application:

All Applications ~ ‘

Selecting a Route Plat Seed



pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5CSurvey%20Seed%20Files%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5CSurvey%20Seed%20Files%5C

2. Your document name, description and file name should all be set in the Des # SRxx LCRS
Plat.dgn format.

Advanced Document Creation Wizard

Document Propertics
Dfne required document properties -the name and the file name
Optiorally. you can als define document desrption and version string.

New documert name

|Des #_SRec LCRS Platdgn | &

Description for the new document
‘Des # SR LCRS Plat dgn ‘

New documert file name
‘Des # SR LCRS Plat dgn ‘

Version
Application
| MicroStation

Route Plat Naming

2.3-2 Contents of the Route Plat Template Files

Each of the route plat templates contains five models. These can be accessed by going to the Models
icon in the OpenRoads Designer Ribbon:

21! survey =1 | ~-JI- =T

Home Field Book Analyze Edit Terrain Geometry Drawing Preduction Drawing

@ [None | Default - %‘ Explorer @ Reference « i@ Properties
= — @ Attach Tools = ’;333 Level Manager ™ % More *
[0 =0 =0 Q@0 4 Models = = Level Display ~

Attributes Primary

Accessing the Models Dialog

By selecting this icon, you will be presented with the following window and list of available models:

Madels — >
D

Type 2D/3D Mame Description o
() [P Default Master Model v
c?_] | Coordinate Table Reference Point Coordinates ¥
@ SV Section Corner Refer.. Survey Section Corner Reference.. +
Q_] I Point Mumber Description ¥
[H _l Plat Routeplat Sheet ¥

Available Models in the Template




The five models available are:

vk wnN e

Model.

Coordinate Table — This is the template Reference Point Coordinate Table.
Default — This is the default MicroStation model and is available in all .dgn files.
Plat — This is the template route plat sheet model.

Point Number — This is the template reference box model.
SV_Section Corner Reference Card Sheet — This is the template Section Corner Reference Card

2.3-3 Creating Reference Boxes

The following steps go through the process of creating a model containing the control point reference

box for use in either Route Plat Sheets or the Section Corner Reference Card.

1. Openyour Des # SRxx LCRS Plat.dgn from ProjectWise.

2. Asshown in the previous section, open the Models dialog from the toolbar icon.
3. Onthe Models dialog, double click on the Point Number model to open it.

£
Type 2D/3D Name

[ Default

U

]

u

i

SV_Section Cor...
Point Number
Plat

8P| E VI X

Description

Master Model

Coordinate Table Reference Point Coordinates

Survey Section Corner Reference...
Description
Routeplat Sheet

Description

The Point Number Model

4. Select the Copy Model icon from the Models dialog.

= |
I o v x
Type 20/30 MName Description
fh‘l [ Default Master Model
‘C.}_] | Coordinate Table Reference Point Coordinates
@ _l SV Section Cor... Survey Section Corner Reference...,
% B Point Number Description
[g 1 Plat Routeplat Sheet

Copying a Model



5. The Point Number model has active field as shown in the earlier capture (the gray shaded areas
for Point Number and Description). During the model copying process, you will be prompted to
create the new model with a new name and description. The values for point name and
description should be entered as you would like them to appear on the completed control point.

—

3 -~

+ ) @2 Y X xl
Type 20/3D Mame Description Model to Copy: [Point Number -

[T} I Default Master Model

21 ' Coordinate Table Reference Point ( MName: | 174
= | SV_Section Cor.. Survey Section C Description: | EAST CORMER 5,35, T.21M, R.9E

., B Point Number Description Ref Logical:
[ L Plat Routeplat Sheet D Logieat

oK Cancel

Point Number Model Copy

6. Once the model information has been entered, select OK. The completed model copy will
become active and will show the name and description in the control point as shown. Repeat
steps 4 and 5 for each additional reference box you require.

&
+ DS Y|X

Type 2D/3D Name Description

T Default Master Model
21 Coordinate Table Reference Point Coordinates
IE | SV_Section Cor... Survey Section Corner Reference...
| Point Number Description
@ Plat Routeplat Sheet
EAST CORMER 5.

EAST CORNER S.35, T.21N, R.9E

Completed Point Number Model Copy



7. Next, the control point content needs created. If not active from the previous steps, enter your

control point model by double clicking on its listing in the Models dialog. Once in the

appropriate model, open the INDOT Tools workflow in MicroStation, and locate the Survey tab:

&4 1INDOT Tools

ECHER - > 224k s

s

Place Place Place
Line Text Mote

Quick Tools

Applications Cells Annotation Tools | Survey 1 Traffic

1EIIJ

Graphlc

Scale

g @ ®L

Survey Survey LS Surnw
Tepo Symbols Monuments Stamps  Cells

Cell Tools

Survey Tab in INDOT Tools Workflow

8. First, you will add the north arrow. Load the Survey Symbols library from the Survey Topo

Symbols tool.

k4 INDOT Tools

Home

/A A

Place Place Place
Line Text Mote

Quick Tools

Applications Cells Annotation Tools Survey Traffic

1 =100

Graphig
Scale

ST [E1 RN =Y

4&0@

LS Survey
ts Stamps Cells

Survey
Topo Symbols

Cell Tools

Survey Symbols




9. This will load the Survey Cell Selector. On the displayed panel, locate the cell called northsy. Do

not use northsymb as it is scaled differently. Clicking on the northsy button will bring up the cell

placement tools at the appropriate scale. Place the cell in the correct spot in the control point

border. Note that cells are sorted by letter case then alphabetical order. (PSSA would show up

in the list before northsy as the capital P takes precedence)

@

File Edit
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The Survey Cell Selector
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10. Next locate the cells for the traverse station cell (PSSA) and any other object that needs placed.

In each of these instances, a scale of 1 should be used. Snap this cell to the center of the

provided centerline.

O

Scale

Active Cell

&5 Place Active Cell

Active Angle:
X Scale:
¥ Scale:

[ Place as Shared Cell

True Scale
Mirror
O Interactive:
Flatten

[ Multi-line Offsets
Dimension Values
Annotations
[ Association

00°00'00.0000"

1.000000
1.000000

Horizontal

Scale and Rotate =

Top

-
=

—

-

-

PSSA Cell Placement

EAST CORNER .35, T.21N, R.9E



11. After placing additional cells such as power poles (PPWP), you will need to place the lines for the
dimension ties. From the Quick Tools group in the Survey Tab, select the Place Line tool.

=] INDOT Tools -OoHE e A 2SS

Horme Applications Cells Annctation Tools Survey Traffic

A 2 1=i00 r:“1 % (‘Sj E

Place |Place Place Graphic Survey Survey LS  Survey

i Mote Scale Topo Symbols Monuments Stamps Cells
Cuick Mols Cell Tools

Place Line

12. While in the place line command, you will want to snap your initial point to the center of the
PSSA symbol on the centerline.

EAST CORNER S.35, T.21N, R.9E

Drawing Dimension Ties

13. Next, in your AccuDraw toolbar/window, place your cursor in any of the fields and hit the “M”
key to set it to angular mode.

AccuDraw n
0. 0001

™ | 50°00'00.0000"

AccuDraw Angular Mode



14. Place your cursor in the angle field and enter the appropriate value. This will also lock the
angular value in allowing you to draw the line along the bearing you have specified. Remember
to specify degrees, using the » symbol (shift key + 6).

AccuDraw

Dimension Tie

15. With the lines drawn, you can now adjust the placement of any cells that you’ve placed, and
your resulting reference box should look similar to the following:

EAST CORNER S.35, T.21N, R.9E

Reference Box



16. Next, you will need to add the text labels to the Reference Box.

tool from the Quick Tools Group on the Survey tab.

] INDOT Tools =]~ I 7R =1
7|

m Home Applications Cells Annotation Tools Survey

JNAA g @ ©[3

Place |Place |Place = Graphic Survey Survey LS  Survey
Line | Text Scale Topo Symbels Monuments Stamps  Cells
Quick Tools Cell Tools
Place Text

Start by selecting the Place Text

Traffic

17. With the Text Editor dialog now active, first set your Text Style to 10 Point Text. This will initiate

the appropriate justifications and sizes. Due to the constrained size of the reference boxes, you

will adjust your font to the Bentley WORKING font as shown. Expand the dialog by clicking on

the arrow in the font selection dropdown in the upper right-hand corner and select WORKING.

&1 Text Editor

7 10 Point Text ... Ay (&) ~ ¢ - e || &= woranG .

Place Text Settings



A Note on Text Styles

As shown in the previous steps, you are deviating from the standard font applied to the 10 Point Text
style, which will cause your text styles to become out of sync with the dgnlib. To revert your text style
to the appropriate values, you can reset the style from the Text Styles dialog (indicated by an ellipsis
icon) located next to the text style selection box. When you locate the style that no longer matches (it
will be denoted with a blue font), right click on it and select “Update from Library”.

E
|| 5 10 Poi - i o 5 feo | 5 «|/affoo0s3 |2~ B
v oint Text 1y \/ = v fE =1 WORKING 1 Al 00083 [ v

T NS R S S R S S S S R R S S S S R S N S R RS S RS SE

' Text Styles - 10 Point Text — x

Style  View

11D 22 5 R X

Text Styles ~ General Spacing Under/Overline  Background = Advanced

Style (none) _

Font: 24 1 WORKING - Color: [ 20 -

52 5 Point Text Justification: |Center Center hd Bold

?; E Eoin: I:;t Height: | 0.0083 I [ ltalics

57 Paint Tt Surve Width: | 0.0083 y [ Underline

522 9 Paint Text : - 000 [] Owverline
EEIEE Fractions

&3 10 Point Ted Save Vertical

v 10Point Ted [ Full Justification

52 12 Point Texd
212 Point Ted  Rename

%2 12 Point Tex)  Remap Elements...

52 12 Point Ted

&312Point Teq  Delete

&3 12 Point Texd__ Reset

522 12 pt. Sub S(! Update From Library
522 12 pt. Super

%t 14 Point Text

52 14 Point Text (Prog .
522 14 Point Text - Car

&2 14 Point Text - Car /‘O PO m t Te Xt

5% 14 Drint Tevt - Car

Update from Library



In addition to adjusting the font, it may also be desirable to adjust the Justification options to more
appropriately place your text along, above or below elements. You can revert to the default text style
settings by selecting the Reset option on the menu shown above.

More Notes on Text Placement

Various notes may require the use of special characters not directly accessible via the keyboard, such as
the degree symbol. There are two ways to place this and other symbols. The first method is via the
Insert Symbol button on the Text Editor. Selecting this button will bring up the Symbol Inserter dialog.
Via this dialog, you can find either place a symbol from the Favorite Symbols tab or you can use the All
Symbols tab to search for the symbol you want (available in your selected font). Then you can insert it
into your text and quickly add it to the symbols favorite list.

> Jv) || B3 WORKING 1 - ooz (2~ B

Testing

The Insert Symbol Tool

Symbel Inserter

Favorite Symbols
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Add to Favorites...

e .V2.|/4.%.|/3 -

Mon-Unicode Font)

The Symbol Inserter Dialog and Adding to Favorites



Additionally, if you know the appropriate key-in sequence, you can type the symbol in. In the case of
the degree symbol and the Working font, you can type it in by holding down the ALT key, then typing 9
then 4. This will place a * in the text editor, however when going to place the line of text, a degree
symbol will appear.

18. After placing the appropriate labels, your reference box should look like the following.

N&C W.SIDE
PWP 236

EAST CORNER S.35, T.21N, R.9E

Reference Box with Labels

19. Finally, you need to place the note describing the monument type. Like the Place Text tool, you
will need to start the Place Note tool. This tool can also be found in the location mentioned in
step 16.

=1 INDOT Tools =]~ T KRN T

m Home Applicaticns Cells Annctation Tools Survey Traffic

S AlAE g @ ©[5

Place Place] Place hic Survey Survey LS  Survey
Line Text | Mote Topo Symbols Monuments Stamps  Cells
Cuick Tools Cell Tools

Place Note



20. With the place note tool active, set the Dimension Style to Engr Arrow as shown.

fn

A®

Dimension Style: ] EngrAmow | 3 A
Text Rotation: | Horizontal -
Location: | Automatic v
Start At: | Terminator -
Harizontal Attachment: | Auto ~

B -

Place Note Settings.

21. Next, on the Text Editor, change your active font from Tahoma to the Bentley WORKING font,
and make sure the text style is set to 10 Point Text.

£ Text Editor

10 Point Text - | e Ay 8 ~ 5 v g | 75 WORKING . || oooez [~ B

b SO R RO R T A R S (R S B WA

Setting the WORKING Font



22. With the Place Note tool configured, type the monument information into the Text Editor.
When the text is typed, place your cursor on the monument in the reference box and select the
location where you would like to start the terminator. A second placement will determine the
leader length and direction and place the text box. The resulting reference box will appear as

follows:

EAST CORNER S.35, T.21N, R.9E

Completed Reference Box

23. At this time, you may need to restore your text and dimension settings to their default
configuration. These steps are noted in tips throughout this section and are similar for text and
dimension styles. With this first reference box created, you can now create additional reference

boxes for each point in the plat.

2.3-4 Creating the Reference Point Coordinate Table
Since the coordinates for the Reference Points are no longer contained in the Reference Box, a
Coordinate Table will need to be created. It is recommended to create one overall coordinate table for

the Route Plat. The following steps go through the process of creating a Coordinate Table.

1. As with the reference box, you are going to use the Models dialog to copy the template model
included in the .dgn file. Open the Models dialog and copy the Coordinate Table model.

I
FRERYE T X
Type 20/3D MName Description 4 Design File
(7] P Default Master Model v chus.\routeplat_US_SVF1
C_)_] _|  Coordinate Table Reference Point Coordinates v chus.routeplat_US_SVE]
[3 ] SV SectionCor.. SurveySection ComerReference./ = B
©1 ] PointNumber  Description <l
] 1 Pt Routeplat Sheet
o]} 0 14 EAST CORNER 5.35, T.21W, R9E | Modelto Copy: Coordinate Table -

Name: | Coordinate Table - Copy-1
)
1 Description: | Reference Point Coordinates

Ref Logical:

L )_

Copying the Coordinate Table
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2. With your table copied, make sure the new model you created is active. If not, double click on it
in the Models dialog to activate it.

3. Allthe text in this table is editable via the standard text editing tools in OpenRoads Designer.
Using either the Edit Text tool, or by double clicking on the pieces of text, edit the values for
your coordinate table accordingly.

2.3-5 Adding the TOPO to the Routeplat Sheet
With the reference boxes and coordinate tables created, you can now begin the process of creating the
route plat sheets and populating the file with content.

1. Asinthe previous two examples, take the template routeplat provided in the .dgn and copy it to

a new model.
5]
B = [[f

+ 11 (E| = ? x

Type 20/3D MName Description -¢ ﬂ

[~ P Default Master Model v

C_)_] |l Coordinate Table Reference Point Coordinates ¥ Modelto Copy: Plat -

@ d 5V _Section Cer.. Survey Section Corner Reference. v

Q3 | Point Number Description ¥ Name: | Plat - Copy-1

E [m] Routeplat Sheet d Description: | Routeplat Sheet

o17a EAST CORMER 5.35, T.21M, R.SE v .

. . ) Ref Logical:
Q_] _J  Coordinate Tabl... Coordinate Table Test v
. , -
< >
1

Copying the Plat Model

2. If not opened automatically, double click on your newly created model to activate it. Should you
need additional plat sheets, repeat step 1 as needed.



3. Now that a new routeplat model is created and opened, you can begin adding the various pieces

of content. When first entering the new routeplat model, you will see the following template

information:

77777777777777777777777777777777777777777777777777777777777777777

INDIANA
DEPARTMENT OF TRAN

LOCATION CONTROL ROUTE SURVEY  F——— e

The Template Routeplat

As you can see in the preceding illustration, the template contains the appropriate border file
and a grayscale border all in a sheet model (denoted by the virtual paper size around the

border).

4. You are now ready to begin adding content to this file. Most of the content being added will be

via OpenRoads Designer references. Open the Reference dialog from the Primary Group of the

Home tab.
=] INDOT Tools -oHBEBR -2 S -
File Home Applications Cells Annotation Tools Survey
& Place Mote * | BD_Title Block Integration ™ QaExplorer

o ~||=0 ~||=0

Attributes

@ Attach Tools
- - |[ A -
@0 =10 Models ~

OpenRoads Designer References

pw:ihdotwise.indot.in.gow:
Traffic

I |E| Reference * @5 Properties
* fag Level Manager = l@ Mare ~

= Level Display ~

Primary




5. The first item to attach is the topo drawing that has been created for the project

. Start by

selecting the Attach Reference button from the Reference dialog.

| [H] References (0 of 0 unique, O displayed

Teols  Properti

E D@ 2 50 B2 ) 7 4 BE (D 3 Hilite Mode [Boundaries +

Slot F A File Name Model Description ™ Logical Orientation Presentation
< >

Rotation

8] A @ & Nested Attachments:

xH B

* | New Level Display:

| =

Display Overrides: > Georeferenced:

Attaching References

™ | Mesting Depth:

-

6. Unlike the prior version of the referencing procedures, all the content resides in a single survey
fieldbook DGN. As such, when prompted for the file you would like to attach, select your single
topo drawing as shown. Make sure to set the attachment method to Interactive so you can

adjust the scaling and view orientation.

‘ :’J Attach Reference
Select

Documents

Folder | | test

o

Mame
/M4INDOT_US_SVFT_2Dseed.dgn
/& JINDOT_US_SVFT_3Dseed.dgn
# & ORD PrPlan.dgn

# & ORD Survey Fieldbook.dgn

/E’JORD Survey Fieldbook_NEW.dgn v
< >
Application: All Applications ~
Extension: *.dgn; *.dwg;*.dxf v
Add Remove
Selected Documents
Name Description File Name Folder Stol
< >
Attachment method: Interactive v
OK Cancel

Reference Attachment
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7. With your topo selected, select OK and configure the additional settings for your attachment.
The following illustration shows the attachment made at 1”=100’". Please note that on this panel
that Coincident-World is selected as the Orientation.

EJ Reference Attachment Properties for . \ORD Survey Fieldbook_MEW.dgn X
File Name: PW_WORKDIR:d059806940ORD Survey Fieldbook_MEW.dgn
Full Path: ..\pw_work\d059806%\ORD Survey Fieldbook NEW.dgn
Model: Default -
Logical Name: | |
Description: | Master Model |
Orientation:
View Description &
Coincident Aligned with Master File
Coincident - Werld Global Origin aligned with Master File
Standard Views
Saved Views (none) w
Detail Scale: [1"=100" -
Scale (Master:Ref): | 1.000000000 | : | 1200,000000000 |
Mamed Group: -
Revision: -
Level: | '|
Nested Attachments: |li\.re Mesting = | Nesting Depth: E
Display Overrides: |Alluw = |
New Level Display: | Use MS_REF_NEWLEVELDISPLAY Configura |
Global LineStyle Scale: |Masle| = |
Synchronize View: |Volume Only v
Drawing Boundary: |(New} - |
Mame: ‘Drawmg |
Visible Edges: |Dynamic < |
Toggles
EIEN - EE - - EHe M2E
[ ok ]| concel

Attachment Settings

8. With the attachment set to Coincident - World, the topo will not appear within the border. As
such, you need to move the topo back into the border. Start by zooming extents, and then in
the References dialog box, choose all the attached reference filenames you want to move, and
select the Move Reference button.

@ References (1 of 1 unique, 1 displayed) — >

Tools  Properties

Bl xn 96 PR 8 g D 19 @ >0 tinevose Bomanes <)

Slot 'F A File Mame Madel Description - Legical Orientation Presentation
[ 1 .AORD Surve... Default Master Model Coincident - Werld Wireframe |

Move Reference
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9. Left click at the location in the drawing you want to move the files from and then left click at the
location in the drawing you want to move the files to. This will move all the selected files to the
new location.

10. Be sure to save settings by hitting Ctr/ + F, or selecting File -> Save Settings. This will ensure that
the changes you made to the reference files will be saved for next time.

11. If you need to clip the reference, the easiest way is to use a fence. Select the Fence tool from
the Home tab of the Survey workflow.

] E::: * v * @ li?.:, s pw:ihdotwise.indot.in.gov:DOTWise\Documer,

eographic Edit Terrain Geometry Drawing Production Drawing

@ Place Note ~ |BD_Title Block Integration  ~| % Explorer B Reference » @A Properies k‘
E| Attach Tools = Fﬂ,:’i Level Manager = 5 More =
o v[[=p =g - Qo - Aqp T Element | .-

""" — E Models = = Level Display - Selw' e Y
Attributes Primary ection

Place Fence

12. On the Place Fence tool, make sure your Fence Mode is set to Inside. In most instances, you can
leave the Fence Type set to Block, however it may be advantageous to use one of the other
fence methods to achieve a tighter clip around your topo.

ﬁ Place Fence — *

Fence Type: | Block A

Place Fence Tool Settings



13. With your fence placed around your topo, you now need to select Clip Reference from the
References dialog as shown. On the Set Reference Clip Boundary dialog, make sure the Method
is set to Active Fence. When satisfied with the boundary fence you’ve defined and the clipping
settings, left click in the drawing area to accept the clipped reference settings.

@ References (1 of 1 unique, 1 displayed) - >

Tools  Properties

E-MxE Ty DEAP Y 0 DE@x
Hilite Mode: Euundariﬁ -

Slot 'F' A File Mame Muodel Description Logical Orientatia
1 «AORD Surve.., Default Master Model Coincider
< >
Scale | 1.000000000 '+ 1200.000000000 ' Rotation | 00°00'00"
Offset X | -33.2563 |¥|-320332 |

E-. @& H. .f" ':.;:E. E =] n ) ! 71 - Mested Attachments: | Mo Mesting - |

Mesting Depth: Display Overrides: [Allow ™ MNew Level Display: |Cunfig Variable - |

Georeferenced: | No A

Reference Clipping

Note: You could draw a polygon and change its Class to Construction. Then by changing the Fence Type
to Element you can create the fence by selecting the polygon. This would give you a way of recreating
the same clip area for additionally attached reference files.
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14. Be sure to save settings by hitting Ctr/ + F, or selecting File -> Save Settings. This will ensure that
the changes you made to the reference files will be saved for next time.

2.3-6 Adding Reference Boxes to the Routeplat Sheet
Now that the topo has been added to the route plat, you need to add the reference boxes to the sheet.
Continuing from the previous set of steps, make sure that you are in the appropriate Plat model,
otherwise open it via the Models dialog as noted in step 2 of the previous section.

1. With the plat sheet showing in the MicroStation view, you should see the frame of your topo
and a dashed grid setup in the sheet. If you do not see the dashed grid, it needs to enabled with
the following steps.

Routeplat with Topo and Grid

2. If the grid is not visible, enable the Constructions option on the View Attribute panel. This panel
can be found on the View toolbar.

L View 1, Plat Test

[

View Attributes



3. The Constructions item can be found on the left side of the panel. Make sure it is highlighted as
shown in the following capture:

[a3 View Attributes - View 1

View Number: 1~ |2y ]

@ Presentation

Display Style: (Sheet Model) | e
T, ACS Triad 7 FastCells
[5d Background Bl
511 Boundary Display [ Grid
Camera ‘E Level Overrides
;' Clip Back .LmeSters
".,;‘ Clip Front .LmeWaights
3 Clip Volume nMarkers -
E Patterns
[ Defaul Lighting O ree
. Dimensions .Text
[t pate Fisies 14 Text Nodes
@ Displayset Transparenc:y
[ Height Fiets

Global Brightness: "'

| Wiew Setup

|T|E Analytic Symbology

v

Construction Elements Enabled

4. At this time, you want to open both the Models and References dialog boxes from the Home tab
of the Survey workflow:

k4 Survey -oadHER e -2 S S pw:\\dotwise.indot.in.gow:D
File Home Field Book Analyze Geographic Edit Terrain Geometry Drawing Production
@ Place Note * Default - 'ﬁ Explorer M @7 Properties
S @ Attach Tools * %55 Level Manager = More =
D 0 =R S0 ~ Q'D - ‘ﬂ.‘_-l 0 T

Models = | = Level Display ~

Attributes

Primary

Models and References




5. With both the References and Models dialogs open, you can now drag the Reference Box
models from the Models dialog and directly attach them to the Plat as references. Note that
you can drag and drop multiple references boxes at the same time on this dialog. For this
example, you will only be attaching a single reference box.

@ References (1 of 1 unique, 1 displayed) - X
Tools  Properties

- Py e [Bh 0 TR K T -

ErflExe RPN 3P 0%

Hilite Mode: | Boundaries ~

Slot P A File Mame Model Description - Logical Orientatio
1 WAORD Surve.., Default Master Model Coincider
< >
Scale [ 1.000000000 1.000000000 | Rotation [ D0700'00"
Offset X | -33.2563 [32.0232 |
E-. ¥ E. N :’;‘E 1] ! @ 15 Nested Attachments: -
Nesting Depth: Display Owerri * | Mew Level Display: v
Georeferenced: =
Models — >
@ L0
e LE 7IX
Type 20/30 Name Description 4 Design File Shee
I.'f' [P Default Master Model v chus.Arouteplat_US_SVFT.dgn
(?_] | Coordinate Table Reference Point rdinates ¥ chus.\routeplat_US_SVFT.dgn
@ U 5V Section Cor..  Survey Section Col Reference.. ~  chus.\routeplat US SVFT.dgn S
Q_] 1 Point Number Description v chus.Arouteplat_US_SVFT.dgn
_|l  Plat Routeplat Sheet v __chus.routeplat US SVFT.dgn Plat
21 0O 172 EAST CORMER 5.35, T.21N, R.SE v clus.\routeplat US SVFT.dgn I
A 1" Coordinate Tabl... Coordinate Table Test ¥ c\us.. \routeplat_US_SVFT.dgn
B Plat Test Routeplat Sheet Test =" cius.Arouteplat_US_SVFT.dgn

Reference Box Attachment Drag and Drop

6. Upon completion of the drag and drop, you will be prompted with the Attach Source Files dialog
requesting you to adjust the alignment of the references being attached. For the reference
boxes, you want to use the Top attachment method as shown:

&4 Attach Source Files X

You have 1 references to attach. Please select attachment method

Attachment Method:

[ ok ] concel

Attach Source Files




7. After accepting the attachment method, you will see an outline of the reference extents that
you are trying to attach. Note that the attachment point is the center of the reference.

FIELD

Reference Attaching

8. You need to position your cursor and snap to the appropriate grid location where you would like
to place the reference box. When satisfied with your location, place the reference by a left click.

174

" BOLT WITH
5/8" HEAD

EAST CORNER S.35, T.21N, R.9E

Placed Reference Box

9. Repeat steps 5-8 for each successive reference box. Finally, to disable the reference grid,
disable the Constructions view attribute that you enabled in step 3.

2.3-7 Adding the Coordinate Table to the Route Plat
Next, you need to add the Coordinate Table to the plat sheet.

1. If not open and active, open your route plat and make sure the plat sheet is open in OpenRoads
Designer.



2. Make sure you have fit the entire sheet in your view. Do this by either performing a Fit View
Zoom from the View toolbar or by double clicking your middle/mouse button.

1 View 1, Plat Test
-4 02 000pOEE & &l

Fit View

3. At this time, you want to open both the Models and References dialog boxes from the Home tab
of the Survey Workflow.

E‘ Survey v ':."H.'g::ﬁ;:c * v * % = pw:i\dotwise.indot.in.gov:DC
Heme Field Book Analyze Geographic Edit Terrain Geometry Drawing Production

@ Place Note ~ [Defeult - @ Bxplorer @] Properties
— % [E| Attach Tools * ‘oz Level Manager * % More *
0o =0 g Q0 210 Models * = Level Display ~

Attributes Primary

Models and References

4. With both dialogs open, you can now drag the Overall Coordinate Table model from the Models
dialog and directly attach it to the Plat as a reference.

References (2 of 2 unique, 2 displayed) B X
® | play

Tools  Properties

E-Byxe £92FRAY Y BLATO R

Hilite Mode: | Boundaries ~

St O FileName Model Description Logical Orientatia
2 Arouteplat.. 174 EAST CORNER S.35, ... Top Standard
1 \ORD Surve. Default Master Model Coincider

Scale | 1.000000000
Offset X | -33.2363

: [1.000000000 | Rotation [ 00%00'00"
v[320332

[T = ]~ R [ s [ [ o 2 e Actacmenc: =
Nesting Depth: Displd@Overrides: T New Level Display: -
Georeferenced:
Models - ped
&S0 ¥
AhedDYy
Type 2D/3D Name Description «= Design File
T (D Default Master Model v c\us.Arouteplat_US_SVFT.dgn
] Coordinate Table Reference Point Coordinates v c\us.Arouteplat_US_SVFT.dgn
] SV_Section Corner Refi\.. Survey Section Corner Reference.. v c\us..\routeplat_US_SVFT.dgn
_1 Point Number Description ¥ e\us.Arouteplat_US_SVFT.dgn
Pt Routeplat Sheet /s \routeplat US_SVFT.dgn
Y] EAST CORNER 5.35, T.21N, RSE outeplat_US_SVFT.dgn
1™ Overall Coordinate Table _Reference Point Coordinates
Plat Test Routepiat Sheet Test " C\Us.Arotteplat US_SVFT.dgn

Attaching the Overall Coordinate Table




5. When prompted with the Attach Source Files dialog, set your attachment method to Coincident.

] Attach Source Files >

You have 1 references to attach, Please select attachment method

Attachment Method:

[ ok ] cance

Coincident Attachment

6. This will attach the coordinate table to your routeplat sheet. You can adjust this reference
placement by highlighting it on the Reference dialog and selecting the Move References tool
and moving the reference as you would any other element.

@ References (3 of 3 unique, 3 displayed) — X

Tools  Properties

E-k ke f9¢HRP D3 @ %
Hilite Mode: | Boundaries ~

Slot P A File Name Model Description ™ Logical Orientatio
2 WArouteplat... 174 EAST CORMER 5.35, .. Top Standard
1 .AORD Surve... Default Master Model Coincider
B < hrouteplat.. Overall Coordin... Reference Point Coo... Coincider

Move References

2.3-8 Creating Section Corner Cards

This section will walk you through the creation of Section Corner Cards and attaching the appropriate
reference boxes.

1. Make sure your route plat file is open. You do not need to be in a specific model.
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2. Open the Models dialog. As you have done in previous examples, you will be copying the
template Section Corner Reference Card Sheet model as you did with both the reference boxes
and the plat sheet.

x4 Survey rodER e S S pw:\\dotwise.indot.in.gow:D
Home Field Book Analyze Geographic Edit Terrain Geometry Drawing Production

& |Place Mote ™ || Default - 'ﬁ Explorer @ LETEETE (@1] Properties
@ Attach Tools = % Level Manager l@ Mare =
| Models = = Level Display =

[Jo = =0 ~|=0 ~|@0 ~|&o -~

Attributes Primary

Accessing the Models Dialog

3. With the Models dialog open, highlight the Section Corner Reference Card Sheet model, then
select the Copy Models button from the toolbar.

Models — x
e rD

Lhel|dTvIX
Type 20730 Mame Description %4+ Design File
7Y [ Default Master Model ¥ chus.Arouteplat_US_SVFT.dgn
Q_'| I Coordinate Table Referen é = B B R e .,
[ Ll SV _Section Corner Refer... Survey § Copy Model ]
Q 1 Point Number Descript
@ 1 Plat Routepli Model to Copy: |S"."_Sectiun Corner Reference Card Sher = |
s EAST N |EAST CORNER 5.35 T.21M R.9E |
Q_'| 1 Owverall Coordinate Table  Referen —ame . . .
4 (1 Plat Test Routepl Description: | 174 |

Ref Logical: | |

Copying the Section Corner Reference
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4. Inthe Copy Model dialog, type the name and description of the reference card as shown in the
previous illustration and hit OK. This will copy the model and should open it in the OpenRoads
Designer session. If it does not open automatically, switch to it by double left-clicking on the
model in the Models dialog.

SECTION CORNER REFERENCE
SECTION TOWNSHIP RANGE
(Description of Corner Location)

TWP.,
COUNTY, INDIANA

Point Nu[hber

; COORDINATES

| []NAD '83 IN E. ZONE
: [INAD '83 IN W. ZONE
' 1 LOCAL GRID

Units: _

Pt.#:

N:

E:

TYPE OF MON.:
DEPTH:
UNCERTAINTY:
BY:

DATE:
DES.NO.:

Description

STATE FORM 40180 (R2/2-04)

Section Corner Card with Reference Box

5. Open the References dialog. You will find that this model already has a reference back to the
blank Point Number model in your active file. This is pre-attached to appropriately place the
reference and allow you to quickly select the appropriate point number attachment.
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6. Inthe References dialog, double-click on the reference with the Model named Point Number
and when prompted, change the model on the Attachment Settings to the appropriate
reference box as shown.

E’J Attachment Properties: routeplat_us_svft.dgn x

File Name: | PW_WORKDIR:d062574%\routeplat_US_SVFT.dgn |

Full Path: ..\pw_work\d062574%\ routeplat_us_svft.dgn

EModeI:E |Poir1t Mumber hd | hpr
h Logical Name; | Name Description |
i Descriptionl 174 EAST CORNER 5.35, T.2TN, R.9E l

. ~|Coordinate Table Reference Point Coordinates
] Detail Scale: Default Master Model

Adjusting Reference Box Attachments

SECTION CORNER REFERENCE
SECTION TOWNSHIP RANGE
(Description of Corner Location)
TWP.,
COUNTY, INDIANA
174
COORDINATES

} []NAD '83 IN E. ZONE

| [INAD '83 IN W. ZONE FI

L I LOCAL GRID

T units: /
I PL#:
| N: b
e *
BOLT WITH
TYPEOFMON.: .. 5/8" HEAD
e FoLND
BY: . 0.3'ON
DATE:
DES.NO.:
EAST CORNER S.35, T.21N, R.9E

STRTE FORM A1 (122081

Reference Box Attachment
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7. At this time, you may conclude filling in the fields on the reference box and moving the section
corner elements as needed. To edit the text, use the Fill In Single Enter-Data Field tool found in
the Text Group under the Drawing Production tab of the Survey workflow.

£l survey odiEBer > S - pw:\\dotwise.indet.in.gov:DOTWise\Documents\Resources\CAD Suppert\Working Folders\PSirouteplat_L

Home  FieldBook  Analyze  Geographic  Edit  Terain  Geometry Drawing  View
= = & =¥ A
Q m e KT yh e O O [ oasx Ap? o7 % A 2

Explorer AHach properties  Element ..., Clip Create  Update Saved A;ﬂ’y Place Place Place Place Edit Change Te = Element Model
Teels - Selection L]  Volume (1 Saved View View Settings Saved View Table MNote Label = Text Text Attributes Annotation *  Annotation *
Primary Selection Clip Saved Views % | Tables Motes Text A Place Text Along

Explorer ¥ I X Properties v ix

L) View 1, EAST CORNER 535" > Find/Replace Text
4 [& Models (1) -4 |}3}°-B*] abe  Display Text Attributes
=R i
Q1 Point Number W Copy/Increment Text

¢ Items v

' OpenRoads Model -~
Q Qe

Search Plax

4 Copy Enter Data Field

%, Copy/Increment Enter Data Fields

I e Fill In Single Enter-Data Field I

Auto Fill In Enter Data Fields

b 7 routeplst_US_SVFT.dgn (EAST CORNER 5.35

€ Change Case

¥ Update Al Fields

B Drop Text

Editing Section Corner Fields

8. Repeat the previous steps for each reference box as needed.
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2.4 Exporting/Reporting OpenRoads Survey Data

Using the built-in survey processing and display tools, reporting can be far more specific--down to the
feature level—when compared to the previous reporting functionality with using InRoads. This section
will look at two different export methods: direct export to .csv and usage of the OpenRoads reporting
tools.

Please keep in mind that these methods are not a way to directly export data to a ready-made format
and are more akin to a direct coordinate export. Any output that these methods produce may need
some clean up and modification if the intention is to use the data these provide in other ways.

2.4-1 Reporting on Survey Information
The following steps look at how to turn OpenRoads survey information into a reported format like those
provided in SS2. This example will show reporting on Point Features.

1. With your DGN open, navigate to the Survey section of the Project Explorer. Locate your
fieldbook.

Explorer > 01X

¥ Items

|| OpenRoads Model
¥ SheetIndex

| OpenRoads Standards

| Drainage and Utilities Madel

+ MR SIE SIE SIE SIK 4

Survey

|5€d’t‘:-”l P|2 ¥

4 L] Survey Data
4 v [E] Default
4 v/ [ Field Books
| 4+ ¥ [ Des 2 SRux Survey Fieldbook |
b v 2 Data Files
>
>

¥4 ALL Point Features
v f‘_,r ALL Linear Features
v ‘b ALL Contral Points
T ALL Setups
*% ALL Observations
b v @ Adjustment
v "y Filters

+ ) Multimedia Files

Survey Fieldbook
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2. Locate the ALL Point Features list under the fieldbook entry. In the Primary section of the Field
Book tab, select the Details tool.

&l survey JoHER « - 4

Home Field Book Analyze
fﬂé Q, %y Reset Details k

Explorey Details Element M
Selection
Primary Selection
Explorer > ix

& Items -
I |

Geographi

| | OpenRoads Model - |

| P SheetIndex v |

| | OpenRoads Standards v |

| - Drainage and Utilities Mode! - |

H Survey ~
Q@R
‘fed'ﬁ‘l ,Olg ¥

4 v [ SurveyData

4 v [E Default

4 v []] Field Books 1

4 [ Des # SRxx Survey Fidbool

v % Data Files
%

v
4
3
b

J ALL Linsar Features
% ALL Control Points
7% ALL Setups

“% ALL Observations
b~ @ Adjustment

+ Ty Filters

<<

v @) Multimedia Files

Survey Details for All Point Features

3. This will bring up the Survey Details for all the points. Should you wish to only report on a
certain feature, or subset thereof, you can continue to drill down under the All Point Features
on the Project Explorer to the feature you’d like.

£ Survey Details - X
[= Blemert List 1}, Message Center
Neme Display Field Code Link Cade Zne Description Terain Model At~

» |52 Te P55 None 1 OPUS 2 THIS IS AN EDITED REC... | Detemine By Fe.

553 T PSSA None 1 OPUS 3 THIS IS AN EDITED REC... | Detemine By Fe.

551 T PSSA None 1 PRES W/TIBBETT CAP FLUSH T... | Detemine By Fe...

200 Te PSSA None 1 CAMPBELL REBAR THIS IS AN E... | Detemine By Fe.

204 T PSSA None 1 NW COR NE NE SEC 24 THIS IS ... | Detemmine By Fe

208 True PSSA None 1 CAMPBELL REBAR THIS IS AN E... | Detemmine By Fe.

21 Te PSSA None 1 IRON PIN ? THIS IS AN EDITED ... | Detemine By Fe.

22 Tue PSSA None 1 SMITH REBAR 2 THIS IS AN EDL... | Detemine By Fe.

213 True PSSA None 1 NW COR SEC 24 THIS IS AN EDI... | Detemmine By Fe.

214 Te PSSA None 1 WEST 1/4 SEC 23 THIS IS ANE... | Detemmine By Fe.

215 T PSSA None 1 PREA UP 1.6 AG NO CAP RECEI... |Detemine By Fe...

216 Te PSSA None 1 SMITH REBAR FD 0.3 AG THIS I... | Detemine By Fe.

a2 Te PSSA None 1 DELETED 3:05:27 PM 3/16/2009 .. | Detemmine By Fe

m T PSSA None 1 DELETED 3:05:31 PM 3/16/2009 .. Detemine By Fe...

a4 Te PSSA None 1 DELETED 30601 PM 3/16/2009 _ | Deeminc By Fe. |
P = o B - e B ~
Row: [4 4 |1 of2219 | b bl

Survey Details
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4. On the Survey Details display, you can select as much or a little, as necessary. This dialog
adheres to standard Windows conventions of Ctrl-click and Shift-click methods to select
multiple entries either one at a time or in a sequence. For this example, all points have been
selected by using the Ctrl+A (select all) command.

£l survey Details - %

[=! Element List I Message Center

Mame Display Field Code Link Code Zone Description Temain Model At... ™

3 € A None 0 C... | Determine By Fe..
None o C... | Determine
Nane ... | Determine
Mone I Al ] .. | Determine By Fe..
Mone S| Determine By Fe..
None
None
None
None
None
None PRE4 UP 1
None SMITH REBAR FD 0.3 AG THIS
Mone M 3/ ... | Determine By Fe..

Nane M 3/ . | Determine

Mone ... | Determine By Fe..

of 2219 | b b

Selecting All Points

5. With your points selected, right click on the far-left hand column (to the left of the point names,
the upper left box will not work), and select Report on selected items.

[
ﬂ Survey Details

= Element List I, Message Center

Name Field Code

» 552

S Edit selected items.

Ol View 3

A Selection 3

'y Export selected items...

A Create Control Points from selected items.

%= Edit Observations

Media files

Report on selected itermns.

Delete selected itemns.
Reset Details

Report on Selected Items
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6. This will start the Bentley Civil Report Browser and initialize the SurveyPointsCompleteTable.xsl.

File Tools Help

CA\Program Files\Bentley\OpenRoads Designer CONNEC

I Cant

I Civil Terrain

I CivilGeometry

4 CivilSurvey
SurveyAdjustmentComplete.xs!
SurveyAdjustmentHorizontalxsl
SurveyAdjustmentPreliminary.xs|
SurveyAdjustmentRepetition.xsl
SurveyAdjustmentSummary.xs|
SurveyAdjustmentVertical xs!
SurveyControlPoint.xs!
SurveyControlPointsTablexsl
SurveyDataFilexs!
SurveyDataFileTable.xs|
SurveyFieldBook.xsl
SurveyFieldBockTable.xs!
SurveyLinearFeature.xs|
SurveylinearFeatureTablexs|
SurveyMissingFeatures.xsl
SurveyObservation.ss|
SurveyObservationsTable.xs!

SurveyPointsTable_CSW.xsl
SurveySetup.xs|
SurveySetupsTablexsl
SurveyToleranceCheck.xs|
SurveyTraversexs|

ComridorModeling

Evaluation

Images

LegalDescription

MapCheck

Milling

Schemas

Stakeout

StationOffset

Superelevation

TemplateLibrary

Tumouts

Themes

ﬂ Bentley Civil Report Browser - C\Users\PSmock\AppData\Local\ Temp\RPTrbexjatv.xml

- o X
Survey Point Feature List Report ~
=
Report Created: Wednesday, February 19, 2020
Time: 1:29:41 PM
Project: Survey
Units: Imperial
Point S . - . Feature Link Attributes Control Terrain Data Field Styl
Name Description Northing  Easting Elevation pogoiion Code Z°" Pair  Codes Attribute File Book  Nar
OPUS 2 THIS IS Determine QE;RXX
562 ANEDITED  1379089.246 2969025055 561229 PSSA  None Trimble5.fid o
RECORD Featurs urvey
Fieldbook
OPUS 3THIS IS Determine ge;m
563 ANEDITED 1376265417 2973212346 507838 PSSA  None Trimble5 fird &
RECORD Feature ey
Fieldbook
PRE5
WTBHETT Determine Des
51 CARPLUSH 070081119 2963614.950  533.388 PSSA  None Trimbles fud =210
THIS IS AN Fratine Survey
EDITED Fieldbook
RECORD
CAMPBELL Dirermie Des
200 REPARTHISIS 4377680 003 2970475.044 0.000 PSSA  None Trimble5 fird T
AN EDITED Excns Survey
RECORD Fieldbook
NW GOR NE NE S Des
204 SECATHISIS o056 979 5970454 347 0.000 PSSA  None Trimble5 furd T—oro
AN EDITED P, Survey
RECORD saure Fieldbook
CAMPBELL Detisiing Des
REBAR THIS IS # SRxx
08 oo EomED. 1378243650 2970470857 0000 PSSA  None I;y . Trimbles fad
RECORD gature Fieldbook
IRON PIN ? Aenomies Des
< >

Survey Point Feature List Report




You can then save the output to several formats, along with printing it to a printer or PDF file.
Additionally, by right-clicking on the report background, you can bring up a context menu that
allows you to export the format directly to Excel. NOTE: To have the table exported correctly to
Excel, you must perform a right-click in the area containing the point feature information. Then,
select the Export to Microsoft Excel from the menu.

Survey Point Feature List Report

Right-click must be
performed in this region.

Report Created: Wednesday, February 19, 2020

Time: 1:48:15 PM

Project: Survey
Units: Imperial

Point N - . 1o Feature  Link Attributes Contrgl Terrain  Data Field  Style
Name Description Northing  Easting Elevation ogniiion Code 2™ Pair Codlm(ribnle File Book  Name,
OPUS 2THIS IS iy Determine e
552  ANEDITED  1379089.246 291 1 Trimble6.fud &
RECORD (Rare Feature ey
Fieldbook
Save background s Dse
OPUS 3THIS IS Determine
553 ANEDTED 1378265417 297 et asbackground 1 Trimbles fwd ’;ﬁ:"x
RECORD Copy background Feature :
feldbook
PRES Select ll
WTBBETT Paste Determine 'e
CAP FLUSH # SRox
1 R ieAN TR e 1 by | Tambls G
EDITED Add to favorites. Fieldbook
RECORD .
CAMPBELL e soures N Des
REBAR THIS IS Encoding > # SR
00 aRESTRS 'S 1377609.203 29 1 by Tt
RECORD Print eaurs Fieldbook
NW COR NE NE Print preview: Determine o
SEC24THIS IS gy # SRoox
200 o 138042627 29 1 by | Timbse
RECORD Bxport to Microsolt Bxcel Fieldbook
CAMPBELL Send to OneNote Dez
Determine
REBAR THIS IS # SRxx
28 oD ISTRMIES0 2 oo 1 by | Timblesa GO

Export to Microsoft Excel

By exporting to Excel, you will get a tabular file with all the data in the report shown in their appropriate
columns. This will allow for the data to be quickly adjusted, and then if needed, saved to a .csv or other
needed formats.

Book1 - Excel ? B - 0O X

PAGE LAYOUT FORMULAS DATA REVIEW VIEW PROJECTWISE ACROBAT

Kuhn, Jason ~

H :
HOME INSERT

Exported Point Feature Information
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.n.D X n ks |==Ee- |z General - | EE Conditional Farmatting ~ Emlnsm - | X~ %Y H O @
Em - $ - % 3 | [ Format asTable - X Delete - | [T~
Paste B I U- | . | B A~ = 5 s ) ol Styiee B Format- | & - Sort& Find& | Share WebEx
o = "= 7 Filter- Select~ | ThisFile -
Clipboard & Font EY Alignment | Number & Styles Cells Editing WebEx
AL - x fr
Formula Bar
A | B | C | D | E | F | & | H | |
1 |Point  Description Northing Easting Elevation Feature Link Zone Attribute
2 |Name Definition Code Pair
3 |
4| 552 OPUS 2 THIS IS AN EDITED RECORD 1379089.246 2969025.055 561.2 PSSA None 1
5| 553 OPUS 3 THIS IS AN EDITED RECORD 1378265.418 2973212.346 507.8 PSSA None 1
6 | 551 PRES W/TIBBETT CAP FLUSH THIS IS AN EDITED RECORD 1379081.119 2963614.359 533.4 PSSA None 1
7| 200 CAMPBELL REBAR THIS IS AN EDITED RECORD 1377689.203 2970475.044 0 PSSA None 1
8 | 204 NW COR NE NE SEC 24 THIS IS AN EDITED RECORD 1380426.279 2570454.347 0 PSSA None 1
92| 208 CAMPBELL REBAR THIS IS AN EDITED RECORD 1378243.651 2970470.857 0 PSSA None 1
10 211 IRON PIN ? THIS IS AN EDITED RECORD 1377834.551 2971771.841 0 PSSA None 1
11 212 SMITH REBAR 7 THIS IS AN EDITED RECORD 1380393.576 2963912.662 0 PSSA None 1




2.4-2 Direct Export
The steps for this process are like those in the previous section. Perform steps 1 through 3 as explained
in the previous section.

1. To export the points directly out without reporting, you’ll right click on the upper left-hand cell
in the table (to the left of the Name field header). Select the Export option shown.

& survey Details — x

[ Blemert List %, Message Center

[ Diiamly Field Code Link Code Zone Description Temain Model At ™

Show Columns
None QPUS 2 THIS 15 AN EDITED REC... | Determine By Fe...
Edit...

None OPUS 3 THIS IS AN EDITED REC... | Determine By Fe...

& Find.. . None PRES W/TIBBETT CAP FLUSH T... | Determine By

'R-,E Replace...

Mone CAMPBELL REBAR THIS IS AN E. .. | Determine By

MNone Y )R ME NE SEC 24 THI .. | Determine By Fe...
MNone CAMPBELL REBAR THIS 15 AN E... | Determine By Fe...
Mone IRON PIM 7 THIS IS AN EDITED ... | Determine By Fe...
Mone SMITH REBAR 7 THI \N EDI... |Determine By Fe...
Mone 2 ... | Determine By Fe...
MNone ] AN E... |Determine By Fe...
Mone 6 AG NC .. | Determine By Fe...
Mone i .. | Determine By Fe...
Mone X / ... | Determine By Fe...
Mone DELETED 3:05:31 PM 3. ... | Determine By Fe...
MNone DELETED 3:06:01 PM 3 ... | Determine By

Row: |4 4 1 of 2219 | b bl

Direct Export
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2. You will be presented a Save As dialog. Selecting the Save as type field will present the different
options you can save your file out as.

& save As *
4+ Bl > ThisPC » Desktop v | Search Desktop el
Organize * MNew folder = o
I This PC 2 Mame Date modified Type Size A
_J 3D Objects Alex CA Unhandled Exception File folder
I Deskiop ARoss Requested PW Archives File folder
Documents Bad Cross Sections File folder
Bentley Training Material ) File folder
; Downloads i i i .
) Bentley User Registration Project Docs 12/10/2018 10; File folder
D Music C Sharp Tutorials 11/13/2018 1:34 PM  File folder
[&] Pictures CAD Peer Group Docs 2/13/202011:55 AM  File folder
B videos Cell Library lcons 5 PM File folder
. Windows (C) Design Checklists 4/18/201910:534 AM  File folder
& PSmock (V\state Desktop background images File folder
=
= NETCOUNT (\\D DOTWise Manual Reviews File folder
DWG Conversion Testing File folder
= APPS (\\DOTAPF . .
Goals and Objectives Forms File folder
= 15-DP30 (\STATI Good Cross Sections File folder
= APP5 (\DOTPW Herber 2435125 2/3/201911:51 AM  File folder
= |5-DIV (\\State.ir v InReads LandXML Style Sheets 11/13/2018 1:34 PM  File folder v
File name: ~
Save as type: | CSV(Comma delimited)(*.csv)
CSV(Comma delimited)(*.csv)
. Excel Workbook(*.xlsx)
~ Hide Folders Excel 97-2003 Workbook (*.«ds)
Excel Binary Workbook(*.xlsk)

Excel Macro-Enabled Workbook(®.xlsm)

Exporting File

Depending on the format chosen, you can then open the file either directly in Excel, a text editor, or
several different applications.
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3. Plans Production for Design in OpenRoads Designer

The following sections discuss the usage of OpenRoads Designer for INDOT Plans Production purposes.
The same federated approach to the drawing composition process that is recommended by Bentley will
be used. These sections discuss how the drawings are created, layered, and pieced together to form a
fully realized data set that can then be turned into a plan set.

3.1 Referenced Base Drawings

As previously mentioned, a layered drawing process allowing for maximum flexibility in configuring data
to be displayed, referenced, and reused is employed. The base drawings for all these steps can be easily
referenced together. The only possible difficulty might be differences in coordinate systems between
the files. This may be resolved using OpenRoads Designer tools. This problem is not likely unless you
have drawings (OpenRoads Designer, MicroStation or AutoCAD) with information from sources outside
of INDOT. Despite this problem, it can be fixed. The following figure displays how base drawings are
placed together.

Base drawing Survey Fieldbook

Base drawing PrPlan

Conceptual view of Base Drawings Referenced Together

Note: With the combination of the Survey TOPO and Terrain model information being in a single DGN, it
is no longer necessary to create discreet contour drawings. The following workflow will describe the
process of acquiring and using this data for your project.

This figure displays a view with the PrPlan dgn set as the active drawing and with the Survey Fieldbook
dgn referenced into PrPlan.



An example illustrating this concept would look like what is shown below:

&

Files: [All

Tools Properties

VR gD DG AR R0 A Ee D YE @ 50 HiteMode [Boundaries ¥
P O FileName Model Description Logical Orientation Presentation @4 1 f N &

1 PW_WORKDIR:d075...\Des # SRox Survey Fieldbook.dgn Default___Master Model Coincident - World __ Wireframe 0 v v«
2 \Alignment.dgn Default  MasterModel -1 Coincident - i 0 v v
3 A Corridor_Roadway.dgn Defalt  MasterModel -2 Coincident - 0 v v
4 \Corridor_Pipe_Circle.dgn Default  MasterModel -3 Coincident - 0 v v
5 7175\ Existing_Terrzin.dgn Default  MasterModel -4 Coincident - 0 v v
5 PrPlan.dgn Default-3D Ref  Coincident - Wireframe 0 v v

<

Rotation | Offset X

[ ® ] 2 [A] = - Nested Attachments: | No Nesting ~| Mesting Depth: Display Overrides: [Allow =

New Level Display: | Config Varizble ~ | Georeferenced: |No -

PrPlan with Survey Fieldbook Referenced



3.2 Introduction to Named Boundaries

New to OpenRoads Designer is the concept of named boundaries. Simply put, named boundaries help
define the plotting extents of your design content. This section will give a brief introduction to named
boundaries and their application in creating plan sheets.

Users can refer to Section 3.6 of this document for more detailed information about named boundaries
and how to create them.

3.2-1 Named Boundaries for Plan and Profile Views
From the perspective of plan and profile views, named boundaries set the plotting extents for use in the
creation of plan-profiles, bridge layouts, construction details, and other drawings. All content—
including content from references—that is displayed within the named boundaries will show through on
the sheets created from them. The following figure displays an example of how named boundaries will
display content from referenced base drawings:

B View!, Defaul (= =
= #~-|d PLPEOGY BE|&HH

Third Named
Boundary

First Named
Boundary

Tools  Properties
B xe DG AR R A s B B9 @ X HiteMode [None
Slot ¥ 3 FileName Model Description Logical Orientation

PW_WORKDIR:d0538069\0ORD Survey Fieldbook.dgn Default Master Model Coincident - World
ORD PrPlan.dgn Default-3D Ref Coincident - World
PW_WORKDIR:d0598069\Survey Fieldi slo Default Master Model Coincident - World

Referenced Survey
Fieldbook Drawing

Scale | 1.000000000 : | 1.000000000
Offset X | 0.0000 ¥ | 0.0000

EIEN 2 i [I7] 4[] = . Nested Attachments: |No Nesting ~| Mesting Depth: [1

llow = | Mew Level Display: | Config Variable ~ | Georeferenced: No =

Base Drawing Referenced into an Active Drawing with Named Boundaries



The above figure displays a view with PrPlan set as the active drawing and a Survey Fieldbook
referenced as a base drawing.

Each of the named boundaries represents a plan view area that is clipped into a given plan profile sheet.
This same concept also applies to the profile view area of these sheets. Other drawings—such as
Construction Details and Bridge Layouts—use these same principles, but with different view sizes and
layouts for each, depending on the desired sheet type and scaling.

3.2-2 Named Boundaries for Cross Section Views
In the context of cross sections, named boundaries define the extents of each of the individual cross
sections. It is important to note that the named boundaries for cross sections are “live” snapshots, in
that they will update automatically based on the content they interact with. For example, say there is a
proposed change to the vertical profile of an alignment. The design content contained within the cross
section named boundary will change automatically to accommodate the profile change.

Cross Section Before Profile Change

— P.G. Elev = 524.84
1

Cross Section After Profile Change

115 |




Note that in this specific scenario, you would have to remove and reapply the drawing model

annotations to update the profile grade annotation. You can refer to section 4.1 of this document for

instructions on working with these annotations.

3.3 Drawing Models

As of the release of OpenRoads Designer, the plans production process directly incorporates the use of
drawing models. Drawing models are created using named boundaries to show a snapshot of the

contents of the design model that reside within them.

3-D View of Cross Section Named Boundary
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|
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_
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Drawing Model Containing the Cross Section Named Boundary Shown Above
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The Named Boundary tool in OpenRoads Designer—explained in further detail later in this chapter—
automatically creates drawing and sheet models for Plan and Profiles, Layouts, Construction Details, and
other types of sheets. The drawing models reference in the named boundaries that are created from
the design model, and then have the desired annotation applied to them. These finished drawing
models are then referenced into the sheet models in conjunction with the appropriate border file.

A very important aspect of drawing models to keep in mind during the plans production process is the
relationship to their corresponding design models when it comes to the display of your design. As
explained above, drawing models reference in the named boundaries that are created from the design
model. How the design elements are displayed in the drawing model is controlled by the Synchronize
View setting of the design model that’s being referenced into it. To access this setting, open up a
drawing model in your file and then open the References dialog. From there, open up the properties
dialog for the attachment, which in this case would be your design model. Note the Synchronize View
setting as shown below:

:J Attachment Properties: prplan 30.dgn X

PrPlan 30.dg Browse..,

Full Path: ..\dotwise\pw_waork\d096812T prplan 30.dgn
Model:  Default hd

Legical Mame: | Survey Line - Plan 1
Description: | Default

Detail Scales |1"=30" hd
Scale (Master:Ref): | 1.000000000 : | 1.000D0DD0DD

Named Group: hd

Revision: hd

Level: hd

Mested Attachments: | Live Mesting * | Mesting Depth: | 99

Display Overrides: | Always v

New Level Display: | Use MS_REF_MEWLEVELDISPLAY Configuration W

Global LineStyle Scale: | Master v
Synchronize View: | Survey Line - Plan 1 Settings From Design Model ~ i

Teggles

EENEE - e o E

Synchronize View Setting

Note the default selected option of Settings From Design Model. This option specifies that all of the
display settings configured in the design model (view attributes, level display, reference display, etc.)
will be propagated down to the drawing model—and then subsequently, the sheet model. Per several
discussions CAD Support had with our internal user base during the piloting process for OpenRoads
Designer, it was decided that this should be the default option for this setting. As such, with this setting
in place, any display changes a user wants to make for a plan sheet will need to be performed in its
corresponding design model for it to propagated back down into the sheet.
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3.4 Creating Base Drawings

With the move to OpenRoads technology, several changes have been made to the base drawing
process. The most obvious change is that some of the supplemental files that were used by InRoads are
no longer necessary for the creation of the base sheets—particularly the DTM file (surface).

As the DTM content has now been split into various data containers within the DGN, there is some
additional flexibility that has come about. First, contours and triangles are no longer separate drawing
steps. Instead, they are displayable portions of the terrain model that can be enabled/disabled with a
toggle. Additionally, as the DGN is now the container, standard MicroStation referencing can be used to
make data available across files.

This section looks at creating comparable base drawings to how processes in the past have compiled
them. This allows us to maintain a vast majority of the current workflow while maintaining flexibility in
providing the base data across the project. In that regard, the biggest change is that a drawing for
existing contours will no longer be created separately.

Next, a note on scaling. OpenRoads tools are no longer dependent on a specific scale being assigned at
the time they are drawn and are now using Drawing Scale instead. This allows for the scaling of data to
be done on the fly as discussed in Section 1.5-5 of this document. For the purposes of this document,
CAD Support will continue advocating that—if possible—a scale be given to the file. Should multiple
scales be unnecessary, the omission of the scaling will be acceptable (ex. PrPlan 50.dgn becomes
PrPlan.dgn).

As a reminder and reinforcement from the previous sections, please pay special attention to the seed
files that are recommended for use throughout this chapter. Geometry elements drawn in a 3D seed file
will cause issues with cross section generation even after a vertical profile has been applied. As such, it is
very important that content is placed in the right file to eliminate potential issues.
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3.4-1 Geocoordinating Base Drawings
Depending on the methodology used to start your base drawings, you may opt to start from fresh seed
files. The following documentation assumes the usage of already provided files that will be preset with
the appropriate geocoordination information. This section, however, covers the process of
geocoordinating individual files and may not apply/be necessary in all workflow situations.

One can easily geocoordinate a DGN file through the following process in a regular OpenRoads Designer
session.

1. In OpenRoads Designer, go to the Geographic tab of the Survey workflow, and select the
Coordinate System tool.

E’J Survey v I'i H |-_;:§ Bx:; *- v ’ é = pwiihdotwise.indot.in.gov:DOTWise\Documents\Resources\CAD Support\Working Folde
Home Field Bock Analyze [ Geographic Edit Terrain Geometry Drawing Preduction Drawing View

= s 0w @ # £ @ 5 o

Coordinate lobal E gﬂ ure Define Synchronize Follow Google Play Camera Open Location
System  Positioning Syst... Google Earth File Google Earth Image Placemark Monument Google Eart... Geogle Earth View Earth Settings Animatien i...  in Goegle..
Geographic

Coordinate System Tool

2. On the Geographic Coordinate System window, select the From File option.

E:!
|

o2 T
Current Geographic C&ﬁtem

Mame: InGCS-Lawrence

Description:  Indiana GC5 Lawrence County code 47
Source:  Indiana DOT Land and Aerial Survey Office

From File Option

3. This will present a ProjectWise file browser. Navigate to your Survey/Project Files folder and
select the Des # SRxx Seed 3D.dgn or the 2D version.

4. With the .dgn highlighted, select Open and the geocoordinated definition for the selected file
will be imported into your active DGN configuring it for further operations that can use the
coordinate system such as attaching rasters, and other project data.



3.4-2 Creating a Geometry DGN/PrPlan

Corridor modeling in OpenRoads means that alignments must exist as information within a civil model
instead of part of an ALG file. The expectation for projects surveyed in OpenRoads is that a Des # SRxx
Survey Alignments.dgn will be provided as part of the project. As with the other survey deliverables,
this file and content will be geocoordinated and based off the provided Des # SRxx Seed.dgn that’s part

of the survey project.

Please keep in mind that whether you have a survey provided alignment in a DGN or ALG, the model
with the alignment in it should be a 2D file, or if creating from legacy data, based on the provided 2D

seed file for your project.

As it pertains to the horizontal alignment itself, it should be created with the Horizontal toolset on the

Geometry tab of the OpenRoads Modeling workflow.

Co

ﬂl OpenRoads Modeling v I = H l'._' fa & - * = ‘f” s pw:\iindot-pw.bentley.com:indot-¢
m Home Terrain Site Corridors Model Detailing Drawing Production Drawing Utilities
1;';? " Import/Export ~ T P 7 o L Offsets and Tapers ~ .
= * , . A (_' o O v = \jru;
B v &y Design Elements ~ s . . A Reverse Curves ~ .
Element ... ) Ciwil Reports § Lines Arcs  Point Modify  Complex
(] Selection i1 ™ | 1 Standards ~ Toggles - v v v =L Spirals ~ v Geometry =
Primary Selection General Tools Horizontal

Horizontal Geometry Tools

Also, when creating the horizontal alignment, be sure to set it to the appropriate horizontal alignment

feature definition.

48 Create.. — >
Parameters -~
Method |;1'-.|_rt|:|mati|: ol |

Maximum Gap |I}_D328 |

Feature ~

Feature Definition |P_ALG_HD|12|:|r|taI|

Name [ ;@ No Feature Definition
: Alignmerit

----- & P_ALG_Horizontal 50 Scale and over
----- & P_ALG_Horizontal Stationing Ol

. |- @ P_ALG_Horizontal under 50 Scale
- Linear

Setting the Horizontal Alignment Feature Definition

For the purposes of this example, you will be looking at keeping a separate DGN file for the alignment
information and then creating the model and terrain in the PrPlan XX.dgn, which you will create later.



To create the file, you can use the process outlined in section 2.2-1. For this file however, your base file
will be Des # SRxx Survey Alignments.dgn. With this file created and named Design Alignments.dgn,
you can then proceed with modifying your survey alignments or creating additional alignments. Again,
with the ability to reference the DGNs together to share the civil data, this alignment file can then be
attached as needed for the purposes of corridor modeling.

3.4-2a Drawing the Proposed Profile to the Design Alignments.dgn
Moving to OpenRoads technology requires a new mindset when it comes to working with profiles. In
InRoads, all profile work was used drawing directly on top of profile graphics in your base drawing file.
This was possible as the ALG file was portable across any file that was open with InRoads. Due to the
change of how an alignment is stored, you will look at the process of creating a profile using the
OpenRoads Designer tools in preparation for plans production. This example will assume that you are
starting with a Des # SRxx Survey Alignment.dgn file that you have copied and renamed to Design
Alignments.dgn.

Please keep in mind that this file should be 2D in nature. A 3D model will be automatically created by
the software and is reference attached as soon as a terrain is referenced and made active and when a
vertical profile is being displayed. OpenRoads Designer will automatically generate the 3D geometry
elements from the 2D information.

To create a profile display in OpenRoads Designer:

1. From the Geometry tab of the OpenRoads Modeling workflow, select Open Profile Model from
the Vertical group. Alternatively, you can locate this tool by highlighting the alignment and
selecting the tool from the heads-up display when hovering over the alignment.

Zl[OperRoads Modeling | H ko « - » & & = pwi\dotwise.ndot.in.gov:DOTWise\Documents\_Tecting\00D1350\DesigniInRoads\Old Testing Data\test\ORD PrPlan.dgn [2D - V8 DGN] - OpenRoads Des
Home  Terrain Stelayout  Corridors  Model Detailing  Drawing Production  Drawing  View /
L = W 2 Impor/Export ~ s 4 5 2 5 —L Offsets and Tapers ~ 4 BB Open Profile Model Sips -
o K e Nk : % ¥ S0 e = 5 b N = BL 3
44 Design Elements v : " X Reverse Curves * 4 Set Active Profile -
Explorer Allach Properties | Element .-, Civil  Reports | Lines Arcs Point — Modify _Complex Lines Curves Element Modify Complex
Tools * Selection L1 * | % Standards * Toggles~ v e 2 Spinls v " Geometry | {7 ProfileCreation v v Proflest v Geometry
Primary Selection General Tools Horizontal Vertical
Expl -1x
[on X a View1, Defautt
A ViE-aw-ierROdsd EER%S
| OpenRoads Model ~

O @ 1=y

[Searc olex

> Z ORD PrPlan.dgn (Default)

_ 4‘ Open Profile Model

Open Profile Model

2. |If selected from the Task Navigation panel, the tool will prompt you to first locate the plan
element. Select the plan view representation of your alignment.
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3. With the alignment selected, OpenRoads will then prompt for a view to be selected or opened.

()~ € ~ 25 ~ B Multi-Model Views v|| ‘.l B HEME

Select or Open View for Profile

4. Use the View Groups toolbar to open an additional view. Any of the views from 2 through 8 are
acceptable. Left click in the opened display to confirm the profile creation. Note that the tool
will redisplay in any view you select potentially erasing any data displayed. In the event you
overwrite a profile display, know that only the graphics are lost. The actual alignment
information will persist as part of the civil model.

B View 2, Profile - Line C E‘Iﬂl@
E-%- 4 PRPROEE DEE & -8Bkl

590+ Lacate Plan Element

585
580+
575+
570H
565
560+
955
550+
545
540+

535—\\—\_\\_
530+ \
525

520+
515+
510
505+
500

495
490+

ol ol ol @I QI | | ?I QI QI QI @I @I ol QI @I @] ol of

RSN SN Q i % O
RS S S S @ @ S P §’ e? KX ,.9 ,JP & P
WO A AN VR '0' NN AN

Profile Display

Note: In the previous version of InRoads, it was necessary to manually select the feature that the existing
surface was on to have it display properly in profile. In OpenRoads Designer, this is no longer necessary
as the terrain model uses the same feature for the boundary and profile display.
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With the existing profile now displayed, you can proceed to creating a proposed profile. Please keep in
mind that this profile display is not actually part of the base model in the DGN itself; rather, it is a
dynamic view that allows for the creation of the civil data that makes up the profile.

3.4-2b Adding the Proposed Vertical Alignment
With the profile now displayed in its own view, you can now begin placing the elements that will be used
for the vertical profile. For this process, you’ll continue to use the Vertical toolset in the Geometry tab
of the OpenRoads Modeling workflow.

€l IOEEanads Modeing . Jo HE T « -+ £2 = pw:\\dotwiseindot.in.goviDOTWise\Documents\_Testing\0001350\Design\InRoads\Old Testing Data\test\ORD PrPlan.dgn [2D - V8 DGN] - OpenRoads Desi

Home  Temain I Geometry | SiteLayout  Comidors  Model Detailing  Drawing Production  Drawing  View
= L = W 7 Impor/Export T b ;;; d T Offsets and Tapers ~ fj’
Q E e k % 2 /0% -

4 Design Elements ~ X Reverse Curves +
Explorer Aftach properties | Element .- 3 =2 En s Civil  Reports  Lines Arcs  Point everse Lunves Modify Complex
Tools = Selection i ™ ‘i Standards ¥ Toggles ~ v - - v 2l Spirals T v Geometry

BB Open Profile Model Il E IJf;L I b

4 Set Active Profile
Lines Curves Element Modify Complex
[~ Profile Creation = Profiless < = Geometry<

Primary Selection General Tools Herizontal

Wertical

Vertical Geometry Tools

Note that when creating your vertical alignment, be sure to select the appropriate P ALG Horizontal
alignment feature definition from the Alignment category as shown below.

8 Create.. — by
Parameters ~
Method | Automatic v|

Maximum Gap |D.1]323 |

Feature ~

Feature Definition |F_ALG_Hnriznrrtal|

Mo Feature Definition
7 Alignment

‘P ALG_Horzontal
& P_ALG_Horzontal 50 Scale and over
& P_ALG_Horzontal Stationing Onby

- @ P_ALG_Horzontal under 50 Scale
@ S_ALG_Alignment

L@ S_ALG_Mignment Rt Plat

[~ Linear

Mame

Selecting Vertical Alignment Feature

Definition

NOTE: CAD Support is aware of the potential confusion of the current naming convention of the
“Horizontal” feature definitions specified above. As such, for the next ORD workspace release we will
change the naming convention for the feature definitions in the Alignment category to remove the
unnecessary distinction between horizontal and vertical.
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3.4-3 Creating the Proposed Plan Drawing

With the survey fieldbook and design alignments in separate DGNs, it is time to bring the base sheets
together as preparation for plans production. The following steps assume that the corridor model and
proposed terrain have been created and are prepared to be attached to the proposed plan drawing.

You can refer to section 3.4-1 for instructions on how to create a new document from a template seed
file using the Advanced Wizard in ProjectWise. Open the file once created.

At this time, you can begin by referencing your Survey Fieldbook and Survey/Design Alignment DGN
files.

1. Open the References dialog from the Home tab of the OpenRoads Modeling workflow.

ﬂllﬂpenﬂoads Modeling 'I'-i' HEle«-2 82 - pw\\dotwise.indot.in.gow:DOT

Heome Terrain Geometry Site Layout Cormidors

del Detailing Drawing Production

@& None | P_ALG_Horizontal Tangents ™ @ Explorer [E| Reference ~ @] Properties
— @ Attach Tools = ?ﬂ*:, Level Manager = IE‘ More =
v || = v || =— - * (| A

B =0 =2 Q@0 20 Models = Level Display =

Attributes

Primary

References

2. On the References window, select the Attach References button.

) Referencegd unique, 0 displayed)
Tools  Settin

— P . Ry e
E:'|L"}- XD ¥DEGRNE R BT
Slet ¥ |[|Attach Reference Model Descr

Attaching References
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3. Select both the Survey Fieldbook and Design Alignments DGN files. This can be done by holding
the Ctrl key on the keyboard while left clicking on each file. Select OK when ready to proceed.

[ Attach Reference X

Select

Documents

Folder [ 1rRoads e Bl EEIRE
o <>

Name

P4~ Design Alignments.dgn

Pd - Explan 50.dgn

+ B4 Prplan 50.dgn

< >

Application: | Al Applications v
Extension: |‘ dgn; *.dwg; *.dxf ~ ‘

Selected Documents

Name File Name

< >
Attachment method: Interactive ]

_QK -_Qancﬁ\

Selecting the File to Attach

4. As allfiles should be in the same coordinate system, the Coincident — World orientation setting
should be used. All other settings can be left to their default values. When ready select the OK
button.

Reference Attachment Settings for ..\Explan 50.dgn

Hie Name: PW_WORKDIR:d0466326\Explan 50.dan
c:\users\stikuhn \workdir\dD466326\Explan 50.dan
" |Defaut -

Logical Name: | Ref |
Description: | Master Mode! |

Orientation:
View Description
Coincident Aligned with Master File
Coincident - World eamna\ Origin aligned with Master File
Standard Views
Saved Views fione)

Named Fences (none)

Detail Scale
ER—
Named Group: -
Revision -
Level -

Nested Attachments: | Live Nesting + | Mesting Depth
Display Ovemides: [Alow |

New Level Display: | Use MS_REF_NEWLEVELDK
Global LineStyle Scale:

Synchronize View: [Wolume Only -

Toggles

EENGEE»« @@l

Drawing Title

Create

Name

Attachment Settings
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5. Repeat this process for all the files you are attaching.

6. Finally, adjust your Drawing Scale to the appropriate value. For this example you will be using
1”=50".

@
ook Settings
BBy £ 071 50 0 ¢ B 350 0wk os -
St © 3 Fle Name Wodel Description Logeal
7 PW_WORKDIR d0466326\Design Algnmert.dgn  Defaut Master Model
2 PW_WORKDIR d0466326"Explan 50 dgn Defaut Master Mode! - I
2 Drawing Scale
Sirvey Feet
g Survey Inches
Scale [ 1.000000 1.000000 Rotation | 00°0000"
1'=50°
Offset X 00000 Y [0.0000 Z [0.0000
Gl &[] 4 @] e [7] @ [A] = - Hested Atachments: |Lve Nestng | Display Overdes: | Alow g CusTomAcs -
New Level Display: |Config Variable * | Ge d: [Na. - 1"=50° -

References Attached and Displayed a 1”=50"

As an alternative to attaching each file specifically, you could also use Live Nesting to attach Explan
XX.dgn to the Design Alignments.dgn and then into Prplan XX.dgn. Just make sure that the Nested
Attachments are set to Live Nesting and that the depth is 1 or greater depending on your project needs.
In that instance, your reference dialog may look like the following:

) References (2 of 2 unique, 2 displayed) - X
Tools  Settings
e & $d G R 000 8 ¢ D Y8 @ 0 bieMode: [Boundaes ~
Hierarchy St ¥ | File Name Model Description Logical Oriertation Presertation [3] o§ X (3
= = -\Design Align... Eul aster Modsl oincidert - Wor Wirsframe:
8 Prplan 50.dgn 1 Design Al Defaut Master Mods! Coincidert - World  Wiref ARV
=+t PW_WORKDIR...\Design Alignments.dgn
PW_WORKDIR:d045...\Explan 50.dgn
Scale | 1.000000 - [1.000000 Rotation | 00°D0'00" Offset X | 0.0000 ¥ [0.0000 Z [0.0000}
ElEx e filx] » < @ e [@]@ Nested Attachmerts: | Live Nesting ~ | Display Overides: [Alow ¥ | Nesting Degth: | 1
< > || MNew Level Display: |Config Variable = | Geo =

Using Nested References



Project Explorer >R IX

< Cwil Model 9 Civil Standards [ Survey r

=« Civil Data A
-« Prplan 50.dgn, Defaut

i,/ Linear Elements

+ Paint Elements

i Civil Cells
W Civil Objects

al

Active Temain Model:

Civil Model with Nested References

At this point you will have the required data to begin the corridor modeling process. Upon completion
of your modeling, you will be prepared to continue in Prplan XX.dgn.

Corridor Modeling with Referenced Geometry and Terrains

As discussed at numerous points throughout this document, OpenRoads allows for the separation of
design items by placing them in separate DGN files and then referencing them back together. While a
very powerful tool to have, there are a few items to keep in mind while working with referenced
elements.

The first item to keep in mind is making sure you activate the terrain properly. In the above example
you have attached the Explan 50.dgn which contains the terrain model that will be targeted. Prior to
performing any modeling process, you must first make sure it is the active terrain model. Unfortunately,
it will not show up in the civil model dialog until activated. To do so, hover over the perimeter of the
terrain. When the heads-up display appears, select the Set As Active Terrain Model option.

_EEer

L L

Set As Active Terrain Model

Set As Active Terrain Model



With the terrain activated, your Civil Model tab will then populate with the referenced in information
and look like the following:

Project Explorer ~hpX
Fle 9 Utity Model | " e KD

B Civil Data

g7 Prplan 50.dgn. Default

----- " Linzar Blements

----- + Point Elemerts

- 3D Linear Elements

% Temain Models

-'I ﬂ Comidors

----- 7 Superelevation

-l Civil Cells

----- W Civil Objects

@z

@ <. Design Alignments.dan, Default
Bl <. Explan 50.dgn, Default

----- /" Linear Blements

----- + Point Bements

-4 30 Linear Eemeants

E—]--% Temain Models

; Artive Temain Model: Des & SR

-l Civil Cells
..... ¥ Civil Objects
- Referenced Models

Civil Model with Active Reference Data

At this point, a new 3D model will be created and referenced back in. Please keep in mind the view
control process from section 1.2-3 of this document as having both 2D and 3D views will be beneficial.

Next, while modeling with referenced alignment information, know that you will not be able to
graphically pick vertical profiles as they will not be able to be drawn up from a referenced file. To
further that, please keep in mind that the horizontal alignment and its vertical profile MUST reside in the
same DGN file. When creating a corridor, you will first select the plan view alignment. On the following

dialog requesting the Profile Element, select the appropriate vertical from the Locate Profile Element
dialog.

% Create Corridor

Locate Profile El | Active Profile: Profile Grade[~ ||

| Active Profile: Profile Grade |

Corridor Name

Design Stage |2 - Design o |

Selecting the Vertical Profile
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With the terrain active, and the horizontal and vertical profiles selected, you can then proceed to create
your corridor in Prplan XX.dgn

Note: One thing to be very careful about when working with referenced civil data is the detaching of
references. All civil data is based on an ever-evolving set of rules and connections to available data in
your project. Should you have civil data that is connected in this manner and then go to detach a file,
you may see the following dialog.

Delete Reference

This reference has probable dependencies in the current civil
! model.Detaching this reference will break relationships in the element
rules which may be permanent. Are your sure to want to detach it 7

Civil Dependencies and References

This message means that there are civil dependencies that exist with your data. Special care should be
used, and best practice is to avoid detaching references when possible, so as not to break any civil
references.

With your design completed and being displayed over your existing, you can now begin the final
preparation steps for creating cut sheets.

3.5 Adjusting your Design Stage for Plans Generation

As you work on your design, much of the display control on your corridor will be via the use of the
Feature Definition options in the corridor’s properties. These feature definitions (which function in
much the same way as “Design Stages” in previous versions of OpenRoads) are a combined set of rules
that govern how your corridor is displayed and the level of accuracy which it is modeled.

As you complete your design, you will notice that there are several different feature definitions that you
can apply to a corridor:

e 0- Functional

e 1-Preliminary

e 2 -Design

e 3-Final

e 4 -Final w/ Meshes

e 5-Final w/ Top Mesh

e 6 - Final w/ Bottom Mesh
e 7 -Final w/ Linear Features
e 8- Final w/ Components



These options all allow for different representations of the corridor and how it displays in the plan view.
While each of these have different uses, the 3 - Final feature definition is the one that will be used
most—as it allows for the most thorough display of all corridor information. However, this display
setting contains far more information than is needed for plans generation:

primary selection Model Analysis and Keporting Model Import export
Properti - Ex
il 2 X | a View!, Defauit
+ e E-8u-sPeRO8Y P IR

4 {f{ Corricor: Line A Plan: Line A Profile: P_ALG_Horizontal

b e Templates

> 4 Components <
General ~
Element Descrip
Level
Color
Line Style
Weight
Class
Template
Transparency e S S EESE SEsiEiia e e SESSsSs ==
Priority
Extended “~
Model Default
212000 BAG30 AN B U e I AT R
Snappable
Modified
New
Locked Unlocked
Disglay Style (From View Display)
Feature -~
Feature Definition Final
Feature Name Line A

Corridor Using 3 - Final Feature Definition

For the purposes of plans generation, most instances will need to display the final linear elements of the
corridor. The recommended Design Stage to display just this information is 8 — Final w/ Components.
This corridor stage has been modified to display both the components and linear features allowing for
the display of the components in cross sections.

Properties - Ix

B View 1, Default

Eraw- i PL0OY Y [EE I

4 %b Elements (1)

4+ ffl Corridor: Line A Plan: Line A Profile: P_ALG_Horizont
b e Templates
> 4 Components
b 2 Features
> |4 Point Controls
o Key Stations

}- Secondary Alignments

2 End Condition Exceptions <
1 »

General -~

Eleme

Level

Color

Line Style

Vieight

Class

Template

Transparency 0

Priority 0

Extended -~
Default
10/2/2020 8:39:10 AM
Snappable
Modified

Ne New

Locked Unlocked

Display Style (From View Display)

Feature -~

Feawre Definiion 8 - Final w/ Components

Feature Name ne A

Corridor Using 8 — Final w/ Components
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This is the most appropriate display for plans generation and should be used when displaying the
corridor to cut plan sheets and cross section and will be reflected in the ModelName-3D that’s created.

At this point you can control the display of any subgrade features by shutting the relevant levels off in
the level display.

3.6 Sheet Layout and Creation (Plan Profile Sheets)

One of the major items that has been changed with the release of OpenRoads Designer is the use of
named boundaries in the creation of sheet drawings.

This section covers how to create the named boundaries themselves, and then how to create Plan and
Profile sheets from them.

3.6-1 Files Required for Plans Production

Before beginning the process of creating plan sheets, make sure you have the following items created
and set up properly:

e Your survey fieldbook file with the terrain included.

e Your Prplan XX.dgn (which references your survey fieldbook file) that contains your proposed
design elements.

e Analignment to create the named boundaries along. The alignment can be created in the
PrPlan directly, or it can be included in the PrPlan via reference. The alighment must also have a
vertical profile associated with it.

e Ablank geocoordinated 2D seed file. This file is to be used as needed as the foundation for
cutting your various plan sheets.

3.6-2 Named Boundary Creation
The first step in the creation of Plan and Profile sheets in OpenRoads Designer is to first open a blank 2D
geocoordinated seed file and reference your PrPlan XX.dgn into it. From there, you can adjust the
necessary level and display settings within the file as desired prior to creating your plan sheets. Then
once your preliminary setup is complete, you can create named boundaries to determine the extents of
your plan and profile sheet(s). To accomplish this, separate named boundaries are created for the plan
view and the profile view to create the sheet. This section will cover how to create named boundaries
for each view.

Note: Once named boundaries have been created, they can be reused if further iterations of the sheets
need cut. Please see section 3.8-4c of this document for a discussion of this process in the context of
cross section sheets. The process described there is also applicable to other named boundary types used
in the plans production process.



3.6-2a Creating Named Boundaries for the Plan View
With a blank 2D geocoordinated seed file open, perform the following steps:

1. Reference your PrPlan XX.dgn into the file. This will bring in all your design information into the
file.

2. Before creating named boundaries and cutting your sheets, proceed to adjust the level display,
presentation settings, etc. within the file as desired to have the plan sheets look the way you
want when they are created.

3. With the preliminary setup completed, navigate to the OpenRoads Modeling workflow, click on
the Drawing Production tab, and then click on the Named Boundary tool.

i

‘OpenRoads Modeling M

Horme Terrain Geometry Site Layout Corridors

=HEHER « - | = ﬂ\dnmise.indnt.in‘gnv:DOTWise\DncumentsLTesting\mmBSU\De;ign\lanads\Old Testing Data\test\ORD PrPlan.dgn [2D - V
Model D

el h: YT O O EAmAL LY A W

WFer Attach properties  Element Clip - Create  Update Saved  Appl Place | Place Place Place Edit Change Text ~ Element Model Named
Tools = il \f\/yew A

election i T Volume Saved View View Settings Saved Vi Table = Note Label Text Tedt Attrbutes A,  Annotation~ Annotation - EBoundary ~

Primary Selection Clip Saved Views | Tables Motes Text [F] Annotations G Named Boundaries

Named Boundary Tool

4. The Place Named Boundary dialog will then appear. Along the top, there are several options to
choose from to create named boundaries. In this case, select the first option: Civil Plan.

= Place Mamed Boundary Civil Plan — =
] y
g N\-'- -
P Bk 7
—
(none) =
Detail Scale: |Full Size 1=1 -

Mame: |Plan1

Description:
Group: | (New) -
Mame: | Untitled

Description:
[] Start Location: |
[ Stop Location: >
Length: | 1625.000000 —_
Left Offset: | -243.000000 —
Right Offset: | 245.000000 —
Overlap: | 125.000000 —_

Boundary Chords: | 3
Create Drawing
Show Dialog

Civil Plan Option in Place Named Boundary Tool
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5. The first setting to configure is the Drawing Seed. This setting contains several preconfigured
drawing seeds that set the Detail Scale, Length, Left Offset, Right Offset, and Overlap values for
the desired plan view. Plan view options include those needed for Bridge Layouts, Double Plan,
Plan Only, Letter Plan, and Plan and Profile sheets. For this example, the Plan Profile (Plan) 30
Scale drawing seed will be used.

J?" Place Named Boundary Civil Plan - x

£

Drawing Seed:

Detail Scale: | Mame &
Letter Double Plan 200 Scale
o Letter Plan 200 Scale
Description: | p1an gnly 10 Scale

Group: |Plan Only 20 Scale
Plan Only 30 Scale
o Plan Only 30 Scale

Description: |pjan Onky 100 Scale
[] Start Lecation: |Plan Profile (Plan) 30 Scale1
Plan Profile (Plan) 50 Scale
Plan Profile (Plan) 100 Scale

Length: |Plan Profile (Plan) Large Plan 20 5cale

Left Offset: Plan Profile (Plan) Large Plan 30 Scale

Name:

MName:

[ stop Location:

Right Offset: =
Overlap: | 25.000000 —

Boundary Chords: | 10
Create Drawing
Show Dialog

Selecting a Drawing Seed

6. At this point, you can fill in the Name and Description fields for the Named Boundary:

BO=® ./ Or
Drawing Seed: |Plan Profile (Plan) 30 Scale -
Detail Scaler |1"=30' -

Mame: | 5R 3 PlanProfile

Description: | SR 3 Named Boundaries - Plan View

Group: I(N ew) -
Marne: | 5R 3 PlanProfile
Description:
[ Start Location: |-
[] Stop Location: >
Length: | 900.000000 —
Left Offset: | -163.500000 s
Right Offset: | 163.500000 —
Overlap: | 0.000000 =

Boundary Chords: | 10
Create Drawing
Show Dialeg

Name and Description for Named Boundaries
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7. The next settings to fill in are the Name and Description fields for the Plan Group. The Name can
either be entered in manually, or by clicking on the path element (i.e., alignment) that you are
placing the sheets along—which will automatically populate the Name field with the name of the
alignment. The Description in either case is optional. Be sure to make note of the Name, as it
will come into play when it comes time to create the corresponding named boundaries for the
profile view.

% Place Named Boundary Civil Plan -
Y Pardsls

Drawing Seed: Plan Profile (Plan) 30 Scale -

Detail Scale: |1"=30" -
Mame: | 5R 3 PlanProfile

Description: | 5R 3 Named Boundaries - Plan View
Group: |(New) -
MName: | LINE R_RERUN

Description:
[ Start Location: | 706+ 14.79
[ Stop Location: | 627+00.00
Length: | $00.000000
Left Offset: | -163.500000
Right Offset: | 163.500000
Overlap: | 0.000000
Boundary Chords: | 10
Create Drawing
Show Dizlog

nnenxET

Name and Description for the Plan Group

8. The next settings to address are the Start Location and Stop Location. If not already selected
from the previous step, select the alignment that you are wanting to create the sheets along.
Once the alignment is selected, the Start Location can be chosen interactively anywhere along
the alignhment—which follows your mouse pointer as indicated by a gray line perpendicular to the
alignment.

Selecting a Start Location
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Alternatively, click the button to the right of the Start Location field to lock it to the beginning of
the chosen alignment. A check mark will then appear to indicate that it is locked.

Start Location: | 705+00.00 EI

] Stop Location: | 687+00.00 |

Locking the Start Location to Beginning of Alignment

9. Inasimilar fashion as selecting the Start Location, the Stop Location can be selected interactively,
or by clicking on the button to the right of the field to lock it to the end of the chosen alignment.

Start Location: | 703+ 00.00 |-
tnp Location: | 718+40.08 m

Locking the Stop Location to End of Alignment

10. At this point, all the settings should be in place to create the Named boundaries. The last
remaining step is to disable/uncheck the Create Drawing setting—as at this point, you do not
want to create the drawing yet without having your profile named boundaries defined.

[] Create Drawing

show Dialog \

Disabling the Create Drawing Setting

11. To proceed with creating the named boundaries, click anywhere within the view to accept the
Named Boundary settings. The named boundaries (outlined in gray) will now appear in the view,
and click again to accept the placement.

Named Boundaries Created



3.6-2b Creating Named Boundaries for the Profile View
With the named boundaries created for the plan view, you are now ready to create the named
boundaries for the profile view.

1. The first step in the process is to display the profile of the alignment. While still in the

OpenRoads Modeling workflow, select the Geometry tab, and click on Open Profile Model from
the Vertical group.

‘j OpenRoads Modeling = = e b [T & ~ S - pwi\dotwise.indot in.gov:DOTWise\Documents\_Testing\0001350\DesigniinRoads\Old Testing Data\test\ORD PrPlan.dgn [2D - V& DGN] - OpenRoads Des

Home  Terrain mm Comidors  Model Detailing ~ Drawing Production  Drawing  View
S 7 ImperBpert © e 2 , i Offscts and Tapers - [ £ Open Profile Model OpEn Profile Model -
q N @ K ° B ® /S0 N L

{ Design Elements ~ G

Reverse Curves = " Set Active Profile

Bxplorer Attach properties  Element =, Gl Reports | Lines Arcs Point — overse Cuves Mudlfy Complex Lines Curves Element Modify _Complex
Tools - Selection i ¥ ﬂ Standards ~ Toggles ~ - - - ~ 2 spirals * - Geometry = | |~ Profile Creation * - Profiles - Geometry =
Primary Selection General Tools Horizontsl Vertical

Open Profile Model

2. Select the alignment to get the profile for, open a new view to place the profile in (in this
example, View 4), and click within the view to place the profile.

B View 4, Profile - LINE R_RERUN EI@

M- PPO0O0ER DEE &+ B lalg| A

Profile Placed within a New View

3. With the profile placed in the new view, go back to the Drawing Production tab and open the
Named Boundary dialog once again.

ﬂ

OpenRoads Modeling - H ‘._' fo « ~ j = = wit\\dotwise.indot.in gov:DOTWise\Documents'_Testing 0001350\ Design\InRoads\Old Testing Data\test\ORD PrPlan.dgn [2D - V
i Home Terrain Geometry Site Layout Corridors Model Detal Drawing Production Drawing Wiew

e - b RBL
. = AR r| D A B A7 ¥ A BBC =
@ N X o & AR QAT AV A X L
7 a2
Expfrer Attach properties  Element .., Clip Create UpdateSavad %y Place | Place Place Place Edit ChangeText , Element Madel Named
Tools ~ election (i T Volume Saved View View Settings Saved View Table = Mote Label —Text Text Attributes A, ™ Annctation™ Annotation Boundary ~
Primary Selection Clip Saved Views T | Tables Motes Text ] Annoctations & Named Boundaries T

Opening Named Boundary Dialog
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4. This time, select the third option: Civil Profile.

RN S [T

Civil Profile Option in Place Named Boundary Tool

5. In much the same fashion as for the named boundaries in the plan view, Drawing Seeds have
been preconfigured for different profile preferences as well, including Bridge Layouts, Profile
only, and Plan and Profile sheets. For profiles, the Drawing Seeds preconfigure the Detail Scale,

Vertical Exaggeration, Availabl

this example, the Plan Profile (Profile) 30 Scale Drawing Seed will be chosen.

e Profile Height, Top Clearance, and Bottom Clearance settings. In

1 J?" Place Named Boundary Civil Profile - X

KLy L Fgigups

-

Marne:

Description:

Method:

Plan Group:

Group:

Name:

Description:

Vertical Exaggeration:
Available Profile Height:

Elevation Datum Spacing:
Station Datum Spacing:
Profile Shifts:

Top Clearance:
™ Bottom Clearance:

(none}
Bridge Layout (Profile) 30 Scale
Bridge Layout (Profile) 30 Scal

lPIan Profile (Profile) 30 Scale I

Plan Profile (Profile) 50 Scale

Plan Profile (Profile) 100 Scale

Plan Profile (Profile) Large Plan 20 Scale
Plan Profile (Profile) Large Plan 30 Scale
Plan Profile (Prefile) Large Plan 50 Scale
Profile Only 20 Scale

Profile Only 30 Scale

Profile Only 30 Scale

2.000000
10.000000
100.000000
Datum Stations A
[ Use Terrains
Use Active Vertical
[1 Whole Conduits Only
[] Create Drawing
Show Dialog

Selecting a Drawing Seed
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6. After the Drawing Seed is selected, note the Method and Plan Group settings.

Method: |From Plan Group -
Plan Group: |LINE R_RERUM -
Method and Plan Group Settings

By default, the Plan Group that is selected is the one that is associated with the most recently
created named boundaries in the plan view. The Method chosen by default is From Plan Group,
which essentially sets the profile named boundaries to share the same station limits as
specified for the selected Plan Group. There is also a “Station Limits” method, which allows you
to set specific start and end stations for the profile limits.

In the same way as for the Plan Group, you can specify the Name and Description for the Profile

Group.
AT E® .o O
Drawing Seed: | Plan Profile (Profile) 30 Scale -
Detail Scale: |1"=30 -
Marne: | Profile 1
Description:
Methed: From Plan Group hd
Plan Group: | LIME R_RERUM -
Group:  |(Mew) -
Marne: | LINE R_RERUM
Description: | From Plan Group: LINE R_RERUN

Vertical Exaggeration:
Available Profile Height:

Top Clearance:
] Bottom Clearance:

Elevation Datum Spacing:
Station Datum Spacing:
Profile Shifts:

'3.000000

80.000000

0.500000

2.000000

10.000000

100.000000

Datum Staticns -
[] Use Terrains

Use Active Vertical

[1 Whele Conduits Cnly
[] Create Drawing

Show Dialog

Name and Description for Profile Group
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8. With the settings configured as desired, you are ready to create the named boundaries for the
profile and create the Plan and Profile sheets. Note these checkboxes at the bottom:
e Use Terrains: Places the active terrain into the profile view of the sheet.
e Use Active Vertical: Places the active vertical profile on the sheet.
o Create Drawing: Enable to proceed with creating the Plan and Profile Sheets
e Show Dialog: If enabled, will show a dialog with additional Drawing Seed parameters
prior to sheet creation.

For the purpose of this demonstration, all the above settings will be enabled.

9. At this point, select the profile created in the secondary view (in step 2), and click once again in
the profile view window to accept. A Create Drawing dialog will then be displayed as shown:

3._6—3C_omp1et@_o_n of _the PIans_P[oductLon Process — Creating Sheets

|l
| Meode: | Plan and Profile A
O One Sheet Per Dgn:
|
| View Mame: | LINE R_RERUM - 5R 3 PlanProfile View Name: | P_ALG_Vertical - Profile 1
| Drawing Seed: |Plan Profile (Plan) 30 Scale M Drawing Seed: |Plan Profile (Profile) 30 Scale -
View Type:  Civil Plan View Type:  Civil Profile
j Discipline:  Civil Discipline:  Civil
| Purpose:  Plan View Purpose:  Elevation View
Drawing Model Drawing Model
Model Mame: | LINE R_RERUM - SR 3 PlanProfile Model Name: | P_ALG_Vertical - Profile 1
Seed Model: | PlanProfile 30 Scale_No Overlap.dgnlib, F Seed Model: | PlanProfile 30 Scale_No Overlap.dgnlib, F
O Filename: | (Active File) O Filename: | (Active File)
A =3 - A =3 -
Annotation Group: |None w Annotation Group: | ProfileGrid ~
Sheet Model Sheet Model
Model Name: | LINE R_RERUM - SR 3 PlanProfile Model Name: | P_ALG_Vertical - Profile 1
Seed Model: | PlanProfile 30 Scale_No Overlap.dgnlib, F Seed Model: | PlanProfile 30 Scale_No Overlap.dgnlib, F
O Filename: | (Active File) Filename: | (Active File)
Sheets: |(Mew) - Sheets: |(Mew) -
A Full Size1=1 - A FullSze1=1 -
Drawing Boundary: |PP (PLAN) 30 SCALE_NO OVERLAP  ~+ Drawing Boundary: PP (PROFILE) 30 SCALE_NO OVERLAP ~
Detail Scale: |1"=30" - Detail Scale: 1"=30' (By Named Boundary) A
Add To Sheet Index (&2
Make Sheet Coincident
Open Model

Create Drawing Dialog

The Create Drawing dialog provides you with a chance to review the settings specified in the creating of
the named boundaries in the plan and profile views. In this case, the Plan and Profile mode should be
selected, and in the View Name and Model Name fields, proceed to enter a different name if you would
like to change the default naming given. Then for the Annotation Group setting for the plan view, select
the appropriate Plan annotation group. In this case, you would select the Plan Profile 30 Scale
annotation group by navigating to Plan = Drawing = Plan Profile 30 Scale.
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Annotation Group: |Nnne
@ |
=~ Plan

Model Mame: =- : Drawing
Seed Model: ~@ Plan Profile 30 Scale

..... @ Bridge Layout 50 Scale

----- & Plan Only 10 Scale

Al @ Plan Only 20 Scale

----- & Plan Only 30 Scale

----- & Plan Only 50 Scale

Detail Scale: | L. @ Flan Only 100 Scale

----- & Plan Profile Large Plan 201 v
< >

Drawing Boundary:

Plan Annotation Group

Finally, pay special attention to the One Sheet Per Dgn setting which, when enabled, will create each
resulting plan and profile sheet to a separate dgn file. What follows is the procedure going forward for
each case (disabled vs. enabled).

3.6-3a One Sheet Per Dgn Setting Disabled:
10. When you are satisfied with the settings (One Sheet Per Dgn Setting disabled), click OK to create
the drawings. Note the two sets of files that get created: a set of Drawing models and a
corresponding set of Sheet models.

Models *h 01X

(1he L E 7YX

Type 20/30 Mame ©

Q1 ] Default
T ‘P Default-3D
ﬁ 1" LINER_RERUN - SR 2 PlanProfile
(3 _|  LINER_RERUN - SR 3 PlanProfile [Sheet]
Y _|  LINER_RERUN - SR 3 PlanProfile-1
B LINER_RERUN - SR 3 PlanProfile-1 [Sheet]
&Y | P_ALG_Vertical - Profile 1
[ ] P_ALG_Vertical - Profile 2

Newly Created Models

In this example with two Plan and Profile sheets being created, two Sheet models are created that
contain the Plan and Profile sheets, and four Drawing models: one Drawing model for each Plan view
and Profile view, respectively. These Drawing models are then referenced into the Sheet models to
create the Plan and Profile sheets.



3.6-3b One Sheet Per Dgn Setting Enabled:
10. If you wish to have the plan and profile sheets created and placed in separate dgn files, click on
the checkbox to enable the One Sheet Per Dgn setting. Then click on the folder icon to select a
location in either ProjectWise or your local computer to save the files to.

| One Sheet Per Dgn: | pw:\\indot-pw.bentley.com:indot-pw-01\D
! View Name: | LINE R_RERUN - SR 3 PlanProfile-2 View Mame: | P_ALG Vertical - Profile 1-1
Drawing Seed: |Plan Profile (Plan) 30 Scale hd Drawing Seed: Plan Profile (Profile) 30 Scale -
View Type:  Civil Plan View Type:  Civil Profile
| Discipline:  Ciwil Discipline:  Civil
| Purpose:  Plan View Purpose:  Elevation View
| Drawing Model Drawing Model
Model Name: | LINE R_RERUN - 5R 3 PlanProfile-2 Model Name: | P_ALG_Vertical - Profile 1-1
Seed Model: | PlanProfile 30 Scale_No Overlap.dgnlib, F Seed Model: | PlanProfile 30 Scale No Overlap.dgnlib, F
(Active File) (Active File)
A [r=3r - A =30 -
Annotation Group: |None v Annotation Group: |ProfileGrd ~
Sheet Model Sheet Model
Model Name: | LINE R_RERUN - SR 3 PlanProfile-2 Model Name: | P_ALG Vertical - Profile 1-1
Seed Model: | PlanProfile 30 Scale_No Overlap.dgnlib, F Seed Model: | PlanProfile 30 Scale_No Owverlap.dgnlib, F
(Active Filg) Filename: | (Active File)
Sheets: |(New) - Sheets: |(New) -
A [FullSize1=1 ~ A [FullSize 1=1 o
Drawing Boundary: |PP (PLAN) 30 SCALE_NO OVERLAP  ~ Drawing Boundary: |PP (PROFILE) 30 SCALE_NO OVERLAP ~
Detail Scale: [1"=30' - Detail Scale: |1"=30" (By Named Boundary) =
Add To Sheet Index &
Make Sheet Coincident
Open Model
oK Cancel

One Sheet Per Dgn Setting Enabled

11. One final setting to consider is the Open Model setting at the bottom of the dialog. If you do
not wish to have your current OpenRoads Designer session ended when the sheet creation
process is over, disable this setting. Otherwise, the current OpenRoads Designer session will be
ended, and the latest plan and profile sheet dgn to be created will be opened in its place.

12. Once satisfied with all the settings, click OK. The plan and profile sheets will then be created at
the specified location (ProjectWise in this example). NOTE: When initially created, the new dgn
files will be associated with MicroStation by default. To open these new files with ORD, you
will need to modify the files’ properties such that it is associated with ORD instead of
MicroStation.

l/"{‘]Tv&rrain_E:c:is,tin5| Topo
/HTEST_'I 201016_Base_PRPlan.dgn
v &g TEST_1801016_Corridor_Roadway.dgn

| gt

HSecTesting.dgn
w" #L|LINE R_RERUN - SR 3 PlanProfile.dgn
" &L|LINE R_RERUMN - 5R 3 PlanProfile-1.dgn

Plan and Profile Sheets Created in Separate DGN Files
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3.7 Adding Other Base Drawings to Sheets

Other base drawings such as Existing Right of Way can be added to OpenRoads created sheets such as
Plan Profiles, Layout sheets, etc. The user must first obtain right of way drawings from whatever
sources are available. For most projects, the existing right of way information will come from Route
Survey Plat drawings and these should exist in the same coordinate system for any new projects and will
line up automatically. (These are provided by your surveyor). Other sources may include CAD drawings
from Real Estate consultants (following complete abstracting and title searches). Throughout this
section, Existing Right of Way drawings are referenced as being created. The same processes work for
adding any additional information to the sheets.

Depending on your surveyor, it is entirely possible that you may receive your Existing Right of Way in
InRoads or OpenRoads Designer native surface features or as alignments. Be aware you may still have
to graphically convert either of these data types into the other for the purpose of cross section display
(Right of Way must be a surface feature if you wish for it to display on cross sections).

3.7-1 Combine multiple drawings into one base drawing
If you have more than one existing right of way drawing for your project, you will want to combine all
the drawings into one. Reference the drawings into each other. If the drawings do not line up
automatically, you will need to move the files based on corresponding coordinates present in both
drawings. Next copy the reference files into the base drawing. Repeat this procedure if you have
multiple files to copy in.

When you have completed the above steps, the desired result is one combined existing right of way
drawing.

3.7-2 Move to same coordinates system as PrPlan.dgn
For the combined existing right of way drawing to be used in the plan profile sheets, the elements must
exist in the same coordinate system. To accommodate this, you will reference in the PrPlan drawing. If
the drawings do not line up automatically, you will need to move the files based on corresponding
coordinates present in both drawings.

The resulting existing right of way drawing is now ready to be added into other proposed drawings.

3.7-3 Graphically Importing Existing Right of Way
As the procedures necessary vary depending on the source of your Right of Way data, you will examine
a few of the more common methods for importing this data and working with it in OpenRoads Designer
and making it available to others.

Data which is graphical in nature can be converted to a format OpenRoads Designer will interact with.
MicroStation, AutoCAD, and DXF files are all supported for this process. Utilizing the File import tools
available allows vector graphics data to be converted to geometry or surface features. Often-times the
largest barrier to conversion is the sheer volume of data in the CAD file provided. Disseminating the
contents requires patience and organization.

In both instances, be aware that the element must be drawn up graphically, as there is no direct
translation method from Surface Features to Geometry Alignments.



3.7-3a Importing to Geometry
Using an existing CAD file provided by either Survey or a Consultant, you will convert the vector graphics
representing Right of Way elements to OpenRoads Designer geometry. If the data provider is an INDOT
employee, then the file is accessible through ProjectWise from the design folder structure. Files
provided by external consultants can be imported to a convenient location in ProjectWise by dragging
and dropping. Select No Wizard for the creation option.

First you need to reference and possibly merge your data into the base drawing (alignments can be
imported from reference elements). Attach your file using the References tool from the Home tab of
the OpenRoads Modeling workflow. With the References dialog open, attach the file containing your
right-of-way. This may be the LCRS Plat provided by survey or another file provided by a consultant.
Note that the file you attach may have additional data displayed that you do not wish to import. Should
this be the case, you can use your level display to disable the levels of features you do not wish to
display.

At this point, you will no doubt recognize the right-of-way elements in the drawing. Elements can be
converted to OpenRoads Designer geometry. Careful inspections of right-of-way elements may show
elements that have been constructed, segmented, and are not joined. For convenience in later
operations, you may wish to join them to be continuous. To join these elements using OpenRoads
Designer, use the Complex By Element tool, which is found on the Geometry tab of the Drawing
workflow. Locate the Horizontal tool group, and click on Complex Geometry > Complex By Element.

ﬂ OpenRoads Modeling 'I H‘-._' fo & ~ * = * pw:\\dotwise.indot.in.gov:DOTWise\Documents\Resources\CAD Suppert\Working Folders\PS\Mitch Ol
Home Terrain I Geometry I Site Layout Corridors Model Detailing Drawing Production Drawing View

e [§ e k @ 2 mpew/Eport * e s T ) o SoTEETEE ;,f EECpenlbror
- % Design Elements ~ ™ Z « A Reverse Curves v . 5 Set Active
Modify | Complex

Explorer Attach properties  Element ., Civil Reports =~ Lines Arcs  Point
Tools = L v v v

Selection L1 v | % Standards v Toggles + v 2 Spirals v Geometry v | b Profile Cre|
Primary Selection General Tools HorizontaN ~  Complex By Element
Explorer ¥ 0 X Properties Z  Complex By Pl |
¥ Items v ~ Define By Best Fit
. OpenRoads Model ~ = Geometry Builder
QO & , - #E Geometry Connector

Complex By Element Tool

On the dialog that appears, you will be given a choice between Manual and Automatic for the Method
setting. With the Manual method, you will choose each element to be joined manually. With the
Automatic method, you choose the first element that you would like to have joined, and then the tool
automatically detects/selects the remaining elements to be joined. In either case, be very careful with
the direction the element chain is going. While hovering over the elements to be selected, pay close
attention to the arrows that appear to indicate which direction the chain is going. In this example, the
Automatic method will be used, and the element chain is to be going upward.
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Feature Definition |RW_ProposedRW ~
Mame RW_ProposedRW

All Elements Selected After Selecting First Element in Chain

With all the desired elements in the chain selected, you can apply the appropriate feature definition to
the complex element chain. In this case, click on the dropdown arrow in the Feature Definition field and
navigate to Linear > Right of Way > Proposed > RW_ExistingRW.
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Selecting the RW_ExistingRW Feature Definition

With the feature definition selected, you can then give the element chain an appropriate name. Finally,
click in the drawing to accept the creation of the complex element chain.



3.8 Cross Sections

As of the release of OpenRoads Designer, cross sections are created via the use of named boundaries.
Named boundaries for cross sections determine the extents of the sections of themselves, and you can
also specify where you want the sections created along a selected alignment. This section will first cover
how to prepare your PrPlan drawing for cross section creation. It will then cover how to create named
boundaries for your desired cross sections, and how to cut the sheets containing them.

3.8-1 Preparing PrPlan.dgn for Cross Sections
As discussed in the previous section on changes, for the proposed corridor to display on your sections, it
must be displayed with the proper Design Stage in the PrPlan.dgn. To adjust the setting accordingly:

1. Open your Prplan XX.dgn.
2. Select the corridor model by its handle.

Profile: Profile Grade
Level: P_MD_Final

Selecting the Corridor

3. Examine the corridor in the Element Information panel. Locate the Feature Definition setting.
4. Set the Feature Definition to 8 — Final w/ Components.

Feature »~
8 - Final w/ Components v
Fe| & Mo Feature Definition
= Comidor

Cot L. @ 0 - Functional
N & 1 - Preliminary
Hd @& 2- Design
[T & 3-Final
Py @& 4-Final w/ Meshes

----- @& 5-Final w/ Top Mesh

----- @ 6 - Final w/ Bottom Mesh

----- @ 7 - Final w/ Linear Feature

----- H

Feature Definitions
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5. With the setting adjusted, save your settings and check your file back into ProjectWise.

3.8-2 Cross Section Creation via Named Boundaries
With your corridor model displayed using the correct feature definition, sections can now be cut via the
Named Boundary tool—which is in the Drawing Production tab of the OpenRoads Modeling workflow.

Ci [ororeimedims ] H s « - + £ & =
File Home Terrain Geometry Site Layout Corridors
QW el hE g O
. L
Ephus (R0 R Bl o o || o e | e i e O |
Primary Selection Clip Saved Views | Tables

Place = Place Place Place Edit Chan aText"‘A

Note Lal

Motes

View

& H A AalR 7 Y

#
bel Text Text Attributes ~ 7

Text |

Element
Annotation ~

e
Model

Annotations

Annotation ~

Named
Boundary -

= Named Boundaries

pw:\\dotwise.indot.in.gov:DOTWise\Documents\Resources\CAD Support\Working Felders\PS\Mitch ORD Test Files\ORD\Corrider_Roadway.dgn [2D - V& DGN] - OpenRoa

Meodel Detailing | Drawing Production| | Drawing

1'=30'
45 ACS Plane Lock
A Annotation Scale Lock

Drawing Scales

Named Boundary Tool

With the Named Boundary tool open, perform the following steps to create your cross sections and
resulting sheets:

1. Asa preliminary step, you will need to create a 3D model in the PrPlan drawing—which is

necessary for creating sheets from the cross section named boundaries. Right-click and hold in

your current view, and then select View Control > 2 Views Plan/3D in the menu that appears.

This will open a 3D view of your PrPlan drawing.

View Control

oo

Copy
Mowve

Scale

- Rotate

Mirror
Select Links

View Attributes
Model Properties
Clip Velurne

Select All

Select None

Select Previous

Cut to Clipboard
Copy to Clipboard
Paste from Clipboard

Turn Level Off by Elernent
Delete Elernent

- 1& HxX5

1 View

2 Views Plan/3D

Ef({pededevee

2 Views Plan/X5

2 Views Plan/Profile

2 Views Plan/Superelevation
3 Views Plan/Profile/3D

3 Views Plan/X5/3D

4 Views Plan/Profile/X5/30
Ref Adjust Colors
Dynamic X5 View

Profile View

Toggle Construction Class
Levels Off Except Element

Displayset Set
Displayset Clear

Arrange Windows

Rotate View

Fit View
lllustration View
Smooth View

WireFrame View

Opening a 3D View of PrPlan




NOTE: If you do not open a 3D view of PrPlan prior to creating your cross section sheets, you will get the
following warning when you try to create them—which prompts you to create the 3D model before
sheets can be created:

Place Mamed Boundary Command Warning X

Only Mamed Boundaries have been created.

! A view with the 3D Model must be open to Create Sheets,
Please open the 30 Model and go to the Civil Named
Boundary Manager to Create Cross Section Sheets,

Sheet Creation Warning

2. With the 3D view created, select the Civil Cross Section option in the Place Named Boundary
dialog (fourth from the left).

Civil Cross Section Option

3. Next, select the desired drawing seed from the dropdown list. The drawing seed in this case
determines both the scale and the left/right offsets for the created sections. For this example,
the Cross Section 5 Scale drawing seed will be chosen.

/% Place Named Boundary Civil Cross Section - X

el O

Drawing Seecki [Cross Section 5 Scale ]

Detail Scale: | Name
none]

ross Section s Scale
Name: ¢ ross Section 10 Seale
Description: |Cross Section 20 Scale

O Start Location:
O Stop Location:
Left Offset: | -75.000000

Right Offset: | 75.000000

Interval: | 50.000000

Group:

e x

Vertical Exaggeration: | 1.000000

Top Clearance: | 10.000000

Bottom Clearance: | 5.000000

Elevation Datum Spacing: | 10.000000

Event Point List: | (None) hd
Include Event Points Only

[ Include Control Points
[] Backward Facing
Create Drawing
Show Dialog

Selecting a Drawing Seed
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4. Inthe drawing, dynamically select the alignment that you wish to cut the sections along. The
Name field in the Place Named Boundary dialog becomes populated with the name of the
alignment, and a Description (if desired) can be entered as well. The Name and Description
fields are for the cross section named boundary group that will be created.

&
~ el O
Drawing Seed: | Cross Section 5 Scale -
Detail Scale: [1"=5' -
Group: |(Mew) -
MName: | Line A
Description:
O Start Location: | 309+70.77 [t
O Stop Location: | 200+00.00 >

Left Offset: | -75.000000 =
Right Offset: | 75.000000 =
Interval: | 50.000000 s
Vertical Exaggeration: | 1.000000
Top Clearance: | 10,000000
Bottom Clearance: | 5.000000
Elevation Datum Spacing: | 10000000
Event Point List: |(None) -
Include Event Points Only
[ Include Control Points
[ Backward Facing
Create Drawing
Show Dialeg

Name and Description Fields for the Cross Section Group

5. Next, set the start and stop locations along the alighment for which you want to cut sections.
This can be done either dynamically in the drawing or entered in manually in the dialog.

Dynamically Entering Cross Section Start and Stop Locations (50 ft interval between sections shown)
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A0 g T
Drawing Seed: |Cross Section 5 Scale -
Detail Scale: |1"=53' -
Group: [(New) -
Name: Line A
Description:
Start Location: | 300+00.00
Stop Location: | 313+36.62
Left Offset: | -75.000000

Right Offset: | 75.000000
Interval | 50.000000

e =

Vertical Exaggeration: | 1.000000
Top Clearance: | 10.000000
Bottom Clearance: | 5.000000
Elevation Datum Spacing: | 10.000000
Event Point List: |(Nene) -
Include Event Points Only
[ Include Control Points
[] Backward Facing
Create Drawing
Show Dialog

Start and Stop Locations Set in Dialog (Arrows clicked on right side of each field to lock to start and

end of selected alignment, respectively)

6. The Left and Right Offset fields are preset by the selected drawing seed, so these settings as a

general rule do not need to be changed.

7. Adjust the cross section interval as desired. In this example, an interval of 50 ft will be used.

8. The vertical exaggeration (set to 1 by default), should be acceptable in most situations.

9. The top clearance (minimum distance between the top of the data in the section to the top of

the cross section grid; set to 5 by default), bottom clearance (minimum distance between the

bottom of the data in the section and the bottom of the cross section grid; set to 5 by default),

and elevation datum spacing (interval of starting elevations on cross sections; set to 5 by
default) should also be acceptable, but can be altered as desired.

10. The checkboxes at the bottom of the dialog are as follows:

Include Control Points: If control points have been configured for the horizontal curves
on the alignment, enabling this setting will add cross sections at the stations where the
control points are located. In most cases, though, this can be left disabled.

Backward Facing: If enabled, the cross sections would be cut as if you are facing
backward in relation to the direction the alignment is going. In essence, the left and

|II

right sides of a “normal” cross section would be reversed. By default, all cross sections
are cut from a forward-facing perspective.

Create Drawing: When enabled, this indicates you want to proceed with creating cross
section sheet drawings. In this example, this setting will be enabled. NOTE: If you wish
to include end area volumes on your cross sections, leave this setting disabled, and
proceed to the following section on creating end area volumes for further instructions.
Show Dialog: When enabled, this setting will bring up the Create Drawing dialog once
you are satisfied with the Named boundaries to be drawn. In this example, the setting
will be enabled.
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11. Once the settings are configured as desired, click in the drawing to confirm the named boundary
placement. The Create Drawing dialog will then appear. Review the settings as needed.

12. On the Create Drawing dialog, pay special attention to the One Sheet Per Dgn setting. This
setting tells OpenRoads Designer to create a separate dgn file for each cross section sheet that
gets created. The process to follow for each scenario (with this setting disabled vs. enabled)
going forward is explained next.

g
1

iviode: | Cross Section -

| |I:I One Shest Per Dgn: |

View Name: | Line A - 10+00.00-2

Drawing Seed: | Cross Section 5 Scale -

View Type:
Discipline:

Purpose:

Model Name:
Seed Model:

m} Filename:
A

&

Annotation Group:
Model Name:

Seed Model:

O Filename:
Sheets:

A

£-4

Drawing Boundary:
Detail Scale:

Open Model

Civil Cross Section

Drawing Model
Line A - 10-00.00-2
Cross Section 5 Scale.dgnlib, Cross Sectic
(Active File)
=5 -

Sheet Model

Create Sheet Model
Line A - 10+00.00-2
Cross Section 5 Scale.dgnlib, Cross Sectic
(Active File)

(New)

Full Size 1= 1
Cross Section All 55
1"=5' (By Named Boundary)

KN ERIE

Add To Sheet Index (&

Make Sheet Coincident

Cancel

One Sheet Per Dgn Setting

One Sheet Per DGN Setting Disabled:

13. With the One Sheet Per Dgn setting left disabled, proceed to give an appropriate name to the

first created cross section sheet in the
example, Cross Section Sheet 1 will be

Model Name field in the Sheet Model section. In this
used as shown above.

14. Apply the appropriate annotation group to the cross sections in the Annotation Group field. In
the dropdown, navigate to Cross Section > Drawing > (Annotation Scale) > (Annotation Group).
In this case, the XSec — 5 Scale > 5 Scale_ ALL ANNOTATIONS annotation group will be used.

[T

Annotation Group:

Model Mame:
Seed Model:
Filename:

Sheets:
A

e}

Drawing Boundary:
Detail Scale :

Eui Drawing

Cross Section

- ¥sec -5 Scale
@ 5 Scale_ALL ANMNOTATIC

ﬁ 5 Scale ALL -'i\I\JNOTi\TIOI‘vJ_SJ

@& 5 Scale_EAV Table
& 5 Scale_Grid Only

i @ 5 Scale_PG/EG Bevation
[ ¥sec - 10 Scale
- ¥sec - 20 Scale
@ SU_X5Cross Sect Annotation
>

Select Annotation Group
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15.

Once all the settings in the Create Drawing dialog have been confirmed, proceed to click OK to
create the named boundaries/cross sections. The process may take some time if there are
several cross sections to be created. Shown below is an example of what is produced—with
drawing models created for each section, and sheet models on which the drawing models are
placed.

E Models

LIMNE R_RERUN - 709+00.00-1
LINE R_RERUN - 709+ 50.00-1
LINE R_RERUN - 710+00.00-1
LINE R_RERUN - 710+50.00-1
LIME R_RERUN - 711+00.00-1
LIME R_RERUN - 711+19,59-1

4 5B Y
Type 20/30 Name ~ Description
[ I8 ] Cross Section Sheet 1
3 | Cross Section Sheet 2
[ | Cross Section Sheet 3
3 | Cross Section Sheet 4
[ | Cross Section Sheet 5
3 | Cross Section Sheet 6
cl)_] 1 Default Master Model
W (P Default-3D
[ 1 LINER_RERUN - 705+55.73-1
Y 1 LINER_RERUN - 706+00.00-1
[ 1 LINER_RERUN - 706+50.00-1
Y 1 LINER_RERUN - 707+00.00-1
[ 1 LINER_RERUN - 707+50.00-1
Y 1 LINER_RERUN - 708+00.00-1
[ 1 LINER_RERUN - 708+50.00-1
U
O
U
O
U
O

Cross Section Sheets and Associated Drawing Models

One Sheet Per DGN Setting Enabled:

15.

16.

17.

18.

After enabling the One Sheet Per Dgn setting, click on the folder icon to select where you want
the new sheets to be placed—which can either be inside or outside of ProjectWise. In this
example, they will be placed inside of ProjectWise.

Select an appropriate name in the Model Name field under Sheet Model as your first sheet. In
this example, a simple name of Cross Section Sheet 1 is used.

Apply the appropriate annotation group to the cross sections in the Annotation Group field. In
the dropdown, navigate to Cross Section > Drawing > (Annotation Scale) > (Annotation Group).
In this case, the Xsec —5 Scale > 5 Scale ALL ANNOTATIONS annotation group will be used.
Also note the Open Model setting at the bottom of the dialog. If you do not wish to have your
current OpenRoads Designer session ended when the sheet creation process is over, disable this
setting. Otherwise, the current OpenRoads Designer session will be ended, and the latest cross
section sheet dgn to be created will be opened in its place.

19. Once all the settings are confirmed, click OK to proceed with sheet creation.

20. Once processed, the sheets will be created and placed at the selected location.

f& Cross Section Sheet 1.dgn Cross Section Sheet 1.dgn
f& Cross Section Sheet 2.dgn Cross Section Sheet 2.dgn
f& Cross Section Sheet 3.dgn Cross Section Sheet 3.dgn
(& Cross Section Sheet 4.dgn Cross Section Sheet 4.dgn
(& Cross Section Sheet S.dgn Cross Section Sheet S.dgn
w" M Cross Section Sheet f.dan Cross Section Sheet 6.dan

Created Cross Section Sheets in ProjectWise



NOTE: When initially created, the new dgn files will be associated with MicroStation by default. In
order to open these new files with ORD, you will need to modify the files’ properties such that it is
associated with ORD instead of MicroStation.

3.8-3End Area Volumes
To create end area volumes for your cross sections, you must first create cross section named
boundaries as discussed in the previous section. As explained in the previous section, DO NOT enable
the Create drawing setting in the Place Named Boundary dialog—leave this disabled, as you just want to
create the named boundaries themselves at this point. Before the cross section drawings get created,
you need to first create the end area volume data to be placed into the cross sections. This process is
explained in this section.

1. With the named boundaries created, the first step is to create the cut fill volumes. To do this,
navigate to the Terrain tab in the OpenRoads Modeling workflow, and in the Analysis section
click on Volumes > Create Cut Fill Volumes.

1| OpenRoads Modeling |18~ & H k& [fa L = pw! -pw.bentley.com:indot-pw-0T\Documents\_Testing\0001350 Desig 0ld Testing Data\test\ORD PrPlan.dgn [3D - V& DGN] - OpenRoads Designer CONNECT Edition
T Home Geometry  Site  Comidors  Model Detailing  Drawing Production  Drawing  Utilities  iTwin  View  Help
@, k i s From File 0.0 =Y ﬁ% % B8y, Edit Complex Model 2 3¢ 3| = @ % @ E
L o A
3 - 88 From Graphical Fikter < 2 & Festure Mensgement - 4, e @, R o~ 'Y Graphical Filter Manager | = Label Terrain Contours
. Element -, Additienal  Tope Active  Edit Transform | Peints Calculste) Yelumes |Hydraulic Reperting Aquaplaning SIght & Export To File 25’ Label Terrain Spots
@ Selection || * A From Elements Methods ~  Import ~ * Model £ Boundary Options ~ - Area - - - - Visibilty =
Primary  Selection Create Edit A Create Cut Fill Volumes ? Miscellaneous Labeling
Properti X | Expl x —
I S s ] B h [ u . fnalyze Volume [ == \" * View 2, Defauft-30
= (=&

Create Cut Fill Volumes

2. Data point in the drawing to accept the default settings for cut fill volumes, then data point to
accept. The cut fill volumes will then be calculated and created in the 3D view. Note that red
indicates cut volume, and blue indicates fill volume. Also note that the outline of these meshes
will appear in the cross sections themselves—however, these are set to not plot so as not to
obscure other data.

3D View of Cut Fill Volumes
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3. With the cut fill volumes created, the next step is to create an end area volumes report. This
compiles the end area volume data for each section and populates the end area volume tables
that will get placed on the cross section sheets. To do this, with the OpenRoads Modeling
workflow still active, go to the Home tab, and in the Model Analysis and Reporting section click
on Civil Analysis > End Area Volumes Report.

L A= P o bentl dot-pw-0T\D s Old Testing Data\test\ORD PrPlan.dgn [3D - V8 DG
Model Detaiing View  Help
2 [None * ||P_ALG_Horizontsl Tangents * r E =9 5 ¢ (:: £ < l@’_ﬂ HT
N T =T T B i - - A Repme” e vy | oot Gy~ " SR
Attibutes Primary Model Import/Export

Properties v & x| explorer — ==

File

¢ ntems

&) Resources

OpenRoads Model
QQe.
B Plo vy

D Z ORD PrPlandgn (Default)

End Area Volumes Report

4. Inthe Named Boundary Group dialog that appears, the name of your recently created named
boundary group should automatically populate. Data point to accept it.

5. You will then be presented with the option to select starting and ending cross section named
boundaries if you want to create a volume exception. If a volume exception is desired, proceed
to select the named boundaries in the drawing as prompted. Otherwise, right-click to complete.
The Bentley Civil Report Browser will then create the End Area Volume Report.

£ Bentley Civil Report Browser - C:\Users\PSmock\AppDatat Locah Temp\RPT2cjoc Stocml - o x
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EarthworkQuantities.xsl
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End Area Volume Report

Report Created: Monday, May 3. 2021
Time: 10:07-51 AM

Cross Section Set Name: Line C
Alignment Name: Line C

Input Grid Factor: Mote: Al units in this report are in feet, square feet and cubic feet unless specified otherwise.

Baseline Mass

Station Factor Area Volume Adjusted Factor Area Volume Adjusted Ordinate
1000 000 1.000 206 518 0.000 0.000 1.000 17.184 0.000 0.000 0.000
1050.000 1.000 191.618 9963.420 9963.420 1.000 12.394 739.484 739.454 9213.966
1100000 1.000 201145 9819.081 9819081 1.000 5905 457 489 457 489 18575557
1150.000 1.000 182,671 9592 894 9592 894 1.000 5738 291.075 291075 27877.376
1200.000 1.000 169.351 8798.035 8798.035 1.000 1.536 181.845 181.845 36493.566
1250 000 1.000 149 461 7970.294 7970294 1.000 2112 91209 91.209 44372651
1300.000 1.000 161.506 7774.180 7774.180 1.000 1.824 98.396 96.396 52048.435
1350 000 1.000 160 969 8061863 8061.863 1.000 2763 114,677 114 677 59995 622
1400.000 1.000 161.324 8057.311 8057311 1.000 1638 110.041 110.041 67942 892
1450000 1.000 133245 7364 233 7364 233 1.000 2695 108.341 108 341 75198.783
1500.000 1.000 117336 6264 544 6264 544 1.000 3758 161.329 161.329 81301.999

Grand Total: 83655 855 83655855 2353 856 2353 856

End Area Volume Report in Report Browser
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6. With the End Area Volume Report created, you can now proceed to create the cross section
drawings. From the Drawing Production tab, click on the icon in the bottom right corner of the
Named Boundaries section to bring up the Named Boundaries dialog.

€ OpenRoadsMadeling + W~ S HE R « - 4+ £ 8 - wi\lindot-pw.bentley.com:indot-pw-01\Documents\_Testing\0001350\Design\inRoads\Old Testing Data\test\ORD PrPlan.dgn [2D - V2 [
Fore  TETEm  Gowy @e G Lo Eoehr l Drawing Production I Drawing  Utiliies  ifwin  View  Help

SORT s e B8 O B A= AR AT Y A X LA = :

& - a2 S 5 ACS Plane Lock
Element ... Clip Create  Update Saved A;:ﬂl’y Place = Place Place = Place Edit Change Text » Element Model Mamed =

@ Selection L4 * Volume (1 SavedView View Settings Saved View Table = Nofe Label = Text Text Attrbutes A%  Annotation = Annotation = Boundary ~ A Annotation Scale Lock
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Accessing Named Boundaries Dialog

7. Inthe Named boundaries dialog, navigate to and then select the Cross Section Group you have
created. Proceed to click on the Show the Create Drawing Dialog button, followed by the Create
Cross Section Drawing button.

i
1% Mamed Bound

X N O e £ o=

Name T Description  Fi Create cross section drawing

B Plan Groups
Profile Groups

4 Cross Section Groups

ORD PrPlan.dgn

Other Group

Named Boundaries Dialog




8. On the Create Drawing dialog, select an appropriate name for the cross section sheets in the
Model Name field under Sheet Model, and be sure to select the appropriate annotation group.

Mode: | Cross Section A

| [0  OneSheet Per Dgn:

View MName: | Line A - 10+00.00-2
Drawing Seed: |Cross Section 5 5cale -
View Type:  Civil Cross Section
Discipline:
Purpose:
Drawing Model
Model Mame: | Line A - 10+00.00-2
Seed Model: | Cross Section 5 Scale.dgnlib, Cross Sectic

O Filename: | (Active File)
A |1"-g' -
|Ann0tati0n Group: |5 Scale_ALL ANNOTATIONS ~ | |
Sheet Model
Create Sheet Model
IModeI MName: | Line A - 10+00.00-2 I
Seed Model: | Cross Section 5 Scale.dgnlib, Cross Sectic |
O Filename: | (Active File)
Sheets: |[Mew) -
“i__‘ Full Size 1 =1 -
Drawing Boundary: |Cross Section All 55 -
Detail Scale: |1"=5" (By Mamed Boundary) -

Add To Sheet Index &
Make Sheet Coincident

Open Model

Create Drawing Dialog

9. With the settings in place, click OK to create the cross section drawings. Once the drawings are
created, you will see the end area volume annotation located at the top right corner of each

cross section grid.

Ac = 681.9 SFT Af = 0.0 SFT

Vc = 1189 CYS Vf = 0 CYS

End Area Volume Annotation
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3.8-4 Cross Section Tips and Tricks
When creating cross sections, there are some scenarios that may arise which require special attention
during the cross section creation process. This section will cover those scenarios.

3.8-4a Excluding Individual Cross Sections
Situations may arise where you want to exclude individual cross sections from a Named Boundary
Group. To accomplish this, open the Named Boundaries dialog, and expand the Cross Section Group
that contains the cross sections you want to be excluded. To exclude a section from a group, simply
right-click on the section you want to exclude, and then select Delete.

{41 Named Boundaries - X

11+50.00 ORD PrPlan.dgn

X % - & @1 £ o=
Name T Description  File Name Show
b Plan Groups
Profile Groups
4 Cross Section Groups
4 LineC ORD PrPlandgn «
10+00.00 ORD PrPlandgn «
10+50.00 ORD PrPlandgn «
11+00.00 ORD PrPlandgn +
v

122500 % Delete
% Appl ,
13+000 pply
13+500 "ﬁ' (Create cross section drawing
142000 [ Fit To Named Boundary
144500 @1 Properties
15+00.00 ORD PrPlandgn
Other Groups

KK EEE

Excluding/Deleting Individual Cross Sections

Once the section is excluded/deleted, proceed to create the cross sections as you would normally, and
the deleted section will no longer appear on the cross section drawings.

3.8-4b Cutting Individual Cross Sections Along a Skew
Situations may arise where you need to cut individual cross sections along a skew. This can be
accomplished with the Civil Cross Section 2 Points option in the Place Named Boundary dialog.

1. Open the Place Named Boundary dialog and select the Civil Cross Section 2 Points option.

@ Place Named Boundary Civil Cross Section 2 Points

KT

Drawing Seed: |Cross Section 5 Scale

Group: |Line C -
Vertical Exaggeration: | 1.000000
Top Clearance: | 10.000000
Bottom Clearance: | 5.000000
Elevation Datum Spacing: | 10.000000
[] Backward Facing
[] Create Drawing
Show Dialog

Civil Cross Section 2 Points Option
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2. Data point on the alignment to select it as the drawing path.

3. Be sure to have the appropriate drawing seed selected, as well as the name of the cross section
group you would like this section to be added to.

=0 = NP O 1

Drawing Seed: |Cross Section 5 Scale hd

Group: |Line C -
Vertical Exaggeration: 11.000000 |

Top Clearance: | 10.000000

Bottom Clearance: | 5000000

Elevation Datum Spacing: | 10.000000

[] Backward Facing

[] Create Drawing
Show Dialeg

Drawing Seed and Group Selection

4. You will then be prompted to enter the two end points for the skewed section. Proceed to
select the two end points of the skewed section in the 2D view, and then data point to accept. A
new named boundary will be created, which can be seen in the 3D view. NOTE: It will most

likely be necessary to manually draw out the skewed section in the drawing first before creating
its associated named boundary.

#8 View 2, Default-30 e s
E-ox-|dPLPROGD HURZERATER

Skewed Cross Section Named Boundary
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10. To verify the station of the named boundary in relation to the selected alignment, you can go to
the Named Boundaries dialog.

=2 -
10er Mamed Boundaries

& o=
Name Y Description  File Name Show -
* Plan Groups
Profile Groups
4 Cross Section Groups
4 lineC ORD PrPlandgn |«
10+00.00 CORD PrPlandgn  «
10+50.00 ORD PrPlan.dgn
11+00.00 CRD PrPlandgn |«
11+50.00 CORD PrPlandgn  «
12+00.00 ORD PrPlandgn |«
12+50,00 CORD PrPlandgn  «
13+00.00 ORD PrPlan.dgn
13+50.00 CRD PrPlandgn |«

I 13+67.65 ORD PrPlandgn |+
14+00.00 ORD PrPlandgn v
14+50,00 CORD PrPlandgn  «
15+00.00 ORD PrPlan.dgn |+

Other Groups

Skewed Cross Section in Named Boundaries Dialog

3.8-4c Recutting Existing Cross Sections

If you’ve already created some cross sections that you wish to recut, you can easily do so via the Named
Boundaries dialog. First, make sure you have a 3D view open that contains the cross section named
boundaries. Then, select the Cross Section Groups section, and select your desired cross section group.
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Profile Groups

4 Cross Section Groups

ORD_PrPlan_luly 22.dgn
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Selecting Cross Section Group




Then with the cross section group selected, click on the Show the Create Drawing Dialog button,
followed by the Create cross section drawing button.

=2 -
e Mamed Boundaries — >

X

plame ¥ | Desciption Show the Create

B Plan Groups Drawing Dialog
Profile Groups Button

drawing button
Cross Section Groups

ORD_PrPlan_luly 22.dgn
QOther Groups

Create Drawing Dialog and Create Cross Section Drawing Buttons

This will bring up the Create Drawing dialog, where you can adjust the settings for your cross sections as
desired.

£l Create Drawing #

Mode: ‘CmssSe:tion '|
O One Sheet Per Dgn: | ‘

View Name: | Line A - 10+00.00-1 |

Drawing Seed: |Cmss Section 5 Scale - |

View Type:  Civil Cross Section
Discipline:

Purpose:

Drawing Model
Model Name: | Line A - 10+00.00-1 |
Seed Model: ‘ Cross Section 5 Scale.dgnlib, Cross Secti(|

O Filename: | (Active File) | +
A =3 ]
Annotation Group: ‘None |
Sheet Model

Create Sheet Model
Model Name: | Line A - 10+00.00-1 |
Seed Model: ‘ Cross Section 5 Scale.dgnlib, Cross Secti(|

O Filename: ‘ (Active File) | +
Sheets: |(New) v
A [FullSize1=1 v
Drawing Boundary: |Cmss Section All 55 - |
Detail Scale: |1'=5' (By Named Boundary) v

Add To Sheet Index (&
Make Sheet Coincident
Open Model

[ ]| concel

Create Drawing Dialog

Note: As previously mentioned, this process can similarly be applied to other sheet types in the Plans
Production process. Repeat the listed steps with the appropriate named boundary groups selected.
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3.9 Bringing Legacy Data into OpenRoads Designer

It is possible to bring legacy data (i.e., civil content from SelectSeries releases) into OpenRoads Designer.
To accomplish this, you will need the following necessary files:

e A .dgn file containing the survey fieldbook and symbols drawn up in the S54/10 OpenRoads
format, this could also be provided as a pre-OpenRoads .fwd format survey file.

e A .dgn containing the survey terrain model in the SS4/5510 OpenRoads format, this could also
be a .dtm file containing the terrain as modified by Survey (triangulation cleanup, etc.)

e A ..dgn containing the survey alignment as a S54/5510 OpenRoads element, this could also be
provided as an .alg file containing the horizontal survey alignment

e Appropriately geocoordinated seed files

For a project that was surveyed and provided to INDOT standards, the above files should already be
available. If you do not have these files, the following subsections will cover what steps may need to be
done—including alternate steps to create the necessary items. In addition to these necessary items,
there are supplemental items that can also be brought into ORD.

o |TL template libraries: These can be brought forward but note that they will need to be updated
to take into account adjustments to features, naming, and targeting.

e |RD corridor file: If available from an older SS2 project, these can also be brought forward, with
the same caveat as the ITL template libraries.

3.9-1 Working with Legacy Data in ORD
As mentioned in the previous section, it is necessary to have appropriately geocoordinated seed files to
import the legacy data into. This section will guide you through the process of taking the
geocoordinated seed files and referencing the legacy data into them. If no geocoordinated seed files
exist, alternate steps will be provided as needed.

3.9-1a Working with the Survey Fieldbook and DTM/Terrain

1. Asoutlined in section 2.2-6 of this document, import your old survey data into your 3D ORD
Survey Fieldbook file. This will create your survey fieldbook in ORD.

2. Create a brand new DGN file from the 3D geocoordinated seed file provided to you. If an
appropriate seed file is not provided, the default 3D seed file from our workspace can be used,
and the geocoordination can be imported directly from the survey fieldbook file. See section
3.4-1 for instructions on this process.

3. Inthe new DGN file, attach the survey fieldbook.

NOTE: Steps 4 through 7 below are only applicable if you were not provided a 3D geocoordinated seed
file from Survey. If you were provided with the seed file, disregard these steps and proceed to step 8.



4. If the 3D geocoordinated seed file was not provided (i.e., you are working from the default 3D
seed file), apply the geocoordination via the Geographic Coordinate System dialog. This can be
accessed in various locations—shown below is the Geographic tab of the Survey workflow.

S ] 2 [ g
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Properties w* 0 X | Explorer
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‘Tp’ j.&a ¢ =5 ‘EI =
Current Geographic Coordinate System
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Description: i
Source:

Vertical Datum:

Accessing Geographic Coordinate System Dialog

5. There are two ways to apply the geocoordination from this dialog. The first is by clicking on the
From Library button and then selecting it from a GCS library, as shown below. Upon making
your selection, click OK.
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The second way to apply geocoordination is by clicking on the From Reference button. Select

the referenced survey fieldbook file on the Geographic Coordinate System from Reference
dialog, and click OK.

oA

w View 1, Default
= -l - L 20RO

& i 2 v
Curr| &
NameSelect Reference graphic C Systems Source
Description] Slot  File Name Model Description Logical GCS Name GCS Description Comment
Sourcd 1 .\1701050_5R8 He.. Default Master Model InGCS-Lawrence  Indiana GCS Lawrence County co... Can get ..
Vertical Datum| < >
di System fros ted Reference
Projection:  Transverse Mercator
Longitude:  00°00'00.0000" False Easting:  240000.0

Latitude:  38°06'00.0000"

False Northing:  36000.0

Cancel

Applying GCS from Reference

7. Upon applying the geocoordination, you will be presented with a warning that the selected GCS
has metric units, while the storage units in the current model are US Survey Feet. Select the
first option to keep the storage units in US Survey Feet. Then click OK to proceed.

&

i The units of Geographic Coordinate System InGC5-Lawrence are Meters, but the
Storage Units in the model are US Survey Feet, Please review the units used in the
source data for this design.

| @ The graphic elements are correctly drawn in US Survey Feet. The storage units should not
be changed.

O Change the storage units in the model from US Survey Feet to Meters to match the
Geographic Coordinate Systermn. The physical size of graphic elements will be changed.

Cancel

GCS Storage Units Warning

8. The next step of the process is to import the terrain from the Survey-provided DTM. To do this,

go to the OpenRoads Modeling workflow, and on the Create tool group of the Terrain tab, select
the From File option.

ﬂ OpenRoads Modeling ¥ I M Hl‘._::? ?n *- - * .g] I::: "‘95 =
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Creating Terrain from File
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9. Select the Survey-provided DTM on the Select Files to Import dialog and click OK.
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Documents
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Selected Documents
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< >
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Selecting File to Import

10. You will then be presented with the Import Terrain Model(s) dialog. The settings you need to be
concerned with are in the File Options section of the dialog:

Feature Definition: Specifies your desired feature definition for the terrain you are
importing. There are several possible options for this—in the case of this example,
Existing _Contours 5 : 1.0 is selected from the list.

Source File Units: Specifies the units of the source file, which in this case is US Survey
Feet.

Import Options: Specifies what components from the DTM that you would like to
import. There are three options. Import Terrain Only will only have the terrain
component of the DTM imported into the file. Import Features Only will only have the
survey features contained in the DTM imported into the file. Import Both will import
both the terrain and the survey features into the file. In this example, we only want the
terrain, so Import Terrain Only will be selected.

Source: Used to specify the source of geocoordination for the terrain. We already have
the geocoordination specified, so this setting can be left at None.
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Importing Terrain Model from DTM

11. With your desired options selected, click Import to proceed with the terrain import.

NOTE: If you choose the Import Features Only option when importing the terrain model, be
advised that all of the survey features found in the DTM will be placed on the Default level and
lose their featurization. This issue has been filed with Bentley by CAD Support as an Enhancement
Request. To address this scenario, you have two options. You can either manually featurize them
after the import, or you can copy the features as line strings and featurize them from there.

3.9-1b Working with the ALG/Alignment
12. With the terrain now imported, the next step is to create a brand new 2D file from a seed file to

bring in our ALG data (alignment). The easiest way to do this is to click on the File tab to open
the Backstage view in ORD, and then click on New.
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Creating a New File in ORD
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13. Select No Wizard at the next prompt and click OK.

14. Then on the next dialog, specify a destination folder for the new file, an appropriate name and
description for the new file, the application to be associated with the new file (which in this case
is OpenRoads Designer), and finally, the INDOT US SVFT 2D seed.dgn file from Template
Documents as the Source Document (chosen by clicking on the Seed... button).
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|
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Folder oK

| InRoads - Change... Cancel
| Document Apply
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Description: | Des Alignments.dgn |
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Application: Dy
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Source Document:
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|

Seed... Import...

Settings for New 2D File

15. You will then be prompted to check in the file you’ve been working on up to this point, proceed
to do so.

16. With the new 2D DGN file open, proceed to attach the 3D file with the survey and terrain as a
reference. Note: Considering that the 3D file you created has a reference itself, you will need to
set the Nesting Depth setting in the Reference Attachment Properties to a value of 1 so that you
can see all of the content.

& Reference Attachment Properties for ...\Explan XX.dgn S

File Name:  PW_WORKDIR:d0466326\Explan XX.dgn
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Detail Scale: |1"=30" -
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Revision: -
Level: |
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Attaching Survey and Terrain as a Reference with Nesting Depth of 1
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17. With the terrain now attached to the file, proceed to make it active. This will create a 3D model
in the file.

18. You are now ready to import the geometry from an ALG file. With the 2D model open, go to the
OpenRoads Modeling workflow if not already open and on the Home tab select the Import
Geometry tool from the Model Import/Export tool group.
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Import Geometry Tool

19. Select the desired ALG file from its location in ProjectWise and click Open.
20. You will then be prompted to select the various components of the ALG that you would like to
import. In most cases, it should be acceptable to select all of the components.
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- -- S_CTRL_Instr ar alignmt
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Feature Definitions Table:
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Linear Features: |P_ALG_H0|'izonta| under 50 Scale w |

Paint Features: |Nn Feature Defirition ~ |

Create Civil Rules

|mport Cancel

Selecting ALG Components to Import

21. At the bottom of this dialog are two very important settings:
e Assign Feature Definition = Linear Features: For the alignment feature (linear feature), set
the appropriate feature definition from the dropdown list. In this example, the Alignment >
P _ALG Horizontal under 50 Scale feature definition is chosen.
e (Create Civil Rules: Creates all of the necessary civil rules for your imported alignment. Itis
strongly recommended that this setting always be enabled.
22. With the import settings set as desired, click Import to import the ALG/alignment.
23. With the alignment imported, perform steps 4 through 7 in this file to apply geocoordination.



4. Drawing/Sheet Annotation in OpenRoads Designer

Upon creating your plan sheets per the processes discussed in the previous chapter, several annotations
need to be added to convey the necessary information on them. This chapter covers the processes for
creating these annotations in OpenRoads Designer using the following three methods: Drawing Model
Annotation, Element Annotation, and the Civil Labeler tool.

Note: OpenRoads Designer is heavily leveraging the use of Drawing models as an intermediate container
between the design and sheet models. Unless otherwise specified, all annotations should now be placed
on the content in the drawing models. This is necessary for the more advanced annotation tools that
read, report, and annotate information directly from the civil content. Using the drawing models plus
the appropriate drawing scales and a combination of the below listed tools and other text and dimension
placement tools should provide a flexible process for adding appropriate annotations.

4.1 Drawing Model Annotations

The Drawing Model Annotation tool in ORD allows you to add annotations to either an individual, or all
drawing models in a design file. The tool can be found on the Drawing Production tab in either the
OpenRoads Modeling or OpenRoads Drawing Production workflows, as shown below.
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Drawing Model Annotation Tool

The remainder of this section will cover how to use the Drawing Model Annotation tool to apply
annotations to various design elements in the drawing models of your plan sheets.

4.1-1 Plan View Annotations
As specified in the previous chapter, the drawing model annotation should already be applied at sheet
creation time when selecting an annotation group for the plan view of a plan sheet. If not already
applied, you can use the Drawing Model Annotation tool to add this annotation—which only consists of
the north arrow, and a border representing the plan view border extents for use when applying
annotation of survey features.

To add the annotation, have the drawing model of the plan view open, and select the Drawing Model
Annotation tool to bring up the Annotate Drawing Model dialog:

J%:-"::f: -

Parameters L3

&l Drawing Models [

Annctation Group  Plan Profile 30 Sca| -

Annotate Drawing Model Dialog
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Then to add the annotation, select the ellipsis button, which will present a dialog where you can select
the appropriate annotation group for your situation. For example, for a 30 scale plan view on a plan and
profile sheet, you would select Plan > Drawing > Plan Profile 30 Scale.

48 Annotat — d
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All Drawing Models []

Annotation Group  Plan Profile 30 SCEEl
— O *

B- - Plan A

=k Drawing
..... @ Plan Profile 30 Scale «

..... @ Bridge Layout 50 Scale

----- @ Plan Only 10 Scale

----- & Flan Only 20 Scale

----- @& Plan Only 30 Scale

----- @ Plan Only 50 Scale

----- & Plan Only 100 Scale

----- @ Plan Profile Large Plan 20 Scale
----- @ Plan Profile Large Plan 30 Scale
----- & Plan Profile Large Flan 50 Scale
----- @ Plan Profile 50 Scale

----- & Flan Profile 100 Scale W

Selecting Plan Annotation Group

If you would also want to apply this annotation to all drawing models in the file, you can select the
checkbox for All Drawing Models. Then to apply the annotation, click once to confirm the All Drawing
Models setting, and then once more to confirm your selection of annotation group to apply to the
drawing model(s). The annotation will then be applied to the drawing model(s), as denoted by the
arrows in the screen capture below:

Drawing Model Annotation Applied to Plan View
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4.1-2 Profile View Annotations
As currently configured, there are no annotations that need to be added to a profile view of a plan sheet
via the Drawing Model Annotation tool. Such annotations are covered by either the Element Annotation
tool or the Civil Labeler tool, which are discussed later.

4.1-3 Cross Section Annotations
To add annotations to a drawing model of a cross section, click on the Drawing Model Annotation tool.
Click on the ellipsis button in the dialog, navigate to Cross Section > Drawing and note the following
layout has been created for cross section annotation groups.
|
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Parameters

| All Drawing Models []

| Annotation Groun & Geala A1 .!LNMOT&TIOM‘@
=
o

]

@ None
[} Cross Section

= Drawing
B[ Xsec- 5 Scale

5 Scale_ALL ANNOTATIONS
5 Scale_Cross Slopes
5 Scale_Crossing Features
5 Scale_EAV Table
5 Scale_Grid Cnly

5 Scale_PG/EG Blevation

- ¥sec - 10 Scale
- Xzec - 20 Scale
----- & SU_¥5LCross Sect Annotation

YY)

Cross Section Annotation Group Layout

The available cross section annotation groups have been broken down first by scale, and then the
individual annotations for each scale.

4.1-3a Breakout Drawing Annotations
As shown in the previous screen capture, there are six available annotation groups for each scale:

e ALL ANNOTATIONS: Contains all the available annotations.

e Cross Slopes: Only contains the cross slopes for the relevant design elements.

e (Crossing Features: Only contains the annotation of various crossing/survey features that are
commonly encountered (utilities, R/W, guardrail, etc.).

e EAV table: Only contains the end area volumes table to be placed at the top right corner of each
section. See the subsection below for information on how to append the benching volumes to
this table.

e  Grid Only: Only contains the cross section grid.

e PG/EG Elevation: Only contains the PG or EG annotation (with leader) for each section.
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4.1-3b Benching Table Placement
To append benching annotation to the EAV table on the cross sections, you will need to do so via placing
it as a cell in your drawing model. You will be able to find this via the Place Active Cell tool and then
locate the EAV_BENCH_(scale) cell in the cell library.
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Selecting Benching Quantity Table Cell

With the appropriate cell selected, be sure to toggle off the True Scale setting in the Place Active Cell
dialog. Failing to do so will place the cell too large in the drawing model. Then simply place the cell at
the bottom left corner of the EAV table that should already be there.
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Placing Benching Quantity Table Cell

To edit the values, simply double click to start the text editor and replace the provided template values.
Note that this table element will not be removed as part of the drawing model annotation.
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4.1-4 Removing Drawing Model Annotations
Removing drawing model annotations is a simple process. However, be very careful in using this
functionality, as it removes ALL drawing model annotations in a model/drawing. There is no option
for removing individual drawing annotations.

To remove drawing model annotations, click on the Drawing Model Annotation dropdown and select
the Remove Drawing Model Annotations option.

A pBC
N ' 4\:-_;

Elerment Drawing Cross
Annotation~  Model Annotation *  Section Navigator

Anni k3¢ Anpnotate Drawing Model lz
91,1480 | % Remove Drawing Model Annotations

Remove Drawing Model Annotations

You will then be presented with a dialog providing a single option, which is to apply the annotation
removal for all the drawing model annotations from all the drawing models in the file. With your
desired option selected, a single left click in the view will remove all drawing annotations.

6%;:;-“7*- _

Parameters ~

Al Drawing Models

Remove Drawing Model Annotations

4.2 Element Annotations

The Element Annotation tool in ORD allows you to add annotations to individual design elements. The
tool can be found on the Drawing Production tab in either the OpenRoads Modeling or OpenRoads
Drawing Production workflows, as shown below.
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Element Annotation Tool

This section will cover the annotations applied with this tool. For the purposes of the plan production
process, you will solely focus on annotating the horizontal and vertical alignment elements.
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4.2-1 Annotating Horizontal Alignments
To annotate a horizontal alighment, be sure to first have a drawing model with a plan view opened.
Then select the Element Annotation tool to open the Annotate Element dialog:

| &8 Annotate Elem - X |
Parameters ~ |
| All Elements in Model O
| All Drawing Models O
Override ~ |

| Override Annotation Group

P —

Annotate Element Dialog

Note the settings in this dialog:

e All Elements in Model: Enable this setting to annotate all the elements in the model with the
same annotation group.

e All Drawing Models: Enable this setting to apply the annotation group to all the drawing models
in the file that contain the selected element.

e Qverride Annotation Group: Enable this setting to override any existing annotation groups that
are being applied to a selected element.

e Annotation Group: The annotation group that you wish to be applied to a selected element.

Note: If the Override Annotation Group option is unchecked/disabled, the Annotation Group setting will
not be displayed. In this scenario, the default annotation group associated with the feature symbology
of the selected element would be applied. If no default annotation group exists for the selected element,
no annotation will be applied—and the protocol would then be to check/enable the Override Annotation
Group setting and select the appropriate annotation group to be applied.

Note: When using the Annotate Element tool, usage throughout this document covers using this tool
with the All Elements in Model selection unchecked. The current workflow is to allow the end user to
apply their annotation to specific elements on an as-needed basis and allows for flexibility when they are
necessary. If the All Elements in Model option is checked, OpenRoads Designer will interrogate every
element visible in the current drawing model (and potentially all associated drawing models in the active
DGN if All Drawing Models is selected), and annotate them according to whatever annotation groups are
applied to the assigned feature symbology. This could cause a number of unwanted or unneeded
annotations to be placed and should rarely be used in the current workflow.

For the purposes of this example, you will have a created horizontal alighment that does NOT have an
annotation group assigned to it via its feature symbology. This would thus necessitate the enabling of
the Override Annotation Group setting and the selection of an annotation group. With the Override
Annotation Group setting enabled, click on the ellipsis button in the Annotation Group field to select the
desired annotation group. In this example, you are working with a 30 scale plan view, so select the Plan
> Linear > Stationing Under 50 Scale annotation group.
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Selecting Annotation Group for Horizontal Alignment

With the annotation group selected, left click in the drawing to accept the current settings (leaving the
other settings disabled). You will then be prompted to select the elements to annotate. Proceed to
select your alignment(s) and then right click to accept. The desired annotation will then be applied to
the alignment. Note that the selected annotation group includes station labels, tangent bearings, PC/PT
stations, curve data, etc.

Applied Element Annotation to Horizontal Alighment

4.2-2 Annotating Vertical Alignments
In much the same way as for horizontal alignments, vertical alignments can also be annotated via the
Element Annotation tool. To accomplish this, open a drawing model containing a profile view and select
the Element Annotation tool. With the first two settings in the dialog disabled, and the Override
Annotation Group setting enabled, click on the ellipsis button in the Annotation Group field to select an
annotation group to apply to the vertical alignment. In this case, select the Profile > Linear > Alignment
Profile annotation group.
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Selecting Annotation Group for Vertical Alignment

Upon selecting the desired annotation group, you will be prompted to left click twice to confirm the
current settings and then to select the vertical alignment(s) you wish to annotate. Right-click to accept
the selected alignments and the desired annotation will then be applied. Note that the selected
annotation group includes proposed elevation labels, vertical curve data, PVC/PVT points, vertical

tangent grades, etc.

Applied Annotations to Vertical Alignment

If additional vertical alignhment annotations are needed, the process can be repeated accordingly.

4.2-3 Removing Element Annotations
Removing element annotations is a very similar process to removing drawing model annotations. Unlike
the removal of drawing model annotations, you have the flexibility to be more specific in removing
annotations for specific elements.

To remove drawing model annotations, click on the Element Annotation dropdown and select the
Remove Element Annotations option.



176

A«

Element Drawing _
Annotation* Model Annotation =

,‘5.\ Annotate Element

."l 4. Remove Element Annotations I-—l

Remove Element Annotations

You will then be presented with a dialog that presents you with two options initially: All Elements in
Model and All Drawing Models.

Jr?" RemoveEl.. — *
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All Drawing Models ]

Remove Element Annotation Options

The All Elements in Model option allows you to remove the element annotations for all elements in the
model. When this option is selected, a secondary option for including references in the annotation
removal is also provided. The final option is to remove all element annotations in all drawing models in
the file. With your desired options selected, proceed through the prompts to select the desired
elements you wish to remove annotation from and right-click/reset to complete the process.

4.3 Civil Labeler

New to OpenRoads Designer is a tool called Civil Labeler—which allows for customizable labels to be
created and applied for annotation purposes. There are several potential uses for this tool, and what
will be described in this section is likely just scratching the surface of what may be possible and useful as
we continue to learn more about its usage. This section will cover how to access and navigate the tool,
and then will cover how to use it to apply annotation to your drawings.

4.3-1 Introduction to Civil Labeler
The Civil Labeler tool can be found in the Drawing Production tab in either the OpenRoads Modeling or
OpenRoads Drawing Production workflows, as shown below:
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Civil Labeler Tool

Upon opening the Civil Labeler Tool, you will be presented with a dialog with only a Civil Labels folder.
Expanding the folder will present the following categories/subfolders:
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INDOT Cross Section Labels
INDOT Plan - Survey Labels
INDOT Plan Labels

INDOT Profile Labels
xBentley
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Civil Label Categories

e INDOT Cross Section Labels: Labels for annotating various points in cross sections—mainly for
points pertaining to structures and hydraulics.

e |INDOT Plan — Survey Labels: Labels for annotating various survey features.

e INDOT Plan Labels: Labels for annotating various points in a plan view (e.g., Begin/end of
project, Begin/end of incidental construction, station-offset of points, etc.).

e INDOT Profile Labels: Labels for annotating various points in a profile view (e.g., begin/end of
project, station-elevation of points, etc.).

e xBentley: Default labels that Bentley has provided with OpenRoads Designer. While we believe
we have covered at least most of the labels that you might need, you are more than welcome to
investigate these labels and experiment with them as needed.

4.3-2 Plan Civil Labels
This section will cover the civil labels that can be placed in a plan view of a drawing. We have broken
these labels up into two separate categories: INDOT Plan Labels and INDOT Plan — Survey Labels.

For discussion on the format/creation of civil labels, please see the DOTWise 5.0 Technotes document,
OpenRoads section. This covers the various options when creating/customizing these labels outside the
provided default labels.

4.3-2a INDOT Plan Labels
The INDOT Plan Labels category contains labels for annotating general reference points along an
alignment, such as begin/end project, begin/end incidental construction, and station-offset of right-of-
way points. Note that each of the labels come in pairs—one that provides for even stationing, and the
other for a standard stationing accuracy of two decimal places.

5.7 INDOT Plan Labels
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----- Plan - CL Structure_Ewven Station
----- Plan - Incidental Begin

----- Plan - Incidental Begin_Even Station
----- Plan - Incidental End

----- Plan - Incidental End_Ewven Station
----- Plan - Project Begin

----- Plan - Project Begin_Even Station
----- Plan - Project End
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----- Plan - Station PL_Even Station

INDOT Plan Labels
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Plan — Project End_Even Station Civil Label

4.3-2b INDOT Plan — Survey Labels
The INDOT Plan — Survey Labels category contains labels for annotating survey features along an
alignment. These labels are the equivalent of the station-offset annotation of survey features created in
MicroStation/InRoads SS10 and then placed along the top and bottom of the plan view.

B Civil Labels
é---, INDOT Plan - Survey Labels
. || Survey Feature - Station Offset Label
------ |__| Survey Feature (Bulk) - Survey Mote Label
------ |__| Survey Feature (Individual) - Survey Mote Label

INDOT Plan - Survey Labels

The process for adding and placing these labels will be described in the subsections below:

Survey Feature — Station Offset Label

Note that prior to the process being described below, it is assumed that you a) have already created the

plan sheets that these annotations will go on, and b) you are in a drawing model of a plan view of one of
these sheets.

1. Inyour drawing model, open the Element Selection tool if not opened already.

2. Onthe Element Selection tool, select the Levels tab—as you will select the survey features you
wish to annotate by level.
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Levels Tab on Element Selection Tool

3. Onthe Levels tab, proceed to select the levels of the survey features you want to annotate. In
this example, we will select the S_ TOPO_Tree deciduous and S_UTIL Ug-gas levels.

v

.

5 TOPO_Tree deciduous
5_UTIL_Ug-gas .

BD_Batch Plot Border
BD_LS Stamp

BD_PE Stamp
BD_SHT
BD_SHT_Attribute Exc...
BD_SHT_Attribute Exc...
BD_SHT_Clip Boundary...
BD_SHT_Frame

BD_SHT Legend

Selected Levels in Element Selection
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NOTE: In the event that no elements are actually selected when you select their associated levels in
the Element Selection tool, please refer to section 4.4 of the Technotes section of our DOTWise manual
for instructions on how to resolve this issue.

4. With your desired survey features selected, navigate to the Element Type tab in the Element
Selection tool. Note the Cell and the Line String element types are currently selected.

[ :
| ﬁ Element Selection — X

Element Type - ]

"
Cell .
Line 5tring .
Annotation Cell
Annctation Cross5ection
Annotation Linear3d
Annctation Plan

Annotation Profile

Annctation Surface

Arc

Associative Region v

Element Type Tab in Element Selection Tool

7. Onthe Element Type tab, hold down the Ctrl key and click on the Line String element type
(denoted with the blue background, NOT the gray one) to deselect it. This prevents the Civil
Labeler from labeling any line strings associated with linear survey features—which in this case,
is a gas line. The way we have the civil label currently configured, each of the individual points
along the linear feature will be annotated. Note that if you are not annotating any linear
features (i.e., solely point features), then you can skip this step.
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8. With your survey features now selected, open the Civil Labeler tool from the Drawing
Production tab.
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Civil Labeler Tool
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9. Inthe Civil Labeler Tool, go to Civil Labels > INDOT Plan — Survey Labels > Survey Feature —
Station Offset Label.
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Survey Feature — Station Offset Label

10. With your survey features still selected, click on the Place button.

11. You will first be prompted to identify the baseline alignment—proceed to do so. NOTE: You will
not be able to right-click to locate the actual alignment if there are multiple elements coincident
with it—as it will cancel the operation. It is thus suggested to turn off any conflicting levels so
that you can easily select the alignment.
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Selecting Baseline Alignment
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12. You will then be prompted to accept the point(s). Left click once to accept the current selection,
note that the labels will now appear, ready to be placed.

Accept Points

13. You will then be prompted to confirm the label placement. Left click once again in the same
location to place the labels in the drawing. Depending on how many survey features are being
annotated, it may take a bit of time to process.

Station Offset Label Cleanup
Some cleanup of the station offset labels will be necessary, as the Civil Labeler tool annotates all of the
points associated with the feature, even if they fall outside the extents of the plan view of the drawing

model that you’re currently in. These annotations falling outside the plan view border extents will need
to be deleted from the drawing model.

Annotations Falling
Outside of Plan View
Border

Plan View Border

Annotations Outside of Plan View Border
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After deleting the unneeded annotations, you are now ready to align the relevant labels to the top and
bottom of the plan view border. For this example, we will start with the labels to align to the top of the
border, and then the ones that align to the bottom.

1. The first step will be to select all the labels corresponding with points/features to the left of the
alignment.

2. With the labels selected, select the Align Elements by Edge tool, which can be found on the
Manipulate section of the Drawing tab in various workflows. You will likely need to click on the
dropdown arrow on the bottom right corner of the section to access the tool.
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Align Elements by Edge Tool

3. Onthe Align Edges dialog that appears, set the Align setting to Top.

4% Align Edges — o

Align |Top ~
[] Make Copy
Use Fence: |Vaid-Clip 7

Align Edges Tool — Set Label Alignment to Top

4. You will be prompted to select a base element for alignment. Select the yellow border
representing the plan view extents for the sheet.

Select this border

Select Plan View Border
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5. With the plan view border selected you will be given a preview of the realignment of the labels.
Once you are satisfied, left click to accept the realignment. The labels will then be aligned to the
top of the border.

Aligned Labels to Top of Plan View Border

6. Repeat steps 1 through 5 to align the labels for the features to the right of the alignment to the
bottom of the border. The only differences would be to select the labels to the right of the
alignment, and then to set the Align setting in the Align Edges tool to Bottom instead of Top.

7. As necessary, you can manually move individual labels around so that they can all be clearly
seen.

Survey Feature (Bulk) — Survey Note Label

The purpose of the Survey Feature (Bulk) — Survey Note Label is to annotate several survey features at
once with just their feature description. The process for placing these labels is virtually the same as for
the Station Offset Label. The only real difference is that in this case, you do not need to select a baseline
alignment to place the labels. All you would need to do is have the features selected and then use the
Civil Labeler tool to place the labels.

Survey Feature (Individual) — Survey Note Label

The purpose of the Survey Feature (Individual) — Survey Note Label is the same as for the bulk version,
but just for one-off/individual usage. Note that there is a leader associated with the label for the
Individual version, whereas for the Bulk version there is not.

NOTE: As it pertains to the survey feature labels, keep in mind that not all survey features have a
note/description that is associated with them. As such, users should investigate the survey elements
they wish to label to be sure they have a note associated with them. Hovering over a survey element
should show whether it contains a note/description.
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4.3-3 Profile Civil Labels
This section will cover the civil labels that can be placed in a profile view of a drawing. In its current
form, we have labels configured for begin/end of project and for design information such as the slope
for the tangent sections of the profile, and station and elevation of individual points along the profile
(PVC/PVT, begin/end of ditches, etc.). Note that for the profile labels that contain stationing, we have
provided options for even stationing and standard two decimal accuracy.

El-/~ INDOT Profile Labels

: = ile - Begin Project

ile - Begin Project_Even Station

ile - End Project

- End Project_Ewven Station

- Mame

- Slope

ile - Station Elevation

ile - Station Elevation_Even Station

Profile Civil Labels

The remainder of this section will provide a general overview of how to place these labels. Note that
prior to placing these labels, it is assumed that you a) have already created the plan sheets that these
annotations will go on, and b) you are in a drawing model of a profile view of one of these sheets.

4.3-3a Begin/End Project Labels
To add Begin/End Project labels to the mainline profile, perform the following steps:

Open the Civil Labeler Tool and navigate to Civil Labels > INDOT Profile Labels and select one of the
Begin or End project options.

-/~ INDOT Profile Labels

] Profile - Begin Project

_J Profile - Begin Project_Even Station
|| Profile - End Project

| | Profile - End Project_Even Station

----- || Profile - Name

----- || Profile - Slope

----- _J Profile - Station Elevation

----- _J Profile - Station Elevation_Even Station

Profile — Begin (or End) Project Label

1. Click the Place button in the Civil Labeler Tool.
2. You will be asked to identify the baseline alignment—which in this example is the mainline
profile.

Active Profle: Line A
Type: Complex Profile ! Line

_ALG _Vertical
Ref. Ling'A - Profile 1 (INDOT_Features_Annotations_Levels_Elem Temp Imperial_COPY_PrPlan.dan)

Named Boundary:
Line & Profile 1

Selecting Baseline Alignment
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3. You will then be asked to select a point on the baseline alighment to place the Begin/End Project
Label. Proceed to select the desired point on your profile.

4. Once the desired point is selected, the placeholder for the label will appear, and will allow you
to place it as desired in conjunction with a leader. When you are satisfied with the location of
the label, left click to accept the placement.

Begin Project
Sta. 11+00, Line A
El. = 556.31

Begin Project Label

4.3-3b Labeling Design Information on Profiles
There are various aspects of a profile design that can be annotated with a civil label. For the purposes of
this document, we will cover two use cases: Profile — Station Elevation and Profile Slope.

Profile — Station Elevation Labels

The Profile-Station Elevation label can be used to annotate the station and elevation of any desired point
on a profile. Note that we also have a companion Profile — Station Elevation — Even Stations label for use
when the station of the point you wish to annotate is on an even station—whereas the other label has
two decimal places for the stationing. The following example will show how to annotate the station and
elevation of a point on a secondary ditch profile.

1. Open the Civil Labeler Tool and navigate to Civil Labels > INDOT Profile Labels > Profile — Station
Elevation.

= = INDOT Profile Labels
- |__| Profile - Begin Project

e |__| Profile - Begin Project_Even Station

.| | Profile - End Project

e |__| Profile - End Project_Ewven Station

- |—_| Profile - Name

----- Profile: - Station Blevation |
Profile - Station Elevation_Even Station

Profile — Station Elevation Label



2. Click the Place button in the Civil Labeler Tool.
3. You will be asked to identify a baseline profile, which in this case will be a ditch profile.

annotanon scaie 1 =3u
Design Scale 360.0000
Paper Scale 1.0000
Propagate Annotation Scale  On
Line Style Scale Annotation Scale
Update Fields True
Drawing Properties r
INDOT_Features_Annotations_Levels,
Civil Profile View v
Viodels vhix
&= S0
Ohe 0 vIX
Type 20/3D Name Descripti A
A ) LineA-18+00.00 [Sheet]
&Y ) LineA - 18+50.00
(3 ) LineA-18+50.00 [Sheet] Profile: P_ALG_Ditch Lt
B U LineA-19+00.00 Type: Projected Profile - P_ALG_Ditch Lt \ Line String
Level: Ditch Lt
[ Line A - 18+50.00 - ~ Frofile 1(INDOT_Features_Annotations_Levels_Elem Temp Imperial_COPY_PrPlan dan)
A ) LineA-19+30.00 [Sheet]
&Y ) LineA - 20+00.00
o ) LineA-20+06.63
Y ) LineA-Plan1
A ) LineA-Plan1[Sheet]
Y ) LineA-Plan2
=] ) LineA-Plan 2 [Sheet]

B Line A - Profile 1
1 LineA-Profile 2

@‘

~

@v '@'@Lmeﬁ\-l’mﬁ\e‘\\he'|E:|“E|l 3|4]s|6|7]a D‘AJ/@-@- 71_.”

Jata Point > Identify baseline profile | | No Elements Found | % | @ | Defautt

Selecting Baseline Profile

4. You will then be asked to select a point on the baseline profile you wish to annotate. Proceed to
select the point.

5. Once the desired point is selected, the placeholder for the label will appear, and will allow you
to place it as desired in conjunction with a leader. When you are satisfied with the location of
the label, left click to accept the placement.

Profile — Station Elevation Label
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4.3-4 Cross Section Civil Labels

This section will cover the civil labels that can be placed on cross section sheets. As it stands at the
present time, we have civil labels configured for annotating various structure-related points (Bottom

Structure, Top Structure, Invert, etc.), as well as hydraulics-related points (flowline). Future labels will
likely be created per user request and feedback.

i/ INDOT Cross Section Labels

|__| Bottom Structure Elevation

|—_| Flowline &t Center Str Elevation
|| Flowline Blevation

[] Invert Blevation

[7] Low Strat Center Str Elevation
|—_| Low Structure Elevation

[ | Offset Elevation

Cross Section Civil Labels

The remainder of this section will cover how to place a civil label in a cross section drawing model. Note
that prior to placing these labels, it is assumed that you a) have already created the cross section sheets
that these annotations will go on, and b) you are in a drawing model of one of these cross sections.

In the following example, we will place a standard offset-elevation label at a ditch bottom point.

1. With the cross section drawing model open, open the Civil Labeler Tool and navigate to Civil
Labels > INDOT Cross Section Labels > Offset Elevation.

=~ Civil Labels
B+ INDOT Cross Section Labels
i["] Bottom Structure Elevation
"] Flowline at Center Str Elevation
|__| Flowline Elevation
] Invert Elevation
[} Low Strat Center Str Hlevation

Low Structure Elevation
Offset Elevation
- op Headwall Elevation

------ Top Structure Blevation

Offset Elevation Civil Label

2.

Click the Place button to begin the placement of the label.
3.

You will first be asked to select an offset element. In this case, you will select the ditch bottom
point.

N Section cut graphics

RD_PrPlan_luly 22.dgn)

Selecting Ditch Bottom Point
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4. A preview of the label will appear and will allow you to move it to a desired location. Once you
find a desired location for the label, data point/left-click to accept.

Offset = 37.9'RT
Elev. = 520.96

Placed Offset Elevation Civil Label

4.3-5 Known Issues with Civil Labeler
CAD Support is currently aware of a few issues that users may encounter when placing civil labels. This
section will cover these issues and—when applicable—how to address them.

4.3-5a Detached Frame from Leader
There may be times when the text frame of the civil label becomes detached from the leader. See
example below.

Detached Frame from Leader

One known example of when this can occur is using civil labels on cross sections where the text is placed
to the left of the leader (as shown above). To fix this, simply select the text frame of the label and drag
it slightly to a new location—which will snap the leader into the proper place.

Offsef- = 200
. Elev. = 524.48

Reattached Frame to Leader
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4.3-5b Shifting Leader when Placing Label to the Left
Before confirming the placement of a label to the left, the reference point of placement of the text
frame is on the left side of the placeholder text as denoted with an “X” in the screen capture below.

Begin Project
Sta. Plan Annotation.Point Station CL

Label Preview Before Confirming Placement

However, upon confirming the reference point to place the label, the text frame adjusts its length to fit
the actual length of the text it contains. In so doing, the leader ends up shifting over to the left to make
up for this length adjustment. See the example below with the same label once its placement was
confirmed. The “X” shown is in the exact same location as shown in the previous screen capture.

Begin Project

Sta. 5+07.94 CL

Label After Confirming Placement

Note how the leader component of the label has shifted over to the left upon confirming the label
placement. This is not desired behavior, and CAD Support has made Bentley aware of the issue.
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4.3-5¢ Placeholder Label Showing Incorrect Orientation
When a placing a label just slightly to the left, the placeholder label that appears will display an
inaccurate orientation. However, once placement is confirmed, the label text and leader should correct
themselves automatically. See below for a before and after example scenario.

)
End Project
End Project Sta. 16+08 Line A |\
"".‘ Sta. P__‘I.a"n Annotation.Point Station Line A

Before and After Confirming Placement of Civil Label

4.4 The Place Note Tool

For a number of annotations, the usage of the previously mentioned tools may not be necessary. For
these processes, a number of legacy Place Note options can be found on the Annotation Tools tab in the
INDOT Tools workflow:

] INDOT Jools =] > | AR

Applications Cells Annotation Tools Survey Traffic

-III I .mu A
A 7
5 ACSPla 'a
F'Iace pl|| n Letter  Full

-""- Annotati

ock | Text Along lements By Edge] ~ 3Ze~ Size~w

Drawing Scales ools Annotation Styles

v 0 X | Explorer o

Properties

The benefit of these tools is that they are pre-configured to place the notes on the appropriate level,
with the correct dimension and text style. Please note that these are legacy tools and if they need
updated, INDOT CAD Support should be contacted to make appropriate adjustments.

Note: There is currently an outstanding bug with the Place Note tool. If you do not use the pre-
configured notes referenced above and instead use the Place Note tool directly, you will experience an




issue where selecting your dimension style does not set the appropriate associated text style. To

alleviate this issue, the appropriate text style must be manually selected from the Text Editor as shown
below:

S

A @

. [7] Engramrow v Lp

Dimension Style

Horizontal 7

Location: v

Start At: | Terrninator =

Horizontal Attachment: | Auto =

— -+

2 e

A Text Editor

W 12 Paint Text L j_f @ > <0 v fitx) | T Tahoma

4 12 Point Text I} o I I

& 12 Point Text - Profile Sta Elev (CC)
% 12 Point Text - Profile Sta Elev (LC)

w47 Mo _n To. No_Cil_ Ca_ Fi_._ /W

Make sure that when switching between dimension styles while using Place Note, you’re always ensuring
that the correct text style is also selected. This issue only affects the Place Note tool, and not the other
Dimension tools. Those tools correctly apply the text style defined in the dimension style.
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